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T ANALISIS Y DISENO DE SISTEMAS DE COMPUTO

TEMA 1. ANALISIS DEL SISTEMA <
1.1 Antecedentes

Es comitn, al hablar de la comunicacién, sefialar el vertiginoso e im-
presiozante progreso logrado en las pocas décadas de su existencia. El
contexto en el que se ha desarrollado el software estd fuertemente ligado a
las cuatro décadas de evolucién de los‘sistemas inform4ticos. Un mejor
rendimiento del hardware, un tamafio méds pequefio y un costo més bajo, han
dado lugar a sistemas informdaticos més sofisticados.

La figura 1 describe la evolucién del software dentro del contexto de las
dreas de aplicacién de los sistemas basados en computadoras.Durante los
primeros afios el hardware (fig 1a) era de propésito general, por otra parte

el software se disefiaba a medida para cada aplicacién y tenfa una
distribucién relativamente pequeifia.

La mayorfa del software se desarrollaba y utilizaba por la misma persona u
organizacién, debido a este entorno personalizado del software, ¢l disefio

era un proceso implicito, ejecutado en la cabeza de alguien y, la
documentacién no existfa normalmente.
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« Onentacidn por [otes  « Muiti-usuario » Sistemas distribuidos + Sistemas experios
« Distribucién limitada « Tiempo-real » “Inteligencia” empotrada  « Maguinas de |1A
» Soltware a megida « Bases da dalos « Hardware de bajo costa  « Arquitecturas paralalas
» Produccion de saftware = impacto en el consumi-
dor
( ) (%) (¢) (d)
PN i
T 0 IR NN //
1950 1860 1870 1930 1990 2000
.. Fig 4

La segunda era de la evolucién de los sistemas de computadoras (fig 1b) se
extiende desde la mitad de la década de los 60 hasta finales de los 70. La

- multiprogramacién, los sistemas multiusuarios, 1ntrodu_|eron nuevos concep-

tos de interaccién hombre-méquina.Las técnicas interactivas abrieron un
nuevo mundo de aplicaciones, los sistemas podfan reconocer, analizar y
transformar datos de multiples fuentes, controlando asf{ los proceso y
produciendo salidas en milisegundos en vez de minutos. '

-
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TEMA 1.'ANALISIS DEL SISTEMA

La tercera era (fig 1c) de la evolucién de los sistemas de computadoras
comenzé a mediados de los 70. El sistema distribuido (en este caso com-
putadoras madltiples, cada una ejecutando funciones concurrentes y

comunicdndose con alguna otra) incremento notablemente la complejidad
de los sistemas informéticos.

Réedes de 4rea local y global, comunicaciones digitales de alto ancho de
banda,la llegada y amplio uso de los microprocesadores y computadoras
personales, supusieron una fuerte presién sobre los desarrolladores de
software.

La cuarta era (fig 1d) en software de computadoras ha comenzando. Las
técnicas.de la cuarta generacién para el desarrollo de software estdn cam-
biando la forma en que algunos segmentos de la comunidad informética
construye los programas de computadora. Los sistemas expertos y el
software de inteligencia artificial se han trasladado finalmente del
'-laboratorio a aplicaciones prdcticas, en un amplio rango de problemas del
mundo real.

Es asi como el software se ha convertido en el elemento clave de la
evolucién de los sistemas y productos informé4ticos.

1.2 DEFINICION DE SISTEMAS Y CARACTERISTICAS.

La palabra sistema es posiblemente el término més sobreutilizado y del que
més se ha abusado en el léxico técnico. Hablamos de sistemas politicos y
educativos, sistemas bancarios y de ferrocarril. La palabra no dice poco.

Podemos definir un sistema como un conjunto u ordenacién de elementos
organizados para llevar a cabo algiin método, procedimiento o control
mediante el procesamiento de informacién.

Dependiendo ala formaenlaque se analizan los sistemas se tienen dos tipos
de sistemas :

- Abierto : En este, caso se deja al libre albedrio de la persona encargada.
- Cerrado : Se delimitan fronteras a partir de las cuales se trabajar4, de tal
forma que aquello que se encuentre fuera de las fronteras no afectars al
sistema, ,

Conforme al comportamiento que presentan los sistemas se tiene la
clasificacién siguiente : '

- Determinfstico : El comportamiento que presenta el sistema es siempre el
mismo.
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TEMA 1. ANALISIS DEL SISTEMA

~quifinalidad : En este ¢aso sea cual sea el estado inicial del sistema
1pre se llegard a un estado final Gnico.

.meostdtico : Para este caso los sistemas que se tienen siempre se est4n
nalimentando,

rolégico . : Este comportamiento se observa en todos los sistemas
'ue mantienc un proceso y persigue un objetivo.

CICLOS DE “IDA,

procedimien:os de la ingenieria del software son la cola que pega a los
odos y herramientas y facilita un desarrollo racional y oportuno del
ware de computadora. Los procedimientos definen la secuencia enla que
:plican los m#todos, las entregas (documentos, informes, formas,etc.)
se requierern, ios controles que ayudan a asegurar la calidad y coordinar

-

cambios y {as gufas que facllltan a los gestores del software establecer
2sarrollo.

‘iclo de vida 235 aquel que requiere un enfoque sistemdético, secuencial,
desarrollo de¢! software que comienza en el mvel del sistema y progresa
avés de sus diversas fases.

1 ciclo de vica tiene las fases siguientes :

—

ANALISIS PRELIMINAR |
‘EFINICION -l PLANIFICACION S

ANALISIS DE REQUERIMIENTQOS

—

ANALISIS DE ESPECIFICACION
"ESARROLLO — DISENO

CONSTRUCCION

—_—

—_—

CORRECTIVO
1 NTENIMIENTC  «—— ADAPTATIVO

AUMENTATIVO i

—
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ANALISIS Y DISERO DE SISTEMAS DE COMPUTO

TEMA I. ANALISIS DEL SISTEMA

LECTURA: FASES DEL CICLO DE VIDA. ’

El proceso de desarrollo del software contiene tres fases genéricas
independientemente del paradigma de ingenieria elegido. Las tres
fases, definicidén, desarrollo y mantenimiento, se encuentran en
todos los desarrollos de software, independientemente del &rea de
aplicacién, tamafio del proyecto o complejidad.

La fase de definicién se enfoca scobre el qué. Esto es, durante la
definicién, el que desarrolla el software intenta identificar qgué
informacidén ha de ser procesada, qué funcién y rendimiento se
desea, qué ligaduras de disefio existen y qué criterios de
validacidn se necesitan para definir un sistema correcto. Por
tanto, han de identificarse los requerimientos claves del sistema
-y del software. Aungque los métodos aplicados durante la fase de
definicidén variarén dependiendo del paradigma de ingenieria del
software aplicado, de alguna forma se producirdn tres pasos
especificos: .

Andlisis del sistema. El1 andlisis del sistema define el papel de
cada elemento de un sistema informitico, asignando finalmente el
papel que jugard el software.

Planificacién del proyecto. Una vez que esté asignado el ambito del
software, se asignan los recursos, se estiman los costes y se
definen las tareas y planificacién del trabajo.

Andlisis de requerimientos. El ambito definido para el software de
la direccidn, pero antes de comenzar a trabajar, es necesario
disponer de una informacién detallada del dominic de la informacién
y de la funcidén del software.

La fase de desarrollo se enfoca sobre el cdmo. Esto es, durante el
desarrollo, el gue desarrolla el software intenta descubrir cémo
han de disefiarse las estructuras de datos y arquitectura del
software, cémo han de implementarse los detalles procedimentales,
cémo ha de trasladarse el disefio a un lenguaje de programacién y
cémo ha de realizarse la prueba. Los métodos aplicados durante la
fase de desarrollo variarén dependiendo del paradigma de ingenieria“
del software aplicado. Sin embargo, de alguna forma se produciran
tres pasos concretos:

Disefio del software. El1 disefio traslada los requerimientos del
software a un conjunto de representaciones (algunas gradficas, otras
tabulares o basadas en lenguajes) que describen la estructura de
datos, arquitectura y procedimiento algoritmlco.

Codificacién. Las representaciones del disefio deben trasladarse a
un lenguaje artificial, que da como resultados unas instrucciones
ejecutables por la computadora El paso de la codificacidén ejecuta
esta traslacién.

Prueba del software. Una vez que el software se ha implementado en
una forma ejecutable por 1la médquina, debe ser probado para
descubrir los defectos que puedan existir en la funcién, légica e
implementacidn.

La fase de mantenimiento se enfoca sobre el cambio que va asociado
con una correccién de errores, adaptaciones requeridas por -la
evolucidén del entorno del software y modificaciones debidas a los
cambios de los requerimientos del cliente para reforzar o aumentar
el sistema. La fase de mantenimiento replica los pasos de las fases
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___de definicién y desarrollo,_—pero en el contexto del software
" existente. Durante la fase de mantenimiento se encuentran tres
tipos de cambios:

Correccién. Incluso con las mejores actividades para garantizar la
calidad, es probable que el cliente descubra defectos en el
software. El mantenimiento correctlvo cambia el software para
corregir los defectos..

Adaptacidén. Con el paso del tiempo es probable que cambie el
entorno original (por ejemplo, CPU, sistema operativo, periféricos)
para el cual se desarrolld el software. El mantenimiento adaptativeo
se traduce en modificacién del software para acomodarlo a los

-cambios de su entorno externo.

Aumento. Conforme se utiliza el software, el cliente/usuario
reconocerd funciones adicionales que podria ser beneficioso
afiadirlas.

Las fases y pasos relacionados descritos en esta visién genérica de
la ingenieria del software, se complementan con varias actividades
protectoras. Las revisiones se realizan durante cada paso para
asegurar gue se mantiene la calidad. La documentacidén se desarrolla
y controla para asegurar que toda la informacién sobre el sistema
y software estarin disponibles para un'uso posterior. El control de
los cambios se instituye de forma gque los cambios puedan ser
mejorados y registrados.

El m&todo en cada caso puede variar de un paradigma a otro, pero el

. enfoque global que exige la definicién, desarrollo y mantenimiento

permanece invariable. Se puede realizar con disciplina y metodos
bien definidos ¢ de forma completamente desordenada. Pero habra ‘'que
realizarlos de alguna forma.
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TEMA 2. ANALISIS DE REQUERIMIENTOS

TEMA 2. ANALISIS DE REQUERIMIENTOS

Subtema 2.1 Fundamentos del An4lisis de requerimientos

Para realizar bien el desarrollo de software es esencial realizar una
especificacién completa de los requerimientos del mismo.

Es importante realizar una especificacién completa de los requerimientos
del software, la tarea de andlisis de requerimientos es un proceso de des-

cubrimiento y refinamiento, de ahf la importancia de una buena
especificacién.

El papel del desarrollador de software y del cliente es un papel activo, el
cliente intenta reformular su concepto de la funcién y comportamiento de
los programas en detalles concretos, el que desarrolla el software actia
como interrogador, consultor y el que resuelve los problemas.

El analista.

El analista ejecuta o coordina cada una de las tareas asociadas con el anélisis
de los requerimientos de software.

El analista debe exhibir los siguientes"rasgos de cardcter :

- Habilidad para comprender conceptos abstractos, reorganizarlos en
divisiones l16gicas y sintetizar "soluciones” basadas en cada divisién.

- Habilidad para entresacar hechos 1mp0rtantes de fuentes conflictivas o
confusas. ‘

- Habilidad para comprender entornos de usuario/cliente.

- Habilidad para aplicar elementos hardware y/o software a entornos de
usuario/cliente.

. - Habilidad par comunicarse bien en forma escrita y verbal.

++Los individuos que se paran excesivamente en los detalles con frecuencia
- pierden de vista el objetivo global de los programas. Los requerimientos del
software deben ser descubiertos de una manera "descendente”; las funciones
--importantes, interfaces e informacién deben comprenderse completamente
antes de que se especifiquen los detalles de las capas sucesivas.

Los problemas subyacentes al anélisis de requerimientos son atribuibles a
muchas causas: |
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TEMA 2. ANALISIS DE REQUERIMIENTOS

“‘bre comunicacién : Esto hace diffcil 1a adqulslc16n de la informacién.

‘cnicas y herramientas inadecuadas : Esto produce especificaciones in-
cuadas o imp-ecisas. S

~ndencia a acortar el andlisis de requerimientos : Conduce a un anélisis -

:table.
1fallo en coc:iderar alternativas antes de que sé especifique el software.
ncipios del a: dlisis.

ia método ¢- anilisis tiene una Gnica notacién y punto de vista. Sin

sargo, todos .os métodos de andlisis estdn relacionados por un conjunto.

orincipios furdamentales :

Z] dominio 2 la informacién, asi como el dominio funcional de un
‘hlema debe ::r representado y comprend1d0

2]l problemra < zbe subdividirse en forma que se descubran los detalles de
» manera prc:resiva (o jerdrquica). -

Deben desarr :llarse las representaciones légicas y ffsicas del sistema.

.ciendo refer:ncia.un poco al dominio de la informacién. Todas las
.icaciones del software pueden colectivamente llamarse procesamiento de
os. Este término contiene la clave de lo que entendemos por re-
:rimientos d:=! software. El software se construye para procesar datos,
co transformz: datos de una forma a otra; esto es, para aceptar entrada,

_ ‘nipularla de -lguna formay produc1r una salida.

:yamos ahora 2 la construccién de prototipos del software

algunos cascs; es posxble apllcar los pr1nc1plos de andlisis fundamental y

¢ :rivar a una especificacién en papel del software desde el cual pueda
: -sarrollarse ur disefio. En otras situaciones, se va a una recoleccién de los

o

A

r.querimientos. se aplican los principios de anélisis y se construye un

ydelo de software, llamado prototipo, segin las apreciaciones del cliente
del que lo desarrolla. Finalmente, hay circunstancias que requieren la
:astruccién de un prototipo al comienzo del andlisis, puesto que el modelo

. el inico medio mediante el cual los requerimientos pueden ser derlvados

‘activamente.

Ferfil de las especificaciones de los Requerimientos del Software.
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TEMA 2. ANALISIS DE REQUERIMIENTOQS

La especificacién de requerimientos de software se produce en la
.culminacién de la tarea de anélisis. La funcién y comportamiento asignados
al software como parte de la ingenieria de sistemas se refina estableciendo
una descripcién completa de la informacién, una descripcién funcional
detalla, una indicacién de los requerimientos de rendimiento y las ligaduras
de disefio, unos criterios de validaci6én apropiados y otros datos pertinentes
a los requerimientos.

Subtema 2.2 Métodos de Andlisis de Requerimientos.

Las metodologfas de anélisis de requerimientos combinan procedimientos
sistemdticos con una notacién finica para analizar los dominios de
informacién y funcionalidad de un problema de software. En esencia, los
métodos de andlisis de requerimientos del software, facilitan al ingeniero

de software aplicar principios de anélisis fundamentales, dentro del contex-
to de un método bien definido.

Todos los métodos pueden ser evaluados en el contexto de las siguientes
caracteristicas comunes :

1 ).mecanismos para el anélisis dél dominio de la informacién
2 ) método de representacién funcional

3 ) definici6n de interfaces

4 ) mecanismos para subdividir el problema

5) soporte de la abstraccién

6 ) representacién de las visiones fisicas y légicas

La mayoria de los métodos de anélisis permiten al analista evaluar la repre-
sentacidn fisica de un problema antes de derivar a la solucién légica.

Métodos de anilisjs orientados al flujo de datos.

Entrada, Saiida,

Sistema .
Entrada., = basado en Salida,
computadora .

Entrada, Salida,,

Fiujo de Informacion.
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TEMA 2. ANALISIS DE REQUERIMIENTOS

— T(fig 5.1) Una técnica para represeEtar el‘fll-ljo de--informacién"a través del

sistema basado en computadora lo podemos ver en esta figura. La funcién
global del sistema se representa como una transformacién sencilla de la
informacién, representada en la figura como una burbuja. Una o mi4s
entradas, representadas como flechas con etiquetas, conducen la
transformacién para producir la informacién de salida.

Un diagrama de flujo de datos (DFD), es una técnica grifica que describe el .

flujo de informacién y las transformaciones que se aplican a los datos,
conforme se mueven de la entrada a la salida.

LEntidad:
i o2

 Entidad’

Almaceén de datos

(fig 5.2) La forma bédsica de un DFD lo podemos ver en esta figura. El DFD
puede usarse para representar un sistema o software a cualquier nivel de
abstraccién. Ademds pueden particionarse en niveles que representan flujo
incremental de informacién y detalle funcional.

Entidad externa: Una fuente de entradas al sistema,
o tuente de saiidas del sistema

Proceso: Ejecuta alguna transformacidn
Q de sus dstos de entrada, produciendo

sus datos de salida

m Flujo de datos: ~  Se usa para conectar los procescs
entre si, a ias fuentes o a los sumideros;
la cabezs de las fechas indica
la direccidén de transferancia de los datos

‘—\ : Almacén de datos: Un depésito de daios; la cabeza
de las {lechas indica las entradas

y salidas al aimacén

(fig 5.3) La simbologfa de un DFD la podemos ver en esta figura. Se utiliza
un rectdngulo pard representar una entidad externa, esto es, un elemento
del sistema (por ejemplo una persona). Un circulo representa un proceso o
transformacién que se aplica a los datos y que los cambia de alguna forma.
Una flecha representa uno o méis elementos de datos. Todas las flechas de
un diagrama de flujo de datos deben estar etiquetadas. Una doble linea
representa un almacenamiento de datos (informacién almacenada que es
usada por el programa). Debido a la excepcional simplicidad de la
simbologfa del DFD es una de las razones por las que las técnicas de anélisis
orientadas al flujo de datos son tan ampliamente usadas.
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TEMA 2. ANALISIS DE REQUERIMIENTOS

Métodos orientados a la estructura de datos.

Puesto que el dominio de la informacién para un problema de software
comprende el flujo de datos, el contenido de datos y la estructura de datos.
Los métodos de anélisis orientados a la estructura de datos representan los
requerimientos del software enfocdndose hacia la estructura de datos en vez
de al flujos de datos. Aunque cada método orientado a la estructura de datos

tiene un enfoque y notacién distinta, todos tienen algunas caracterfisticas en
comin como son:

Primero, todos asisten al analista en la identificaci6én de los objetos de
informacién clave (también llamados entidades) y operaciones (también
llamadas acciones o procesos)

Segundo, todos suponen que la estructura de la informacién es jerdrquica

Tercero, todos requieren que la estructura de datos se represcnte usando la
secuencia, seleccién y repeticién. (vistas anteriormente)

y cuarto, todos dan un conjunto de pasos para transformar una estructura de
datos. jerdrquica en una estructura de programa.

Dentro de los métodos orientados a la estructura de datos, el desarrollo de

sistemas estructurados de datos (DSED), también llamado metodologia de
Warnier-Orr, se basa en el trabajo sobre anédlisis del dominio de
informacién, realizado por J. D. Warnier. Warnier desarrollo una notacién

para representar la jerarqufa de la informacién usando las tres construc-
ciones :

1) Secuencia

2 ) Seleccibn

3 ) Repeticién

El diagrama de Warnier facilita al analista representar jerarquias de
informacién de una manera compacta. Se analiza el dominio de la
informacién y representa la naturaleza jerdrquica de la salida.

El método, comprende todos los atributos del dominio de informacién:

flujo, contenido y estructura de datos. Para ilustrar la notacién y dar una
visi6bn general del método de anélisis,
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TEMA 2. ANALISIS DE REQUERIMIENTOS

juerimientos de las bases de datos

:érmino de i~ase de datos actualmente se ha convertido en uno de los
:hos tépicos del campo de las computadoras. Podemos definir una base
datos como una coleccién de informacién organizada de forma que
ilita el acces :, andlisis y creacién de informes.

anélisis de r:juerimientos para una base de datos incorpora las mismas
zas que el anilisis de requerimientos del software. Es necesario un con-
0 estrecho - :n el cliente; es esencial la identificacién de las funciones
.nterfaces; :c requiere la especificacién del flujo, estructura y

‘ciatividad ¢: la informacién y debe desarrollarse un documento formal
los requerim:2ntos.
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TEMA II. ANALISIS DE REQUERIMIENTOS
LECTURA: AREAS DEL ANALISIS DE REQUERIMIENTOS.
El andlisis de requerlmlentos puede dividirse en cuatre éreas

1) reconocimiento del problema.

2) evaluacién y sintesis

3) especificacién vy

4) revisién
Inicialmente, el analista estudia la especificacidn del sistema (si
existe) y el Plan del Proyecto. Es importante comprender el
contexto del sistema y revisar el dmbito de los programas cue se
uso para generar las estimaciones de la planificacién.
Posteriormente, debe establecerse la comunicacién necesaria para el
anilisis, de forma que se asegure el reconocimiento del problema.
El analista debe establecer contactoc con el equipo técnico y de
gestidén del usuario/cliente y con la empresa que vaya a desarrollar
el software. El1 gestor del programa puede ser-ir como coordinador
para facilitar el establecimiento de los cam. 7s de comunicacidn.
El objetivo del analista es reconocer los e. mentos bésicos del
programa tal como lo percibe el usuario/clier .2,
La evaluacidédn del problema y la sintesis de la solucidn es 1la
siguiente &rea principal de trabajo del andlisis. El analista debe
evaluar el flujo y estructura de la informacién, refinar en detalle
todas 1las funciones del programa en detalle, establecer las
caracteristicas de la interface del sistema y descubrir las
ligaduras del disefio. Cada una de las tareas sirven para describir
el problema de forma que pueda sintetizarse un enfogue o solucxén
global.
Por ejemplo, un importante suministrador de materiales de
fontanerfa necesita un sistema de  control de inventario. E1
analista encuentra que los problemas con el sistema manual actual
incluyen:
1) imposibilidad de obtener rapldamente el estado de una
componente.,
2) dos o tres dias de tiempo medio para actuallzar un archivo de
tarjetas y "
- 3) multlples reérdenes del mismo vendedor dEbldO a que no hay forma
> de asociar vendedores como componentes, etc. Una vez que se han
identificado los problemas, el analista determina qué informacidn
va a ser producida por el nuevo sistema y qué& datos se 1le
suministrarin al sistema. Por ejemplo, el cliente desea un informe
diario que indique los elementos que se han tomade del inventario
y cudntos elementos similares permanecen. el cliente indica que los
empleados del inventario registrarin el nlmero de identificacién de
cada pieza cuando dejen el &rea de inventario.
Hasta la evaluacién de los problemas actuales y de la informacidn
deseada (entrada y salida), el analista comienza por sintetizar una
© mas soluciones. Un sistema basado en un terminal en 1linea
resolverd varios problemas, pero parece que se va-a necesitar un
sistema de gestién de base de datos, pero :;estd justificada 1la
necesidad de asociatividad el usuario/cliente? El1 proceso de
evaluacién y sintesis continia hasta que el analista y el cliente
creen que el software puede ser especificado adecuadamente para la
fase de desarrollo.
En una etapa no es posible hacer una especificacién detallada. El
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20 estar seguro de precisar bien lo que quiere. El
21 software puede no estar sequro de que un enfoque
sropiado para realizar la funcién y comportamiento

éstas razones puede presentarse un enfoque
amado construccién de prototipos, para el anilisis
28.( ‘Se tratard la construcciédn de prototipos méis

iadas con el andlisis y especificacién existen para
antacién del programa que pueda ser revisada vy

cliente. En un mundo ideal el cliente desarrolla
":6n de Requerimientos del Software completamente por
5e presenta raramente en el mundo real. En el caso
zcificacidén se desarrolla conjuntamente entre el

-;:CniCOo .
se hayan descrito las funciones |Dbéasicas,
interface e informacién, se especifican 1los

‘alidacién para demostrar una comprensién de una
"antacién de los programas. Estos criterios sirven
+ hacer la prueba durante el desarrollo de los
'a definir las caracteristicas y atributos del
zribe una especificacién de requerimientos formal.

.38 casos en los que se desarrolle un prototipo se

.al de Usuario Preliminar.

.nnecesario desarrollar un manual de usuario en una

rana -del proceso de desarrollo. Pero de hecho, este

ual de usuario fuerza al analista a tomar el punto
usuarioc del software. El1 manual permite al

»~ revisar el software desde una “perspectiva de

.na y.frecuentemente produce el comentario: "La idea

. 2ro ésta no es la forma en que pensé que se podria

Es mejor descubrir tales comentarios
rosible en el proceso.

del andlisis de requerimientos (especificacién y

lo més

.io) sirven como base para una revisidn conducida por
+1 técnico.
.e modificaciones en 1la funcién,

La revisiédn de los requerimientos casi
conportamiento,
la informacién, ligaduras o criterios de
se realiza una nueva apreciacién del Plan del
‘are para determinar si las primeras estimaciones

de

vdlidas después del conocimiento adicional obtenido

durante el analisis.
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LECTURA: ANALISIS ORIENTADO AL OBJETO. :

El disefio orientado al objeto (DOQ), como otras metodologias de
" disefilo orientadas a la informacidn, crea una representacién del
dominio del problema en el mundo real y lo transforma en un dominio
de solucién que es software, A diferencia de otros métodos , el DOO
da como resultadeo un disefio que interconexiona los objetos de
datos (elementos de datos) y las operaciones de procesamiento, de
forma que modulariza la informacidn y el procesamiento en vez de
sblo el procesamiento.

La naturaleza Gnica del disefio orientado al objeto estd ligada a su
habilidad para construir, basindose entres conceptos importantes de
disefio del software: abstraccién, ocultacidén de la informacién y
modularidad. Todos los métodos de disefio buscan la creacién de
software que exhiba estas caracteristicas fundamentales, peroc sdlo
DOO da un mecanismo que fac lita al disefiador adquirir los tres sin
complejidad o compromiso.

Origenes del disefio orientado al objeto.

Los objetivos y las operaciones no son un nuevo concepto de
programacién, pero si lo es el disefio orientado al objeto. En los
primeros dias de 1la computacidn, 1los lenguajes ensambladores
facilitaban a los programadores la utilizacidn de las instrucciones
midgquina (operadores) para manipular 1los elementos de datos
(operandos). El nivel de abstraccidn que se aplicaba al dominio de
la solucién era muy bajo.

Conforme aparecieron los lenguajes de programacidén de alto nivel
(por ejemplo Fortran, algol, cobol, etc) los objetos y operaciones
del espacio de problemas del mundo real podian ser modelados
mediante datos y estructuras de control predefinidas, que estaban
disponibles como partes del lenguaje de alto nivel. En general, el
disefio de software se enfocaba sobre la representacidn del detalle
procedimental . usando el 1lenguaje de programacidn elegido. Los
conceptos de disefio, tales como refinamientos sucesivos de una
funcién, modularidad procedimental y, posterjormente, programacién
estructurada, fueron introducidos entonces.

Durante los afios 1970, se intrudujeron conceptos tales como
abstracciédn y ocultacién de la informacidén y, emergieron métodos de
disefio conducidos por los datos, pero los gue desarrollaban
software aln se encontraban sobre el proceso y su representacién.
Al mismo tiempo, los lenguajes de alto nivel modernos (por ejemplo
Pascal) introdujeron una variedad mucho mds rica de tipos Yy
estructuras de datos.

Aunque 1los lengua]es de alto nivel convenc1ona1es (lenguajes a
partir de Fortran y algol) evolucionaron durante los afios 1960 y
1970, los investigadores estaban trabajando mucho sobre una nueva
clase de lenguaje de simulacidn de prototipos, tales como Simula y
Smalltalk. En estos lenguajes, la abstraccién de datos tenia una
gran importacia y los problemas del mundo real se representaban
mediante un conjunto de objetos de datos, a los cuales se les
afiadia el correspondiente conjunto de operaciones. El uso de estos
lenguajes era radicalmente diferente del uso de los lenguajes més
convencionales.

El método del disefio orientado al objeto ha emergido durante los
dltimos 17 afios. Los primeros trabajos en disefio de software
pusieron la base estableciendo la importancia de la abstraccidn,




software. En algunos aspectos, los métodos de disefio orientados a
estructuras de datos tales como Desarrollo de Sistemas
Estructurados de Datos (DSED) y Desarrollo de Sistema de Jackson
(DsJ) , pueden verse como orientados al objeto.
Durante los aflos 1980 la ripida evolucién de los lenguajes de
programacidén Smalltalk y Ada causaron un creciente interés en D0O.
En las primeras discusiones sobre el m&todo para consegquir un
disefio orientado al objeto. Abbott mostrd "cémo el anilisis de
sentencias en lenguaje natural del problema y sus solucidn, pueden
usarse como guia para desarrollar la parte visible de un paquete
Gtil (un paquete Gtil que tenga los datos y procedimientos que
operan sobre ellos) y el algoritmo particular para un problema
dado". Booch extendid el trabajo de Abbott y ayudé a popularizar el
concepto de disefio orientado al objetoc. Hoy el DOO se estd usando
en aplicaciones de disefio de software que van desde animaciones de
graficos por computadora a las telecomunicaciones.
Conceptos del disefio orientado al objeto.
Como otros métodos de disefio, el DOO introduce un nuevo con junto
de terminologia, notacién y procedimientos para la derivacién de un
disefio del software.
La funcidén del software es relacionada cuando una estructura de
datos (de distintos niveles de complejidad) es manipulada mediante
unc o mas procesos, de acuerdo con un procedimiento definido
mediante un algoritmo estdtico y 6rdenes dindmicas. Para conseguir
un disefio orientado al objeto, se debe establecer un mecanismo
para: :

1) la representacidén de la‘estructura de datos

2) La especificacién del proceso y

3) El procedimiento de llamada.
Un objeto es una componente del mundo real que se transforma en el
dominio del software. En el contexto de un sistema basado- en
computadora, un objeto es normalmente un procedimiento o ¢onsumidor
de informacidn o un elemento de informacién. Por ejemplo, objetos
tipicos pueden ser: mAquinas, érdenes, archivos, visualizaciones,
conmutadores, sefiales, c¢adenas alfanuméricas o cualquier otra
persona, lugar © cosa. Cuando un objeto se transforma en una
realizaciédn software, consta de una estructura de datos privada y
procesos, llamados operaciones o métodos, que pueden transformar
legitimamente la estructura de datos. Las operaciones contienen el
control y las construcciones procedimentales que pueden ser
ilamadas mediante un mensaje una peticidén al objetoc para que
ejecute una de ‘sus operaciones. La realizacién software de un
objeto se muestra en la figura (fig
9.1).
Refiriéndose a la figura, un objeto del mundo real (un diccionario)
se transforma en una realizacién software para un sistema basado en
computadora. La realizacién software de un diccionario exhibe una
estructura de datos privada y las operaciones relativas a ella. La
estructura de datos puede tomar la forma descrita mediante
diagramas de Warnier-orr de la figura (fig 9.2). Las entradas del
diccionario estéan compuestas de palabras, una guia de pronunciacién
y una o mis definiciones. Un dibujo o dlagrama puede estar también
contenido dentro de una entrada. El diccionario de objetos también
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iene un <c¢onjunto de operaciones que puede procesar los
rentos de la estructura de datos. La parte privada de un objeto
a estructura de datos y el conjunto de operaciones para 1la
-uctura de catos.
. bjeto tier- también una parte compartida que es su interfaz. '
z mensajes s:- mueven a través de la interfaz y especifican qué
~ vaciones de! objeto se desean, pero no cémo se va a realizar la
< -acién. El :>bjeto que recibe un mensaje determina cémo se
_ementa la . weracién solicitada. _
I .niendo un :>jeto con una parte privada y dando mensajes para
. :ar al proc-samiento adecuado, se consigue la ocultacidn de 1la
: rmacidén; =:to es, los detalles de la implementacién estéan
© ‘tos a todc.: los elementos del programa exteriores al objeto.
L objetivos :* sus operacicones dan una modularidad inherente; esto
z los elemern: s del software (datos y procesos) se agrupan junto
o los mecani:zos de interfaces bien definidos.
I a2sta forma 2 tiene que el andlisis orientado al objeto puede
< :ribirse d= la siguiente forma:
El softwa 2 asignado (o el sistema entero) se describe usando
una estr:z.2gia informal. La estrategia no es mas gque una

SOmomomonN

descripci-n en lenguaje natural de la solucién del problema
que hay <. 2 resolver, mediante el software representado a un
nivel cor:istente de detalle. La estrategia informal puede ser
establec! 2 en forma de parrafos sencillos, gramaticalmente
correctos

: Los obje: .vos se determinan subrayando cada nombre o cléusula
nominal introduciéndclo en wuna tabla - sencilla. Deben
anotarse "os sindnimos. Si se requiere que el objeto se
implement - como una solucién, entonces es-parte del espacio de
solucién; =2n otros casos, si un objeto es necesario sdlo para
describir una solucién, es parte del espacio del problema. -
Los atri: zos de los objetos se identifican subrayando todos

los adje: —os y luego asoci&ndolos con sus objetos respectivos
(nombres:
- Las oper:.iones se determinan subrayando todos los verbos,
frases vz 'pales y predicados (una frase verbal indica un test
condicicr 1) y relacionando cada operacién con el objeto
apropliadc
z Los atri: :tos de las operaciones se identifican subrayando
todos los adverbios y luego asocii&ndolos con sus operaciones
respectiv:s (verbos). _
-a ilustrar :1 método de andlisis orientado al objeto, considere '
siguiente t-xto:
El softw:-e SCCT recibird la jinformacidn de entrada de un
lector de -6digo de barras a intervalos de tiempo gue estén de
acuerdo cun la velocidad de la cinta transportadora. Los datos
del cb6di:> de barras se decodificard&n en un formato de
identific:cién de caja. El software examinard una base de
datos de :nas 1000 entradas para determinar la posicién del
cubo apr-.iado para la ¢aja que actualmente esti en el lector
(estaciér, de clasificacién). SE usard una lista FIFQ para
tomar not: de las posiciones de envio de cada caja conforme se

mueve por la estacién de clasificacidn.
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- - E1 software SCCT reciblré también entrada de un tacémetro de
pulsos que se usard para sincronizar la gefial de control con
el mecanismo de envio. Bas&ndose en el nGmero de pulsos que se
generardn entre la estacién de clasificacién y el envio, el
software producird una sefial de ¢ontrol a la estacién de envio
indicando la posicién correspondiente de la caja...

Analizando un poco el texto anterior muchos de 1los nombres
subrayados indican que residen en el espacio del problema y n o son
necesarios para la implementacién del programa. Otros nombres,
tales como datos del cédigo de barra, posiciédn del cubo y sefal de
control, residen en el espacio de la solucién e introducen en la
tabla de objetos y operaciones. Sigquiendo el procedimiento de
andlisis orientado al objeto, se subrayan a continuacién todos lo
adjetivos y se colocan en la tabla como se muestra en ella. .
Cuando uno de los objetivos representa un elemento de informacién
gque debe ser procesado por el programa. Para determinar 1las
funciones de procesamiento, debemos aislar todas las operaciones.
Por lo que siguiendo el procedimiento de andlisis:
El software SCCT recibird la informacién de entrada de un
lector de cdédigo de barras a intervalos de tiempo conforme a
la velocidad de la cinta transportadora. Los datos del cédigo
de barras se decodificarén en un formatc de identificacién de
caja. El software examinard una base de datos de unas 1000
‘entradas para determinar la posicién apropiada del cubo para
la caja que actuvalmente estd en el lector (estacidn- de
clasificacién). Se usari una lista FIFO para tomar nota de las L
posiciones de envic de cada caja conforme se mueve por la -“'f
estacidén de clasificacidn.: : ‘ ’
El software SCCT recibird también entrada de un tacémetro de
pulsos que se usard para sincronizar la sefial de control con
el mecanismo de envio. Basdndose en el nGmero de pulsos que se
generarin entre la estacién de ordenacién envio, el software
producird una sefial de control a la estacién de envio
indicando la posicién correspondiente de la caja...




TABLA
OBJETOS Y OPERACIONES

Objeto Atributo Operacién correspondiente
Datos Cédigo de caja ' Decodificador
Posicién Caja Determinar

Sefial : Control Sincronizar, producir
Entrada Tac. pulso Recibir

Lista FIFO Tomar nota

Posiciones Envio . Tomar nota

Intervalos Tiempo Conformar

Formato Id. caja Decodificar

Base de datos 1000 entradas Examinar

Pulsos Tac. Generado

Algunas de las operaciones anotadas pertenecen al espacio de
soluciébn (por ejemplo recibir, buscar, producir) mientras que otras
son parte del espacioc del problema (por ejemplo sincroniza). Las

operaciones del espacio de solucién se afiaden a la tabla de objetos
y operaciones.
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URA: CONSTRJCCION DE PROTOTIPOS. :
ndlisis de:= ser conducido independientemente del paradigma de
nieria de :oftware aplicado. Sin embargo, la forma que ese
isis tomar: puede variar. En algunos casos es posible aplicar
principio=: de an&lisis fundamental y derivar a una
cificacién en papel del software desde el <cual pueda
rrollarse ''n disefio. En otras situaciones, se wva a una
‘lecciédn de los requerimientos, se aplican los principios de
isis y s« construye un modelo de software, llamado un
otipo, sec¢''n las apreciaciones del cliente y del que 1lo
rrolla, F.:almente, hay circunstancias que requieren 1la
“truccidn <d- un prototipo al comienzo del andlisis, puesto que
codelo es :. Gnico medio mediante el que los requerimientos
:en ser der . -ados efectivamente.
odelo entor '2s se transforma en una produccién de software. En
.08 casos (' :ngue no todos), la construccidn de un prototipo,
zlado posib. :mente con métodos de andlisis sistemdticos, es una
-a efectiva le ingenieria del software.
:s los prov- 2tos de ingenierlia del software comienzan con una
.cién del < .iente. La peticidn puede estar en la forma de una
>ria que decs :ribe un problema, un informe que define un conjunto
>bjetivos c: -erciales o del producto, una Peticidn de Propuesta
~al de una 2 .2ncia o compafiia exterior, o una Especificacidn del

. zema que ha 2signado una funcién y comportamiento al software,

> un eleme- "> de un sistema basado en computadora. Suponlendo
existe una <=ticidn para un programa de una de las formas para
struir un :r-ototipo del software  se aplican los siguientes
383
> 1. Evalu:r la peticién del software y determinar si el
jrama a dewirrollar es un buen candidato para construir .un
cotipo. Nc todos 1los programas son adecuados para ' la
struccidn ie prototipos. Varios factores de candidatura ‘de
strucciédn 'z prototipos pueden ser definidos: "“8rea de
icacién, c:-:plejidad, de la aplicacidn, caracteristicas del
2nte y cara:teristicas del proyecto.
:do a que e. cliente debe interaccionar con el prototipo en los
imos pasos, =s esencial que:
1) El1 cli-nte participe en la evaluacién y refinamiento del
prototipc
2) El clisnte sea capaz de tomar decisiones de requerlmlentos
de una fc:ma oportuna.
a1lmente, la naturaleza del proyecto de desarrolle tendra una
~te influencia en la eficacia del prototlpo.
> 2. Dade un proyecto candidato aceptable, el analista
arrolla una representacidén abreviada de los requerimientos.
2s de que ruieda comenzar la construccién de un prototipo, el

‘lista debe rapresentar los dominios funcionales y de informacién

programa y desarrollar un método razonable de particién.
D> 3. Despué= de que se haya revisado la representacién de los

-uerimientos. se crea un conjunto de espec1f1cac1ones de disefio

- .aviadas par: el prototipo. El disefio debe ocurrir antes de que
.ience la construccidén del prototipo. Sin embargo, el disefio de

orototlpo s+ »nfoca normalmente hacia la arquitectura a nivel

aglior y a los aspectos de disefio de datos, en vez de hacia el




disefio procedimental detallado.
PASO 4. El software del prototipo se  crea, prueba y refina.
Idealmente, los bloques de construccién de software preexistentes
se utilizan para crear el prototipo de una forma ripida. Debido a
que tales bloques construidos raramente existen. Alternativamente,
pueden usarse herramientas de construccidén de prototipos
especializadas para asistir al analista/disefiador en 1la
representacién del diseflo y traducirlio a una forma ejecutable
~8i la 1mplamentac16n de un prototipo gque funcione es impracticable,
el escenario de construccién de prototipos puede aGn aplicarse.
Para las aplicaciones interactivas con el hombre, es posible
frecuentemente crear un prototipo en papel que describa 1la
interaccién hombre-méqulna (preguntas, presentaciones, decisiones,
etc.) usando una serie de hojas de historia. Cada hoja de historia
contiene una representacién de una imagen de la pantalla con texto,
que describe la interaccién entre la maquina y el usuario. El
cliente revisa las horas de historia, obteniendo una perspectiva de
usuario de la operacién del software.
PASO 5. Una vez que el prototipo ha sido probado, se presenta al
cliente, el cual "conduce la prueba" de la aplicacién y sugiere’
modificaciones. Este paso es el nficleo del método de construccién
de prototipo. Es aquf donde el cliente puede examinar una
representac16n implementada de los requerimientos del programa,
sugerir modificaciones que har&n al programa cumplir mejor las
necesidades reales.
PASO 6. Los pasos 4 ¥ 5 se repiten iterativamente hasta que todos
los requerimientos estén formalizados o hasta gque el prototipo haya
evolucionado hacia un sistema de produccién. El1 paradigma. de
construccién del prototipo puede ser conducido con uno o dos
objetivos en mente: )
1) el propdsito del prototipo es establecer un conjunto de
requerimientos formales que pueden luego ser traducidos en la
produccién de programas mediante el uso de métodos y técnicas
de ingenieria de programacién, o
2) el propdésito de la construccién del prototipo es
suministrar un continuo que pueda conducir al desarrollo
evolutivo de la produccién del software. Ambos métodos tienen
sus méritos y ambos crean problemas.
Métodos y herramientas para la construccidén de prototipos.
Para que la construccién de prototipos de software sea efectivo, un
prototipo debe desarrollar rédpidamente, de forma que el cliente
pueda comprobar 1os resultados y recomendar cambios. Para conseguir
una construccién réplda de prototipo, existen tres clases genérlcas
de métodos y herramientas: Técnicas de la cuarta generacién,
componentes de software reusables, especificacién formal y entornos
de construccién de prototipo.
TECNICAS DE LA CUARTA GENERACION. Las técnicas de 1la cuarta
generaciédn (4GT) comprenden un amplio repertorio de lenguajes de
informes y pregquntas de base de datos, generadores de programas Yy
aplicaciones y otros lenguajes no procedimentales de muy alto
nivel. Debido a que las 4GT facilitan al ingeniero de programacidn
general, cbédigo ejecutable répidamente, son ideales para la
construccidén rédpida de prototipos. Desafortunadamente, el dominio
de aplicacidén de las 4GT estd actualmente limitado a sistemas de




informacién comerciales.

COMPONENTES DE SOFTWARE REUSABLES. Otro método para la construccién
rdpida de prototipos es ensamblar, en vez de construir, el
prototipo usando un conjunto de componentes software existente. Una
componente software puede ser una estructura de datos (o base de
datos) o una componente arquitectdnica software (por ejemplo un
programa © una componente procedimental (es decir, un médulo). En
cada caso, la componente software debe ser disefiada en forma que
facilite el ser reusada sin conocer los detalles de su
funcionamiento interno. Debe observarse que un producto software
existente puede ser usado como un prototipo para un "nuevo,
mejorado" producto competitivo. De alguna forma, esto es una forma
de reusabilidad para la construccidn de prototipos de software.
ESPECIFICACION FORMAL Y ENTORNOS PARA LA CONSTRUCCION DE
PROTOTIPOS. Se han desarrollade varios lenguajes de especificacién
_formal para reemplazar las técnicas de especificacién en lenguaje
natural. Hoy, los desarrolladores de estos lenguajes formales estén
en el proceso de desarrollar entornos interactivos que: -
1) facilite al analista <crear interactivamente |una
especificacidn basada en el lenguaje de un sistema o software;
2) 1llame a herramientas automiticas que traduzcan las
especificaciones basadas en lenguajes en cédigo ejecutable y
3) faciliten al cliente utilizar el cdédigo ejecutable del
‘prototipo para refinar los requerimientos formales.
La forma de espec1f1car tiene mucho que ver con la calidad de la
solucidén. Los ingenieros de software que ‘se’ han esforzado ‘en
trabajar con especificaciones incompletas, 1ncon51stentes o mal
establecidas han "experimentado la frustacién y confusién que
invariantemente se produce. Las consecuencias se padecen en -la
calidad, oportunidad y completitud del software resultante.
Las técnicas de anilisis pueden conducir a una especificacion-en
papel gue contenga las descripciones graficas y el lenguaje natural
de los requerimientos del software. La construcciédn de prototipos
conduce a una especificacién ejecutable, esto es, el prototipo
sirve come una representacidén de los requerimientos. Los lenguajes
de especificacidén formal conducen a representaciones formales de
los requerimientos que pueden ser verificados o analizados.

N
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LECTURA: BASES DE DATOS.

Un sistema de base de datos.

Se puede definir un sistema de base de datos como un sistema de
mantenimiento de registros, basado en computadoras, es decir, un
sistema que de manera general registra y mantiene informacidén de
importancia para la organizacién donde el sistema opera.

Un sistema de base de datos tiene cuatro componentes principales:
datos, hardware, software y usuarios.

Datos

Se refieren a los valores registrados dentro de la base de datos.
Es importante distinguir entre "datos" e informacidén" ya gque no
siempre significan lo mismo. Un dato, simplemente es un valor
(nGmero, letras,...) mientras que la informacién es el significado
.de esos valores segfin el sentido que les dé& el usuario. Los datos
se dividen en una o mas bases de datos, pero didacticamente es
valido suponer que existe una sola base de datos.

Hardware ,

Se compone de los volGmenes de almacenamiento secundario (discos,
tambores),...) donde se encuentra la base de datos Jjunto con
dispositivos asociados (unidades de contrel, canales,...).
Software

Es un sistema de administracién de bases de datos o DBMS y existe
entre el usuario y la base de datos fisica. Este DBMS maneja todas
las solicitudes de acceso a la base de datos y protege a los
usuarios contra los detalles a nivel hardware apoyando las
operaciones del usuario.

Usuarios

Se pueden considerar diversos tipos de usuarios. :

Existe el wusuario programador de apiicaciones quien escribe
programas de aplicacién que utilicen bases de datos. Dichos
programas recuperan informacidn, crean informacidén, suprimen o
cambian informacidén, y en general operan con los datos de todas las
maneras posibles.

El usuario final es qgquien accesa la base de datos desde una
terminal. Dicho acceso lo realiza a través de un lenguaje de
consulta con el cual puede realizar todas las funciones de
recuperacidn, creac16n, modificacién y supresién de la informacién
contenida en la’base de datos.

El usuario administrador de Bases de Datos o DBA es quien organiza
el sistema para un desempefio adecuado y le hace los ajustes
necesarios al cambiar los requerimientos.

Objetivos de los sistemas de bases de datos

El objetivo primordial de un sistema de base de datos es
proporcionar a la empresa un control centralizado de sus datos.
Dicho control trae consigo diversas ventajas:

Control de la Redundancia. ) ]
Se evita que cada aplicacién tenga sus propios archivos

.
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-(Redundancia=Informac16n repetida).” La Redundancia propicia un
desperdicio del espacxo de almacenamiento. En ocasiones, 1la
redundancia no se elimina totalmente (por rabones técnicas o
comerciales) sin embargo se controla y el sistema debe

responsabilizarse de propagar las actualizaciones que se le hagan
a los datos.

Evitar Inconsistencias.

Cuando en un sistema de bases de datos, existe redundancia, hay
duplicidad de datos. Esta duplicidad puede originar que en
determinado momento una actualizacién no se propague correctamente
y se dé& la inconsistencia de datos. En este momento, la informacién
no ser& totalmente confiable, ya que, datos repetidos no son
concordantes y la base de datos es inconsistente. Con lo anterior,

se puede decir que la 1nconsxstenc1a se puede evitar si se controla
la redundancia.

Datos Compartidos.

Se pueden tener aplicaciones que compartan los datos de la base de
datos, e incluso, aplicaciones que operen con los mismos datos
almacenados. Con ellos, nuevas aplicaciones pueden realizarse sin
tener que crear nuevos almacenamientos.

Seguridad.

Al tener el DBA completa jurisdiccidén de los datos se asegura que
el Gnico medio de accesar la base de datos sea a través de los
canales establecidos, y que se definan controles de autorizacién
que se aplican cada vez que se intenta el acceso a datos sensibles
(aquellos datos cuyo valor es ‘importante y que''solo puede ser
cambiado bajo condiciones muy particulares).

Integridad. :
Se garantiza que los datos de la base de datos son exactos, esto

es, no se presenta inconsistencia .entre dos entradas que
representan la misma cosa.

Independencia de los datos.

Para evitar que las' aplicaciones dependan de la manera como los
datos se organizan en el almacenamiento secundario y la manera como
se accesan no sea dependiente de la aplicacidn. Cuando no existe
independencia de datos es imposible cambiar la estructura de
almacenamiento o‘la estrategia de acceso sin afectar la aplicacién.
Modelos de Bases de Datos.

El modelo de datos: es un grupo de herramientas conceptuales para
describir datos, sus relaciones, su semlntica y sus limitantes.
En general, los modelos de datos se pueden dividir en tres grupos:
Modelos légicos basados en objetos

Su caracteristica principal es que permiten estructuras flexibles
y permiten especificar claramente las limitantes de los datos.
Existen més de treinta modelos distintos de este tipo entre los
cuales estén el Binario, Seméntico de Datos, Entidad-Relacién, etc.
El modelo Entidad-Relacifén es el mids representativo de los modelos
légicos basados en objetos. Dicho modelo, se basa en un conjunto de




objetos basicos llamados entidades y de las relaciones entre estos
objetos. Se manejan conceptos como Entidad y atributos.

Una Entidad es un objeto, persona, animal o cosa de interés para la
comunidad de usuarios acerca de la cual es sistema- de bases de
datos debe mantener, correlacionar o desplegar informacidén. Un
atributo es una caracteristica o cualidad de una entidad, debe ser
‘"de interés y estar dentro del alcance del sistema.

Lo que distingue a una entidad de otra es el conjunto de atrlbutos
que la describen. Por ejemplo los atributos nombre y direccién
describen a un usuario especifico en una biblioteca.

Varias entidades pueden relaciocnarse entre si mediante una relacién
o asocliacidédn, por ejemplo, la relaciédn Libro-Autor asocia a un
libro con cada uno de los autores que tiene (asi pues, es posible
tener un conjunto de entidades y un conjunto de relaciones,. los

cuales estdn constituidos por todas las entidades y todas las
relac1ones respectivamente).

La estructura ldgica general de una base de datos puede expresarse
griaficamente por medio de un diagrama Entidad-Relacién.

Modelos Légicos Basados en Registros

A diferencia de los modelos de datos basados en objetos, estos
especifican tanto la estructura légica general de la base de datos
como una descripcién en un nivel mas alto de la implantacidén. Estos
modelos, no permiten especificar en forma clara las limitantes de
los datos. Los modelos de este tipo con mayor aceptacidn son:
Modelo Relacional

Modelo en el que los datos se representan por medio de una serie de
tablas, cada una de las cuales tiene varias columnas con nombres
Gnicos (atributos). Cada renglén de las tablas es llamado Registro
0 tupla; entonces, un registro representa un elemento de la tabla
con diversos atributos.

La cardinalidad de una tabla queda definida como el nGmero de
' registros (renglones) que tiene; y el orden de la tabla queda
definido como el nimero de columnas o atributos de la misma.

Por ejemplo en la tabla B:

Tabla A ' Tabla B
nombre calle- ciudad nimero nimero cuota
Hugo Central México 113 113 12
Paco. Azafrén Puebla 129 128 130
Luis sur Guadalajara 317 317 19
Pedro Norte Monterrey 113
Pedro Norte Monterrey 317

se tiene tres tuplas o registros y dos columnas o atributos, por lo
tanto la tabla tiene orden 2 y cardinalidad 3.

Modelos de Red.

Los datos en .el modelo de Red se representan por medio de conjuntos
de registros (en el sentido de la palabra en Pascal o PL/1) y las
relaciones entre los datos se representan con ligas, que pueden
considerarse como apuntadores Los registros de la base de datos se
organizan en forma de conjuntos de graflcas arbitrarias. La

T
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'“siguiente figqura es un ejemplo de una base de datos de féd:

Hugo Central | México

. 113 12

Paco Azafrin Puebla

Luis sur Guadalajara 129 130

. l
Pedro| Norte '| Monterrey : 317 19

Modelos Fisicos de los Datos

Sirven para describir los datos en un nivel m&s bajo. A diferencia
de los modelos légicos de los datos, son muy pocos los modelos

fisicos utilizados. Los m&s cohocidos son:
El modeleo unificador.
La memoria de cuadros.




TEMA 3. ESTIMACION DE COSTOS DEL SOFTWARE,

TEMA 3. ESTIMACION DE COSTOS DEL SOFTWARE.

En los primeros dfas de la informitica, el coste del software representaba
un pequefio porcentaje del coste total del sistema inform4tico, basado en
computadora. Un error considerable en las estimaciones del coste del
software tenfa relativamente poco impacto. Hoy en dfa, el software es el
elemento mds caro en muchos sistemas inform4ticos. Un gran error en la-
estimacién del costo puede marcar la diferencia entre beneficios y pérdidas.
Sobrepasar el coste puede ser desastroso para el equipo de desarrollo. La
estimacién del proyecto de software puede transformarse de un oscuro arte
en una serie de pasos sisteméticos que proporcionen estimaciones con un
grado de riesgo aceptable.

Para realizar est1mac1oncs seguras de coste y esfuerzo surge un nimero de
opciones posibles:

1. Retrasar la estimacién m4s adelante en ¢l proyecto.

2. Utilizar "técnicas de descomposicién® relativamente simples para generar
las est1mac1ons: del proyecto de software.

3. Desarrollar un modelo empirico para el coste y el esfuerzo del software.

+

4. Adquirir una o m4s herramientas autom4ticas de estimacién.

Desafortunadamente, la primera opcién, aunque atractiva, no es préctica:
las estimaciones del coste deber ser proporcionadas "de antemano”. Sin
embargo, debemos reconocer que cuanto més tiempo esperamos, méis cosas
sabemos y, cuanto més sabemos, menor es la probabilidad de cometer serios
errores en nuestras estimaciones.

Las tres opciones restantes son aproximaciones viables para la estimaci6n
del proyecto de software. Idealmente, las técnicas senaladas para cada
~opcién deben ser aplicadas en conjunto, cada una usada para comprobar las
otras. Las técnicas de descomposicién utilizan una aproximacién de "divide
y venceréds” para la estimacién del proyecto de software.

Los seres humanos han desarrollado una aproximacién natural a la
resolucién de problemas: si el problema a resolver es demasiado com-
plicado, tendemos a subdividirlo hasta encontrar problemas manejables.
Entonces resolvemos cada uno individualmente y esperamos que las
soluciones puedan ser combinadas para responder al problema original.

La estimacién del proyecto de software es una forma de resolucién de

proyectos y, en la mayoria de los casos, el problema a resolver es demasiado
complejo para considerarlo como una sola pieza. Por esta razén, descom-
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TEMA 3. ESTIMACION DE COSTOS DEL SOFTWARE.

mero de eniradas de usuario: Se cuenta cada entrada de usuario que
porciona a! software diferentes datos orientados a la aplicacién. Las
‘radas deber ser distinguidas de las peticiones, que se contabilizan por
-arado.

mero de sali :as de usuario: Se cuenta cada salida de usuario_que propor-
‘na al usuari- informacién orientada a la aplicacién. En este contexto, la
‘da se refier: a informes, pantalla, mensajes de error, etc. Los elementos
datos indivi. zales dentro de un informe no se cuentan por separado.

mero de pe: ciones del usuario: Una peticién estd definida como una
:rada interac.iva que resulta en la generacién de algin tipo de respuesta
forma de sa. Ja interactiva. Se cuenta cada peticién distinta.

“mero de ar::ivos: Se cuenta cada archivo maestro l6gico o sea, una
rupacién 16; :a de datos que puede ser una parte de una gran base de
0s o un arc: -o independiente.

.mero de int~ faces externas: Se cuentan todas las interfaces legibles por
méquina p. - ejemplo, archivos de datos en cinta o disco, que: son
‘lizados parz .ransmitir informacién a otro sistema.

sa vez obter Zos los datos mencionados, se deberd asociar un valor de

mplejidad 2 -ada cuenta. Las organizaciones que, utilizan métodos de
. .ntos de fun..5n desarrollan criterios para determinar si una entrada
. :ierminada es simple, medida o compleja.

" .ra calcular !. ; puntos de funcién (PF) se utiliza la siguiente relacién:
PF = cu -ata.total X [0.65 + 0.01 X SUM(Fi)]

.nde cuenta.: -:al es la suma de todas las entradas obtenidas de la tabla.
" s valores contantes de la ecuacién anterior y los factores de ponderacién

1licados a las cuentas de los dominios de informacién han sido deter-
inados empir::amente.

L4
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TEMA 3. ESTIMACION DE COSTOS DEL SOFTWARE.

-ponemos el problema, re-caracterizdndolo como un conjunto de pequeios
problemas esperando que sean més manejables

Estimaciones LDC y PF.

La medicién es fundamental para cualquier disciplina de ingenierfa del
software no es una excepcién.

Las métricas del software se refieren a un amplio rango de medidas para el
software de computadoras. Dentro del contexto de la planificacién del
proyecto de software. Se considera al uso de lfneas de cé6digo (LDC) como
medidas clave. Los defensores de la medida LDC afirman que la LDC es un
"artefacto” de todos los proyectos de desarrollo de software que puede ser
facilmente calculado, que muchos modelos de estimacién del software exis-
tentes utilizan LDC o KLDC (miles de lfneas de c6dige) como clave de

entrada y que ya existe un amplio conjunto de datos y de literatura basada
en LDC.

Las métricas del software orientadas a la funcién son medidas indirectas del
software y del proceso por el cual se desarrolla. Mé4s que calcular las LDC,
las métricas orientadas a la funcién se centran en la "funcionalidad" o
"utilidad" del programa.

Los puntos de funcién son obtenidos utilizando una relacién empirica
basada en medidas contables del dominio de informacién del software y
valoraciones subjetivas de la complejidad del software. La medida del punto

de funcién fue disefiada originalmente para aplicarla en las aplicaciones de

sistemas de informacién comerciales. Elemento de domiio | Facter de ponderacion PE
de infommacion Simple Med. Complejo )
Numera de ] 3 4 6
entradas de usuario
Namer de
salidas de ysuario 4 S 7 )
Nimere de i
peticiones de usuano 3 4 6 |
NGmero de archivos 7 10 15 :
P Numero de interlaces 5 7 10
extemas

FF = cuenta por ¢ facior de ponderscion

(fig. 3.9). Los puntos de funcién son calculac!l's relienando la tabla que se -

muestra en la figura. Se determinan cinco caracterfsticas del dominio de la
informacién y los cdlculos aparecen indicados en la posicién apropiada de
la tabla. Los valores del dominio de la informacién estdn definidos de la
siguiente manera:
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-Tema- 4, Fundamentos del Disefio de Software

-

El disefio es el primer paso en la fase de desarrollo de cualquier sistema, se define como: “El
proceso de aplicar distintas técnicas y principios con el prop6sito de definir un dispositivo,
proceso o sistema con los suficientes detalles como para permitir su realizacién fisica".

Hay que tener en cuenta que el objetivo del disefiador es producir un modelo de una entidad
que serd construida posteriormente. El proceso para el desarrollo de un modelo combina:
intuicién y criterios, -es decir, se basa en la experiencia para construir entidades similares,

principios que guifan la forma en la que se desarrolla el modelo, criterios que facilitan discernir
sobre la calidad y el proceso de representacién del disefio final.

Subtema 4.1 La fase de desarrollo y el disefio de software

Una vez establecidos los requerimientos del software, la fase de desarrollo comprende tres
pasos distintos: '

1. Diseiio
2. Generaci6n de c(;digo
3. Prueba
Cada paso transforma la informacién de tal forma que finalmente se obtiene un software para -
computadora vélido. En este tema explicaremos el prime{ paso "diseﬁo" y posteriormeui‘se se

desarrollaron los siguientes.

&
¥
e

El flujo de informacién que alimenta la etapa de disefio se ve en la figura anterior En esta se
aprecia las entradas las cualés son: los requerimientos del programa, los requerimientos
funcionales y de comportamiento. Usando alguna de las distintas metodologias de disefio se

realiza el disefio de datos, el disefio arquitect6nico y el disefio procedimental, que posterior-
mente explicaremos. '
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Tema 4. Fundamentos del Diseiio de Software

C-  hacer notar-que el disefio es el lugar en donde se asienta la calidad del desarrollo del

ama, nos da las representaciones del software que pueden establecerse para conseguir
>ducto con calidad, '

£7

§:  :ma4.2El proceso de disefio

E  .c=dode prograr:s es un proceso mediante el cual se traducen los requerimientos en una
r:  sentacién del scitware,

L :elpunto de vis:a de una gestién de proyecto, el disefio del software se realiza en dos

1.Disefio preliminar: que se refiere a la transformacién de los requerimientos en datos y
arquitectura c:| software

2. Disefio en cztalle: que se enfoca hacia los refinamientos de la representacién
arquitecténica que conduce a una estructura de datos detallada y a representaciones
algoritmicas ¢z! software.

E. iremos ahora éc:rca del disefio y calidad de software que es esencial para el logro de'un
bu  producto.

D oy calidad del software

P:  2valuar la calidad de una representacién de disefio presentamos los siguientes criterios:
L. ‘sefio debe:

- exhibir una ¢rganizacin jerdrquica
{que haga uso inteligente de control entre los elementos del software) 7

- ser modular

{esto es, el sofrware debe estar particionado 16gicamente en elementos que realicen fun-
iones y subfunciones especificas)

- contener una rgpresentaci6n distinta y separada de los datos y los procedimientos.

. conducir a m6dulos que muestren caracterfsticas funcionales independientes

- derivarse usando un método repetitivo

‘que esté conducido por la informaci6én obtenida durante el anélisis de requerimientos
1e software) ' :
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Tema 4. Fundamentos del Disefio de Software

mentos del disefio

la importancia que representa la elaboracién de un buen disefio, para

= conceptos fundamentales en el disefio del software, se ha dado desde

:s cuales ayudan al ingeniero en software a responder a las siguientes

s pueden usarse para subdividir el software en componente individuales?

:aran los detalles de una funcién o una estructura de datos de una repre-

-:eptual del software?

-rios uniformes que definen la calidad técnica de un disefio de programas?

le estos conceptos, sobre todo aquellos que respondan a las preguntas
_omenzaremos con:

:rategia de disefio descendente propuesta por Niklaus Wirth, "En cada

3, una o varias instrucciones del programa dado se descomponen en mis

‘das. Esta descomposicién sucesiva o refinamiento de especificaciones
5 las instrucciones est4n expresadas en términos del computador usado o
.acién".

-almente un proceso de elaboracién. Se comienza con una declaracién de
:i6n de la informacién) que se define en el nivel superior de abstraccién,

+4n describe la funcién o informacién conceptualmente, pero no se-da

-1 funcionamiento interno de la funcién o la estructura interna de la

amiento hace que el disefiador amplié la declaracién original, dando mas

me se produzcan sucesivos refinamientos.
ware

srGuitectura del software y esto alude a dos caracteristicas importantes en

a jerdrquica de los componentes procedimentales (médulos)
ra Je datos
offware se deriva mediante un proceso de particién, que relaciona a los

solucién del software, con partes de un problema real definido
nt.: el an4lisis de requerimientos. La evolucién del software y la estructura
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Téma 4, Fundamentos del Disefio de Software

de datos comienza con una definicién del problema. La solucién ocurre cuando cada parte del
problema se resuelve mediante uno o mas elementos de software, en la siguiente figura se

muestra la representaci6n de esta transicién entre el anilisis de requerimientos de software
y el disedo.

“Solucidn™ Software

“Problema™ a resoclver via soitware

Estructura de un programa

Un concepto mas es la estructura del programa que representa la organizacién jerérqmca de
las componentes del programa (médulos) e implica una jerarqufa de control. Para repre-
sentarla se utilizan notaciones diferentes, siendo la mas comin el diagrama de 4rbol, llamado
diagrama de estructura, En la figura siguiente se muestra un diagrama de’4rbol, con una
profundidad y anchura gue indican el numero de niveles de control y expansién global. Notese -
que el abanico de salida es una medida del numero de médulos que estdn directamente
controlados por otros médulos, el abanico de entrada mdlca cuantos médulos controlan
du'ectamente a un modulo dado. :

Estructura de datos

Siguiendo con los conceptos, uno mas es la representacién de la relacién 1égica entre los
elementos individuales de datos, conocidas como estructura de datos, la cual es muy impor-
tante y dicta la organizacién, los métodos de acceso, grado de asociatividad y alternativas de
procesamiento para la informacién.

Algunas estructuras de fatos cldsicas, se muestran en 1a figura. El elemento escalar representa
un elemento simple de informacién direccionado mediante un identificador. El vector es un
conjunto continuo de elementos escalares que pueden ser de una, dos 0 mis dimensiones. La
lista enlazada esta organizada con elementos escalares, no continuos y pueden ser procesados
como una lista. Cada nodo o elemento, contiene una organizacién propia y uno o mis
apuntadores que indican la direccién de memoria del siguiente nodo de la lista.
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Tema 4. Fundamentos del Disefio de Software

-dimientos de sof{tware

olar de procediiziento de software, se enfoca sobre los detalles de procesamiento de cada
ilo individualm:nte. El procedimiento debe dar una especificacién precisa del
samiento, inclu-2ndo secuencia de sucesos, puntos de decisiones exactos, operaciones
.tivas e incluso :rganizacién/estructura de datos.

= una relaciéc . atre estructura y procedimiento, el procesamiento indicado por cada
:lo debe inchuir ina referencia a todos los médulos subordinados del modulo que se
“ibe.

ilaridad

"do se tiene un zroblema, para resolverlo, es més fécil dividirlo en partes manejables
:das médulos, 2! nodulo es un elemento con nombres y direcciones separadas, los cuales
‘sgran para szati: acer los requerimientos del problema.

.sible deducir - ue si subdividimos ¢l software indefinidamente, el esfuerza que se
.ere para desar: llar serd significativamente pequedo. Sin embargo, hay otros factores

;acen que esta ¢ .nclusién no sea del todo aceptada.

raccién

. nsiderar una sc :cién modular a cualquier problema, se pueden formular muchos niveles

»straceién, la cu i facilita al disefiador representar un objeto de datos a diferentes niveles

- .ztalle y especi:arlo en el contexto de las operaciones que se le. aplican. En el nive!

-1ior de abstracciin, se establece la solucién en términos amplios usando el lenguaje del
;o del probler:.:, en los niveles inferiores se toma una orientacién més procedimental y
:zablece la soluc:in en forma que pueda implementarse directamente.

. ‘tamiento de la aformacién

specificarse o cisefarse los médulos se debe hacer de tal manera que la informacién
‘zuida dentro ¢z un médulo sea inaccesible a otros médulos que no necesiten tal
.macién.

&
.. -tema 4.5 Diseno modular efectivo

:1 subtema anterior tratamos acerca de la modularidad, la cual se ha convertido en un

r. ,g1e aceptado er. todas las disciplinas de ingenierfa. Algunas ventajas que proporcicna el
. :0 modular es cue reduce la complejidad, facilita los cambios y da como resultado una
' implementaci6n, posibilita ademds el desarrollo paralelo de diferentes partes de un
ilzma. '
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Tipos de médulas
_os médulos se ¢ividen en categorfas, las cuales son:

- m6dulc :cuencial
( se lama - gjecuta sin interrupcién aparente, son los m4s comunes y se categorizan

como ma..0s en tiempo de compilacién y subprogramas convencionales, conocidas
como fur. :iones, procedimientos o subrutinas )

- médule scremental

( se pued: .aterrumpir antes de la terminacién por software de aplicaci6én y rees-
tablecidc :n el punto de interrupcidn, se les llama cominmente corrutinas, man-
tienen ur :puntador de entrada que permite al m6dulo reestablecer el punto de
interrupc.:a)

- médulc -aralelo : X

( se ejecu: simultdneamente con otro médulo en multiprocesamientos concurrentes, se
encuentr: : en célculos de alta velocidad que necesitan dos o mas procesadores

trabajand: : en paralelo ). \ "

Independencia {.:acional.

La comunicacié:: entre médulos no debe ser excesiva y se deben desarrollar con una clara
funcién de lo qu= va a hacer, para llegar a lo que se conoce como independencia funcional. *

Siempre es prefe ible disefiar software de forma que cada médulo se enfoque auna subfunmén
especffica de rec:erimientos y se tenga una interface sencilla.

Esta independer -ia se mide con dos criterios cualitativos:
- Cohesi6én
- -~.coplamiento
Cohesion:
Alhablar de un médulo coherente, se hace referenciaauna tareasencillaen un procedimiento
de software y requiere poca interaccién con procedimientos que ejecutan en otras partes de

un programa, es cecir, un médulo coberente debe hacer s6lo una cosa.

La cohesién puede ser representada como el "espectro” mostrado en la siguiente figura, enla
cual se nota los diferentes tipos de cohesién que se tienen de acuerdo al nivel.

En la medida de la fortaleza funcional de un médulo, si se ejecutan un conjunto de tareas a
relacionadas con otras debilmente, se habla de cohesidn coincidental, si se relacionan
l6gicamente es cohesién 16gica y cuando se contienen tareas relacionadas por el hecho de que
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se deben ejecutar dentro de un mismo tiempo, se exhibe cohesién temporal. Se puede apreciar
también que la escala de la cohesién no es lineal, siempre se intenta conseguir un gran
cohesién, aunque el punto medio del rango del espectro es aceptable.

Se habla de cohesién procedimental, cuando los elementos de procesamiento de un médulo
estdn relacionados y deben ejecutarse en un orden especifico, y cuando los elementos de

procesamiento se concentran sobre una 4rea de un estructura de datos, se presenta cohesién
de comunicacién. '

No es necesario determinar el nivel preciso de cohesién. Es importante buscar una cohesién
alta y reconocer la cohesién baja de forma que el disefio del software pueda modificarse, de
forma que contenga una mayor independencia funcional.

Acoplamiento

Otro criterio de medida de independencia, el cual es acoplamiento, que se puede definir como
la medida de lainterconexién entre médulos en una estructura de un programa, que depende
de la complejidad de la interface entre médulos, del punto en el que se hace una entrada o
referencia aun méduloy de los datos que pasan a través de lainterface. Al igual que la cobesién
se puede representar por un espectro, en el que se marcan los tipos de acoplamiento.

El acoplamiento directo se da cuando dos médulos estdn relacionados en forma directa; el
acoplamiento de datos es cuando un modulo B es subordinado de un modulo A y esta accesible
mediante una lista de argumentos convencionales, a través de los cuales pasa datos. Al pasar
una porcién de una estructura de datos mediante una interface de médulo que es unavariacién
del acoplamiento de datos, se le conoce gomo acoplamiento por estampado. A niveles
moderados, el acoplamiento se caracteriza por el paso de control entre médulos, en su forma

sencilla, el control se pasa mediante un indicador sobre el que se toman las decisiones en un
médulo subordinado o superior,

Se producen niveles altos de acoplamiento, cuando los médulos est4n ligados a un entorno
externo al software. El acoplamiento externo es esencial, pero debe limitarse a un pequefio
numero de mdédulos dentro de una estructura. As{ mismo a niveles altos de acoplamiento se
encuentra ¢l acoplamiento comin, que se da cuando varios médulos se hace referencia a un
drea de datos global. Y el mayor grado de acoplamiento se da en el acoplamiento por
contenido, cuando un }Ilédulo hace uso de informacién de control o de datos mantenidos
dentro de los limites de otro médulo.

Subtema 4.6 Disefio de datos

Una de las mas importantes de las tres actividades de disedio que se realizan durante la
ingenierfa de software, es el disefio de datos.

Esta actividad como ya mencionamos es la primera en el disefio de datos y se encarga
principalmente de seleccionar las representaciones 16gicas de los objetos de datos, conocidas
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» estructaras- = catos, las cuales se identifican durante las fases de definici6n y
-ificacién de rec . erimientos.

sendientement: de las técnicas de disefio usadas, los datos bien disefiados nos pueden
ICir a una mejc: sstructura del programa, modularidad y reduccién de la complejidad de
rocedimientos.

:pecificar los dz. »s tenemos tener presentes los siguientes principios:

1. Los métoc s de andlisis sistemdtico, aplicados al software deben también aplicarse a
los datos: ce” »n desarrollarse y revisarse las representaciones de flujo y estructura

de datos, cor .derar organizaciones alternativas y evaluar el impacto del disefio de
datos sobre . disefio de software, es decir, si por ejemplo, la especificacién de una
estructura ¢ .:sta doblemente ligada puede satisfacer agradablemente a los re-
querimientc: e los datos, pero conducir a un disefo de software dificil de manejar.

2. Debenide: :ificarse todas las estructuras de datos y operaciones que han de
ejecutarse sc re cada una de ellas: Si por ejemplo, se considera una estructura de
datos formz.' ; por un conjunto de diversos elementos de datos. La estructura serd
manipuladz : or varias funciones principales, para la evaluacién de la operacién
ejecutada sci ¢ esa estructura, se define un tipo abstracto de datos para usarlo en el
disefio subs< .ente del software, que puede llegar a simplificar el disefio de software.

3. Deben es: Dlecerse y usarse un diccionario de datos para definir el disefio de los
datos y el so:: vare: En el diccionario de datos se representa explicitamente las
relaciones e:. re los datos y las ligaduras de los elementos de una estructura de datos.

4. Las decis:. :es de disefio de datos a bajo nivel deben retrasarse hasta las ultimas
etapas del p: -ceso de disefio: Puede usarse un proceso de refinamiento sucesivo
para el diseZ:: de datos, es decir, definir una organizacién global de los datos
durante el 2- :lisis de requerimientos, refinarse durante el disefio preliminar y
especiﬁcars‘ zn detalle durante el disefio detallado.

5.La represc atacién de una estructura de datos debe ser conocida s6lo por los médulos
que hagan u:. uso directo de los datos contenidos dentro de la estructura: Este punto
hace referer.ia a los conceptos antes vistos de ocultacién de informacién y
acoplamien:.;, los cuales proporcionan un aspecto importante en la calidad del

disefio de so-ware.

6. Debe des: Tollarse una biblioteca de estructuras de datos ttiles y de las operaciones
que pueden :plicarse a ellas: Una biblioteca de estructuras de datos, pueden reducir
el trabajo de =specificacién y disefio de los datos.

7. El disefio :le software y el lenguaje de programaci6n deben soportar la especificacién
y realizaci6r. de tipos abstractos de datos: La implementacién de una estructura de
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datos sofisticada puede hacerse excesivamente dificil si no hay forma de realizar una
~ especificacién directa de la estructura.

Los principios descritos forman la base de un método de disefio de datos, que puede ser
integrado en la fase de definicién y desarrollo del proceso de ingenierfa de software, dado que
una clara definicién de la informacién es esencial para desarrollar bien el software.

Subtema 4.7 Disefio Arquitecténico

El disefio principal del disefio arquitectonico es desarrollar una estructura de programa
modular y representar las relaciones de control entre los médulos, adem4s mezcla la estructura

de programas y la estructura de datos, deﬁne las interfaces que facilitan el flujo de los datos a
lo largo del programa.

Subtema 4.8 Disenio Procedimental

Una vez que se ha establecido la estructura del programa y de los datos, se realiza el diseio
procedimental. En este se realiza la especificacién procedimental que requiere definir los
detalles algoritmicos que deben establecerse en un lenguaje natural, existe desafortunada-
mente un pequefio problema, en el disefio procedimental debe especificarse los detalles de

los procedimientos sin ambigiiedad y la falta de ambigiiedad en un lenguaje natural no es
corriente.

Programacién Estructurada

En el desarrollo procedimental se requiere del uso de un lenguaje, como ya mencionamos, sus
fundamentos se formaron a principios de los afios 60, en el cual se propuso el uso de un
conjunto de construcciones légicas con las que podrfa formarse cualquier programa. Cada
construccién tenfa una estructura légica predecible, se entraba por el principio y se salia por
el final, y facilitaba al lector seguir mis ficilmente el flujo procedimental. Las construcciones
introducidas anteriormente en la representacién de datos, son la secuencia, condicién y
repeticion.

Secuencia: la secuencia, implementa los paso de procesamiento esenciales en la
especificacién de cualquier algoritmo.

Condicién: la condicién da la facilidad para selecaonar un procedimiento basado en al-
guna ocurrencia logica.

Repeticidn: 1a repeticién suministra el ciclo.
Estas tres construcciones son fundamentales en la programacién estructurada, la cual es una

técnica de disefio importante en el campo m4s amplio de lo que hemos aprendido de ingenierfa .
del software.
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:alquier progra: - ., independientemente del 4rea de aplicacién o complejidad técnica, puede
.efiarse e imple. <ntarse usando sélo las tres construcciones estructuradas,

srramientas gr< :as dediseno

zuien alguna v: -1ijo: un dibujo vale mas que mil palabras, pero es importante saber que
“ujoy que mi'2 .z palabras"... No hay duda que las herramientas gréficas, tales como los

.gramas de flv:: . de cajas, dan una excelente forma gréfica de describir facilmente los
:alles procedi ales. '

agrama de fluj:
diagramadef . :slarepresentaci6ngrificamésusadaparael disefo procedimental. Pero

abién es del ¢--. ~as se ha abusado. Es un grifico muy sencillo, una caja indica un paso de

scesamiento, L. =mbo representa una condicién 16gica y las flechas muestran el flujo de
trol.

- siguiente figusz -uestra las tres construcciones de programacién estructurada.

Condichn T
T el e
<
r Da whiy Regaaf-und
Sekuciin Repeticisn

_secuencia esta reoresentada por dos cajas de procesamiento conectadas por una linea de
trol.

™

- condicién tambis 2 I'amada IF-THE-ELSE, sé dibuja como un rombo de decisién, el cual,
25 verdad, hace c':¢ se realice el procesamiento de la parte then y si es falso llama al
- scasamiento de I- oate del ELSE.

Wy o

r—l

. repeticién se rep: =senta usando dos formas algo diferentes. La forma DO-WHILE prueba |
=1 sondicién y ejecut ; repetidamente una tarea mientras la condicién sea verdadera. La

r

DECFI o -23- ' ' CECAFI



. Tema 4. Fundamentos del Disefio de Software

t

forma REPEAT-UNTIL ejecuta primero el ciclo, luego checa la condicién y repite la tarea
hasta que falla la condicién.

Estas construcciones estructuradas pueden estar anidadas unas en otras como se muestra en
. la siguiente figura.

Parte-eise ->-—

- I Primera tarea

l Condicion
= Siguiente tarey

-3
i \n\ Parte then

Tarea bucle

| condicisn
del bucle

Una herramienta mas en el disedio gréifico es el diagrama de cajas, que surgié del deseo
procedimental que no permitiera la violaciéa de las construcciones estmctu:adas, y tiene las
siguientes caracteristicas:

- Dominio funcional:

el 4mbito de la repeticién o un IF-THEN-ELSE, esta bien deﬁmdo y claramente visible
¢omo una representacién grafica,

- Imposible transferencia arbitraria de control

- Determinacién de los 4mbitos de los datos locales y/o globales, estos pueden deter-
minarse ficilmente,

- Representacién fécil de la recursividad.

En la siguiente ﬁgura,se muestra, la representacién grafica de construcciones estructuradas
usando diagramas de cajas, en esta se ve que el elemento fundamental del diagrama esla caja,
para representar la secuencia se conectan dos cajas seguidas. para representar el IF-THEN-
ELSE, se pone una caja dé la parte THEN y otra de la parte ELSE, a continuaci6n de la caja
de condicién. La repeticién se dibuja con una caja interior que encierra el proceso que ha de
repetirse (parte del DO-WHILE o parte REPEAT-UNTIL).

Y la seleccién se representa usando la forma gréfica mostrada al final.
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Primérs tarea . Condicidn

F T
Siguienis tea
Parte- Parte-
s then
Tarss siguients + 1
Sacuencia H-then-eise
L Sandicidn de bucie Condicion del case
: 1]
i
H - Valor | Yaor
: Pane
i repeat-until
Partn Parte- | Pante-
¢ de-whie i case | case
S
' | Condicisn de bucie

Rspatcion : Seleccidn

lamadas a los médulos subordinados puede representarse mediante una caja con el
“bre del médule =acerrado dentro de un 6valo. '

guaje de disefio /e programas

1 el disefio de p-ogramas se requiere de un lenguaje, llamado pseudocédigo, que es un
:uaje mezclado - e utiliza el vocabulario de un lenguaje por ejemplo el inglés, y la sintaxis
zral de otro por :iemplo, un lenguaje de programacion estructurada.

!iferencia entre i lenguaje de disefio de programas y un lenguaje de programacién de alto
'l real se refiere ! uso del texto narrativo insertado directamente dentro de las sentencias
‘enguaje de dis< 20 de programas. '

i .:pendientemec:z de su origen, un lenguaje de diseio debe temer las siguientes
¢ ucterfsticas: )

- Sintaxis fijz de palabras clave que den todas las construcciones estructuradas,
declaracionz; de datos y caracteristicas de modularidad

- Sintaxis lit - en lenguaje natural que describa las caracteristicas del procesamiento

- Facilidad para declaracién de datos que incluyan las estructuras de datos sencillas (es-
calares y arrzglos) y complejas (listas ligadas o drboles).

- Definicién de subprogramas y técnicas de llamada que soporten los distintos modos de
descripcién ce interfaces.

. - s ntaxis basica d21 LDP debe incluir:
- definicién de subprograma

- descripci6n de interfases
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- declaraci¢a y tipificacién de datos
- técnicas para estructurar en bloques
- instrucdc:es de condiciéa |
- i;nstruccié-:::s repetitivas
- instruecic ;.25 de entrada/salida.

formato y semd :ica de un LDP es:
- Instruccis 1 que permite representar las estructuras de datos locales y globales:
TYPE [nomore-variable] IS [calificadorl] [calificador2)

-ade:

[nombre-varible]  es unavarible declarada dentro de un médulo o declarada
" parauso giobal o entre médulos.

" {[calificador i] indica la estructura de datos especifica e incluye palabras
' reservadas como: SCALAR, ARRAY, LIST, STRING,
STRUCTURE '
[calificador?] indica como se utilizan los nombres de variables en el

contexto de un médulo o programa.

Siementos pro.:dimentales estructurados en bloques, es decir, pude definirse un
zudocédigo en bloques que se ejecute como una entidad simple.

1 bloque esta dei:mitado de Ia siguiente manera:
BEGIN {ncmbre-bloque]
[sentePcias de pseudocddigo);
END

-nde, [nombre-bloque] puede usarse para dar un nodo de referencia subsecuente aunbloque
‘sentencias en pszudocddigo] son una combinacién de otras instrucciones en LDP.
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- Instruccién de condicién en LDP, tiene la forma cl4sica if-then-else.
IF [descripcién-condicién]
THEN [bloque o sentencia de pseudocédigo]; |
ELSE [bloque o sentencia de pseudocédigo];
ENDIF

donde, [descripcién-condicién] indica la decisién l6gica que debe hacerse para llamar a la
parte de procesamiento THEN o ELSE.

- Instruccién de seleccién, es un conjunto de IF anidados, esta instruccién compara un
parametro especifico, la variable del case, con un conjunto de condiciones. Cuando se satisface
una condicién, se llama a un bloque o sentencia individual en pseudocédigo. Surepresentacién
es: '
CASE OF [nombre-variable-case]
. WHEN [condiciénl-case] SELECT [bloque o sentencia de pseudocédigo];

'WHEN [condici6n2-case] SELECT [bloque o sentencia de pseudocédigo];

WHEN [ultima-condicién-case] SELECT [bloque o sentencia de pseudocédigo];
DEFAULT [fallo o error del case. blogue o sentencia de pseudocédigo];
ENDCASE

- Instrucci6n de repeticién en LDP, incluye ciclos pre-test y post-test asi como un ciclo con
indice. ‘

DO WHILE descripcién-condicién
bloque o sentencia en pseudocédigo

ENDDO
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REPEAT UNTIL descripcién-condicién
bloque o sentencia en pseudocédigo

ENDREP

DO FOR {i{ndice = lista-indice, expresién o secuencia}
bloque o sentencia en pseudocédigo

ENDFOR

- Los subprograma.s y sus correspondientes interfases se dcfinen usando las siguientes instruc-
ciones del LDP.

' PROCEDURE [nombre-subprogramalfatributos]

INTERFACE [lista-argumentos]

[bloques y/o sentencias en pseudocédigo];

donde, [atributos) de un subprograma describe sus caracterfsticas de referencia (internas o
externas) y otros atributos dependientes de la implementacién (lenguaje de programaci6n) si
los hubiera ENTERFACE se utiliza para especificar una lista de argumentos del médulo que
contiene los identificadores para la informacién de llegada y salida.

- Especificaciones de entrada/salida, dependen mucho de los lengua]es de diseflo, las mas
comunes son:

L4

r

>

READ/WRITE TO [dispositivo] [lista E/S]

donde dispositivo indica el dispositivo fisico de-E/S y lista E/S contiene las vanables que se
transmiten.
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C: -aracién de not' :ignes de diseno

C  uiernotaciény raeldisefo procedimental, si se usa correctamente, puede ser de ayuda
o -aliosa en el pre: ;250 de disefio, es por esto que cualquier comparacién debe basarse en
e: »remisa, recfpro :amente, incluso la mejor notacién, si se aplica mal, afiade poco a la
¢t -resién. Tomar. » en consideracién:lo anterior podemos aplicar comparaciones a las
nC  iones:
M laridad:

Una notaciér. e Jdisefio debe soportar el desarrollo de software modular.
Si- -lcidad global:

Una notacié: e disefo debe ser relativamente sencilla de aprender, relativamente facil
de usary ge=- -almente fécil de leer.

F.. idad de ediciér.:

La facilidad : .nla que una representacién de disefio pueda ser editada, puede ayudar a
facilitar cadz . no de estos pasos de la ingenierfa de software.

L: 5le porla mdqu:: a:

Una notaciér. que pueda ser introducida directamente en un sistema de desarrollo
basado en cc :putadora, ofrece enormes beneficios potenciales.

Af tenimiento:
Es esta la fas mas costosa del ciclo de vida del software. El mantenimiento de la
configuraciér. de software casi siempre significa mantenimiento de la representacién
del disefio procedimental.

E.:lzencia de estructura:

La notacién ce disefio que refuerce el uso de Ginicamente construcciones estructuradas,
promueve la prictica de un buen disefio.

R ore sentacién de dcztos:

La habilidad para representar los datos locales y globales es un elemento esencial en el
disefio detalizdo. Una notacién puede idealmente, representar directamente los
datos.
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~acibn logica:

La verificacic : automética de la 16gica del disefio es un objetivo supremo durante la
prueba de so:--are. Una notacién que la refuerce mejora grandemente la suficiencia

de la prueba. -

sicién de la coc “cacidn:

Una notaciér: -ue se convierta ficilmente a cédigo fuente reduce el trabajo y los errores.

e que un le: ruaje de diseiio de programas ofrece la mejor combinacién de
-eristicas. Se pu:- ie insertar directamente en los listados fuente, mejorando de esta forma
-umentacién v i :ciendo menos dificil el mantenimiento del disefio.
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) ORIENTADO AL FLUJO DE DATOS.

'rito como un proceso multipaso en el que las representaciones de la-

sstructura de programa y procedimiento, se sintetizan a partir de los
informacién. Es ademd4s, una actividad referida a la toma de decisiones
:emente de una naturaleza estructural. Comparte con la programacién
"2s a la abstraccién en la representacién de la informacién y en las

-amiento, pero el nivel de detalles es muy diferente en ambos casos. El
:zpresentaciones coherentes y bien plamnificadas de programas,

5 interrelaciones de las partes a un nivel més alto y en las operaciones
- los niveles inferiores.

~os acerca del disefio orientado al flujo de datos (y en general el disefio
:iene sus origenes en los primeros conceptos de disefio que aventuraron
io descendente y programaci6n estructurada. Sin embargo, el enfoque

al flujo de datos amplié estas técnicas procedimentales, integrando

‘2 aplicacidn.

:| flujo de datos puede aplicarse a un amplio rango de 4reas de aplicacién.
zor importante de seleccién de un método de diseno, la amplitud de las
lica.

) orientado al flujo de datos es particularmente 1itil cuando lainformacién
.imente y no existe una estructura de datos jerérquica.

>fio orientadas al flujo de datos se aplican también a aquellas que se
Jcesamiento de datos y pueden aplicarse con efectividad, incluso cuando

‘2 datos jerdrquicas.
‘eraciones sobre el proceso de diseio.

- al flujo de datos permite una c6moda transicién de las representaciones

una descripcién de disefio de la estructura del programa.

- «:a transicién se rzaliza en cinco pasos:

1) se establz:e 21 tipo del flujo de informacifn;

2) se indicar los limites del flujo;

3) el disedc de flujo de datos se convierte en la estructura del programa;

4) se define !a ierarqufa de control mediante factorizacién, y
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Tema 5 DISENO ORIENTADO AL FLUJO DE DATOS.

5) se refina la estructura resultante usando medidas y heuristicas de disefio.

Subtema 5.3 Flujo de transformacién y Flujo de Transaccién.

Analizaremos ahora dos tipos de flujo de informacién. Primero veremos el flujo de
transformacidn: :

Recordando el modelo fundamental del sistema (diagrama de flujo de datos), la informacién
debe entrar y salir en una forma del "mundo externo”. Por ejemplo, los datos escritos sobre un
teclado de una terminal, hablados sobre una linea de teléfono y dibujados sobre una
presentacién grafica por computadora, son todos formas de informacién del mundo externo.
Tales datos externos deben ser convertidos en una forma interna para el procesamiento.

L a historia del tiempo del flujo de datos se muestra en la siguiente figura, en la que se aprecia,
la informacién entra al sistema mediante caminos que transforman los datos externos en una
forma interna y se identifica como flujo de llegada. En el nicleo del software ocurre una
transicién. Los datos de llegada se pasan a través del centro de transformacién y comienzan a

moverse a lo largo de caminos que conducen ahora hacia la "salida" del software, se llaman
flujo de salida.

En lo que se refiere al flujo,de transaccién tenemos que :

El modelo fundamental del sistema implica un flujo de transformacién; el flujo de informacién
se caracteriza frecuentemente por un elemento de datos sencillo, llamado una transaccién,
que desencadena otro flujo de datos alo largo de uno de los muchos caminos. Cuando un DFD
toma la forma mostrada a continuacién, se presenta un flujo de transacci6n.

Este flujo de transaccién se caracteriza por datos que se mueven a lo largo de un camino de
llegada que convierte informacién del mundo externe en una transaccién, esta transaccién es
evaluada, y basdndose en este valor el flujo se inicia por uno de los muchos caminos de accién.
El centro de flujo de informacidn desde que salen muchos caminos de acciénse llama uncentro
de transicién. En un DFD para un gran sistema, pueden presentarse los dos tipos de flujos de
transformacién y de transaccién.

Para completar este punto vamos a definir que es un Andlisis de Transformaci6n.
El anélisis de transformacién es un conjunto de pasos de disefio que permiten aun DFD, con .
caracteristicas de flujo de transformacién, convertirse en una templeta predefinida para la

estructura del programa.

Subtema 5.4 Pasos del diseno.

Los pasos de disefio comienzan con una revaluacién del trabajo hecho durante el anélisis de
requerimientos y luego se va hacia el desarrollo de la estructura del programa. Analicemos
paso a paso como se lleva a cabo este disefio:
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Tema S DISENO ORIENTADO AL FLUJO DE DATOS.

Paso 1. Revisién del modelo fundamental del sistema. El modo fundamental del sis-
tema abarca el nivel 01 DFD y el soporte de la informacién. En realidad, el paso de
disefio comienza con una evaluaci6n de la Especificacién del Sistema y de la
Especificacién de los Requerimientos del Software. Ambos documentos describen
el flyjo y estructura de la informacién de la interfase del software.

Paso 2. Revisién y refinamiento de los diagramas de flujo de datos para el Software.
Usando la informaci6n obtenida de una Especificacién de Requerimientos del
software, se deriva un diagrama de flujos de datos.e-nivel-03 para el implicado en
una transformacién ejecuta una funcién sencilla y diferenciada, el DFD contiene los
suficientes detalles para un "primer corte” en el disefio de la estructura de programa,
y procedemos sin més refinamientos.

Paso 3. Determinar si el DFD tiene caracteristicas de transformacién de transaccién, el
flujo de informacién de un sistema puede presentarse siempre como transformacién.
Sin embargo, cuando se encuentra una transaccién, se recomienda una organizacién
de disefio diferente. : ‘

En este paso, el disefiador selecciona una caracterfstica global del flujo baséndose en la
naturaleza prevalente del DFD. Ademds, se afslan las regiones locales del flujo de
transformaci6n o transaccién. Estos subflujos pueden usarse para refinar la estruc-
tura del programa derivada de la caracteristica global descrita anteriormente.

Paso 4. Aislar el centro de transformacién especificando los limites de!l flujo de Uegada
y salida. :
Los limites del flujo de llegada y salida estdn abiertos a diferentes disefiadores pueden
seleccionar puntos algo diferentes en el flujo como posiciones lfmites, pueden
derivarse soluciones de disefio alternativas variando la colocacién de los-l{mites del
flujo.

Paso 5. Realizaci6n del "primer nivel de factorizacién”. La estructura del programa rep-
resenta una distribucién descendente del control. La factorizacién da como resul-
tado una estructura de programa en la que los médulos de nivel superior toman las
decisiones de ejecucién y los médulos de nivel inferior ejecutan la mayorfa del
trabajo de entrada, computacional y de salida. Los médulos de nivel intermedio
ejecutan algiin control y realizan moderadas cantidades de trabajo.

Primer nivel de factorizacidn.

El nimero de médulos del primer nivel debe limitarse al minimo necesario, para que
puedan realizarse las funciones de control y mantener al mismo tiempo unas buenas
caracteristicas de acoplamiento y cohesién.

Paso 6. Ejecucién del "segundo nivel de factorizacién". El segundo nivel de
factorizacién se realiza mediante la conversién de las transformaciones individuales
de un DFD, en los médulos correspondientes de la estructura del programa. Comen-
zando en el limite del centro de transformacién y yendo hacia fuera a lo largo de los
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caminos de llegada y luego de salida, las transformaciones se convierten en niveles
subordinados e la estructura del software.

Una estructura de programa de primer corte puede siempre refinarse aplicando los conceptos
de independencia de médulos. Se puede aumentar o reducir el nimero de médulos para

producir una estructura que pueda implementarse sin dificultad, probarse sin confusién y
mantenerse sin problemas.

El objetivo de los siete pasos procedentes es desarrollar una representacién global del
software. Esto es, una vez que se define la estructura, podemos evaluar y refinar la arquitectura
del software viéndola como un todo.

Subtema 5.5 ANALISIS DE TRANSACCION

En muchas aplicaciones software, un elemento de dato determina uno o més flujos de
informacién que afectan a la funcién implicada por el elemento de dato determinante. El
elemento de dato, lamado transaccién.

Pasos del disefio

Los pasos del disefio para el andlisis de transacciones son similares y en algunos casos idénticos
a los pasos para el aplisis de transformaciones. La principal diferencia se refiere a la
conversién del DFD en estructura de programa.

Paso 1. Revisar el modelo fundamental del sistema.
. Paso 2.Revisar y refinar los diagramas de flujo de datos par software.

Paso 3.Determinar si el DFD tiene caracteristicas de transformacién o de transacabn
Deben establecerse lIr.mtes de ﬂll]O para ambos tipos de flujo. bus pezas V.2 vz

-5 S e

.,V‘l‘- F ‘- .‘. F:‘ J"‘J"-aa-‘l.-'l‘- ._’ <

Paso 4.1dentificar el centro de transaccién y las caracterfsticas del flujo de cada camino
de acci6n. La posicién del centro de transaccién puede discernirse inmediatamente
a partir del DFD, El centro de transaccién est4 ligado al origen de varios caminos de
informaci6n que fluyen radialmente de el.

awi T - Lo

Paso S.Transformar el DFD en una estructura software adecuada al procesamiento de
transacciones. El flujo de transacci6n se convierte en una estructura de programa
que contiene una bifurcacién de entrada y una bifurcacién de salida o expedicién. La
estructura para la bifurcaci6én de entrada se desarroila de la misma forma que el
anilisis de transformaciones.

Paso 6.Factorizar y refinar la estructura de transacciones y la estructura de cada camino
de accién. Cada camino de accién del diagrama de flujo de datos tiene sus propias
caracterfsticas de flujo de informacién, se puede encontrar un flujo de
transformacién de transaccién.
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La transformacién crear y visualizar mensaje del DFD se convierte en un médulo de

utilidad (es decir, un médulo lamado por dos 6 m4s médulos) que se utiliza por dos
estructuras de flujo de accién.

Paso 7.Refinar la estructura del software de "primer corte" usando medidas y heuristicas
de disefio. Criterios tales como independencia de médulos, prctica y mantenimien-

to, deben ser considerados cuidadosamente cuando se propagan modificaciones a la
estructura.

Una vez que se ha desarrollado la estructura del programa usando el disefio orientado al flujo '
de datos, puede conseguirse una modularidad efectiva aplicando los conceptos introducidos

en el tema anterior y manipulando la estructura resultante de acuerdo al siguiente conjunto
de criterios. : '

I.Evaluar la estructura de programa preliminar para reducir el acoplamiento y mejorar
la cohesién. Los médulos pueden expandirse o reducirse con la mirada puesta en la
mejora de la'independencia de los médulos.

II.Intentar minimizar las estructuras con un abanico de salida ancho; fomentar los
abanicos de entrada conforme se incrementa la profundidad.

HI.Mantener el efecto de un médulo dentro del Ambito de control de ese médulo.

IV Evaluar las interfases de los médulos para reducir la complejidad y redundancia y
mejorar la consistencia.

V. Definir médulos cuyas funciones sean predecibles, pero evitar médulos que sean;
demasiado restrictivos. '

VI.Buscar los médulos de una Ginica entrada ¥y una tnica salida, evitando las conexiones-
patolégicas. '

VII.Empaquetar el software basidndose en las restricciones del disefio y requerimientos
de transportabilidad.

En forma global, podemos decir que las técnicas expuestas en este tema conducen a una
descripcién del disefio preliminar del software. Se definen médulos, se establecen las inter-
fases y se desarrollan las estructuras de datos. Estas representaciones del disefio forman la
base de todo el trabajo posterior de desarrollo.
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T- 16 Disenio Orientado a las Estructuras de Datos

E  ‘stema tratarernos larelacién entre el software y datos, 1a cual siempre ha existido desde
lc “genes de la coriputacién, comenzaremos diciendo que la estructura de la informacién
. faestructura d= datos, es un factor que tiene impacto en la complejidad y eficiencia de
k. joritmos disefizos para procesar la informacién.

:ntificacién de 'os estructuras de datos inherentes es vital y la estructura de los datos
> usarse para deo -ivar la estructura de un programa,

1  ‘atos de entrzd-, internamente informacién almacenada y los datos de salida, pueden
t: :cadauno una :-:ructura tnica. El disefio orientado a la estructura de datos hace uso de
e  2structuras com. base para el desarrollo de software.

' laremos cueniz : lo largo de este tema que las estructuras de datos son tan importantes
' que afectan a! :sefio tanto en el aspecto estructural, como procedimental del software.
T  sforma ademé: na representacién de la estructura de datos en una representacién de
s.  -are,los creacdc::sdel disefio orientado ala estructura de datos han de definir un conjunto
¢. -ocedimientos ¢ = iransformacidnque utilizan la estructura de lainformacién(datos) como

1,

%5 ‘ema6.1 Técnicys de estructura de datos frente a las de flujo de datos

2 »sde considerzr as diferencias entre el disefio orientado al flujo de datos y orientado ala
e :cturade datos, =5 importante hacer mencién que ambos comienzan en los paso de anélisis
¢ conducen a los siguientes pasos de disefio. Ambos son conducidos por la informacién;
¢ -0s intentan trar:formar-la informacién en una representacién de software. .

. iseflo orientadc ala estructura de datos no hace un uso explicito de un diagrama de flujo
¢ latos. El objetiv: dltimo de los métodos orientados ala estructura de datos es producir una
« . -ripcién procec mental del software. El concepto de estructura modular de programa no
s -onsidera explic::amente. El disefio orientado a la estructura de datos hace uso de un
¢ irama jerrquic: para representar la estructura de la informacién.

“'terna 6.2 Consideraciones sobre el proceso de disefo

andlisis de requerimientos del software permanece como la base del disefio orientado a la
-ructura de datos. La descripcién del dominio de la informacién {estructura, contenido y
;0 de datos) cor:enida en la Especificacién de Requerimientos de Software prefigura la
-uitectura del soirware que ha de desarrollarse durante del diseiio.

—-i

£y ey

1 ;s métodos oriertados a la estructura de datos tienen su propio conjunto de reglas. Sin
¢ mbargo, las tareas de diseio que deben siempre realizarse son: '

1.- evaluar las caracterfstiéas de la estructura de datos

»
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Tema 6 Disefio Orientado a las Estructuras de Datos

2.- representar los datos en términos de formas elementales, tales como secuencia,
seleccién y repeticién. :

3.- transformar la representacién de la estructura de datos en una jerarciufa de control
para el software

4.- refinar la jerarqufa del software usando los criterios definidos como parte de un
método

5.- desarrollar finalmente una descripcién procedimental del software.
Subtema 6.3 Descomposicion usando estructuras de datos.

Los origenes del disefio orientado a la estructura de datos pueden dirigirse a las dos técnicas
de descomposicién usando estructuras de datos desarrolladas en forma independiente y
précticamente al mismo tiempo por Jackson en Inglaterra y Warnier en Francia.

Estas técnicas estdn basadas en el principio de correspondencia entre la estructura del
programa y la del problema que la programacién pretende resolver. Como generalmente el
problema a resolver consiste en el procesamiento de datos, la estructura del programa deberd
corresponder a la estructura de los datos que procesa. Jackson menciona : "si un programa no
corresponde al ambiente del problema, el programa no es ni pobre ni malo: es incorrecto”.

Para comprender mejor esto, consideremos el siguiente problema:

En un almacén de una fabrica se requiere producir un reporte que presente el movimiento
neto de productos (articulos, piezas, partes, etc), que el almacén compra y vende. Se cuenta
con unsistema de c6mputo que tiene un archivo maestro de transacciones, en donde se registra
cada ventay cada compra. Los registros del archivo contienen, entre otras variables, el nimero
de identificador del artfculo, el tipo de movimiento (venta o compra) y la cantidad. El archivo
se encuentra clasificado por nimero de articulo, de tal forma, que todos los registros que
representan los movimientos que ha tenido un artfculo se encuentran secuencialmente ligados.

El programa deber4 producir el movimiento neto de cada artfculo y al final resumir4 el total

de productos que sufrieron movimientos. El reporte final deber4 tener el formato como se
muestra en la figura....,
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:ructura del pro :ramma deber4 derivarse de la estructura de datos. Puesto que se desea
\2r una estruct. 1 jerérquica, los datos serdn analizados jerarquicamente. El diagrama
iructura de los  1tos, asf como el diagrama de estructura de programa, representan la
.5n "es compuz > de". Por ejemplo, como entrada al programa tenemos el archivo de
icciones que “: compuesto de " un grupo de registros y cada grupo de registros "es
ruestode "regi: s individualesy, finalmente, cada registro es de uno de dos tipos: venta
npra, eneldiz. msiguiente se puede apreciar lo anterior...
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cotrolado, alas: id: del programa el reporte "es compuesto de " un encabezado, un cuerpo
~dos los movimie .:ov netos) y el resumen.

! :estructuradelp: ;rimase derivadelaestructuradel reporte y de lade los datos de entrada

. programa: el prc. ma: 1a que produce el repor-: "es compuesto de " un médulo que produce

. encabezado, de . - T:6dulo que produce el cuerpo y de uno que produce el resumen. A su

v :z, el médulo qus :o luce el cuerpo contiene un médulo que procesa un grupo de registros,
r:quiriendo al mis: o .empo, de un médulo que emplea un registro y finalmente, dado que _
{ s registros son ¢z os tipos, se necesitaran dos diferentes médulos: uno para analizar los de '
20 de ventay otro 73 a consumir los de tipo compra, como se aprecia en la figura.
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Como puede apreciar, una parte del diagrama de estructura del programa que produce el
reporte corresponde a la estructura de los datos de entrada (el archivo de transacciones), y
otra parte corresponde a la estructura de los datos de salida (el reporte).

Subtema 6.4 Areas de aplicacién

Eldisefio orientado ala estructura de datos puede aplicarse con éxito a aphcacxones que tengan
una estructura jerdrquica, bien definida, de 1a informacién. A.lgunas son:

- Aplicaciones en sistemas de informacién comerciales.

La entraday salida tiene distinta estructura (como en el ejemplo anterior), el uso de una base
de datos jerdrquica es frecuente.

- Aplicaciones de sistema

La estructura de datos para los sistemas operativos comprende muchas tablas, archivos y listas
que tienen una estructura bien definida.

- Aplicaciones de CAD/CAM/CAE

Los sistemas de disefio/fabricacién/ingenieria asistidos por computadoras requieren estruc-

turas de datos sofisticadas para el almacenamlento traduccién y procesamiento de
informacién.

il

- Aplicaciones del dominio de la ingenierfa y de la ciencia.

El disefio orientado a la estructura de datos es mas diffcil de aprender y mas complicado de
aplicar que las técnicas orientadas al flujo de datos. Sin embargo, el disefio orientado a la
estructura de datos ofrece un enfoque més rico y potencialmente, més poderoso para el disefio
de software.
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[A 7 Disenic Orientado al Objeto

ste tema tratars 7105 el disefio orientado al objeto, afio con afio se logran avances que
.cen a la corsiicciébn de computadoras mas veloces, mas compactas y baratas; sin
-go, el aspecio :2 software no se ha desarrollado en forma similar, mientras los costos
-rdware han d::-:inuido continuamente, los de software han hecho lo contrario. No es
rea fécilla con: :ruccién de software y en varias ocasiones los proyectos de programacién
-giran los presu:. :2stos de tiempo y dinero.

-3blema del ma: :2nimiento de software

.0 ya hemos -+ :cionado en temas anteriores la construccién de software ha sido la

:ipal preocupzac: "2 de los expertos por lo que se han conseguido avances significativos
la construccié~ de programas en forma sistemdtica y a bajo costo.. Algunos de los
:ados de estcs - “luerzos son las técnicas que con el disefio estructurado y el desarrollo
:ndente (top-c:. -n), han sido utilizadas durante mucho tiempo por los programadores.
hay aun tres gr. :des deficiencias:

- los product : que resultan de emplear estas técnicas son poco flexibles

- - los progras .lores que las usan tienden a concentrarse en el disefio € implementacién
inicial del si:- :ma, sin tomar en cuenta su vida posterior.

- no alientar. | programador a aprovechar el trabajo de proyectos anteriores. -

desventaja de u .lizar una metodologfa que se concentra en el disefio inicial del sistema
:ce evidente si <. considera que la vida 1til de un producto de software puede ser cinco o
veces mas grar. : que el lapso en que se desarrolla. Los gastos que se hacen durante el
o periodo {gz; »s de mantenimiento) representan el 70% del costo total del sistema.
:dedor del 429 - =1 costo total se tienen que hacer por cambios en las especificaciones del
ri0 0 en los for::.atos de los datos. Es por ello que la extensibilidad (la facilidad con que
:odifica un sist-.na para que realice nuevas funciones) debe ser uno de los objetivos
-arios de la etap . de disefio.

1fase de mantz - miento es muy importante que cualquier método de disefio tenga como
-tivo principal rroducir sistemas que faciliten su propio mantenimiento. Para ello se
‘mienda una se::= de actividades y heurfsticas que pueden servir como guia durante el
«rrollo del sistera.

:ilizacion de ¢éiiigo

5 de los factores que no se toma en cuenta en los métodos de disefio tradicionales es la
“lizacién de ¢6¢: ;0. Cualquier programador que desarrolla unsistema nuevo debe escribir

- buena cantidac de c6digo que ha escrito anteriormente una y otra vez. Las rutinas de

queda, ordenarm :nto, manejo de menis y despliegue de ventanas, se repiten continua-
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mente en proyectos diferentes. Los métodos de desarrollo de software deben alentar al
programador a utilizar el cédigo escrito previamente por el mismo o por otros programadores.

Se han empleado tres tipos de reutilizacién:

- de personal: un proyecto nuevo se le asignan a programadores que tienen experiencia
en ¢l desarrollo de proyectos semejantes.

- de diseiio: consiste en emplear el disefio de un sistema para desarrollar otro sistema
similar

- de c6digo fuente: se da cuando un programador utiliza parte de un programa escrito
con anterioridad para crear un nuevo programa.

Sin embargo, estas tres formas de reutilizacién se han empleado en forma muy limitada, por
lo que es necesario buscar técnicas mas generales.

Modularidad

En temas anteriores mencionamos una de las herramientas de disefio mis poderosa para
facilitar el desarrollo y mantenimiento de sistemas de software, la modularidad. En este tema
trataremos algunas de las caracterfsticas de esta herramienta.

Como recordaran, la modularidad es dividir un sistema complejo en unidades mas pequedas
y manejables, cada una de esas unidades se encarga de manejar un aspecto local de todo el
sistema, interactuando con otros médulos para cumplir con el objetivo global.

_El concepto de médulo es ain mas sofisticado. Entre las propiedades que tiene estén: la
decomponibilidad, componibilidad, comprensibilidad, continuidad y proteccién.

a) Decomponibilidad: Un método modular debe permitir descomponer un problema de
disefio en problemas més pequeios que pueden resolverse en forma independiente.

b) Componibilidad: una vez que se cuenta con un conjunto de médulos que realizan una
funcién especifica, se debe alentar al programador a usar esos médulos para con-
Struir nuevos programas.

¢) Comprensibilidad: El lector de un programa o librerfa debe ser capaz de entender ¢l

funcionamiento de cada mé6dulo sin necesidad de consultar el texto de otros
mddulos.

d) Continuidad: un cambio pequefio en las especificaciones de un programa debe
causar cambios en un sélo médulo 6 en un conjunto pequeiio de ellos.

e) Protecci6n: un error de ejecucién en el funcionamiento de un modulo no debe expan-
dirse hacia los demé4s médulos.
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TEMA 7 Disefio Orientado al Objeto’

¥ - alentar estas pr iedades se utilizan las siguientes estrategias:
mero: Unmodui- :ebe corresponder con una unidad sintdctica del lenguaje.

:ndo: Los m6d.:  : deber tener pocas interfaces (medio de comunicacién entre médulos)

-as debe ser pe:'  :Aas. Un niimero pequefio de interfaces aumenta la independencia de
n6dulos, bacer  mas fécil el proceso de componer nuevos sistemas a partir de médulos
-‘abricados, ayuc  Jemds a evitar que los errores de un médulo se propaguen por todo el
2ma. '

-ercero: Cadam  :lo debe ocultar su implementacién y algoritmos internos al resto del
2ma. No se d2° Dermitir que un médulo modifique los elementos internos de otros
:dulos.

;efio orientado s -jetos

.. disefio orientz. : objetos (DOOQ), es un método que tiene como objetivo establecer
* -nicas de desarr:  de software para producir sistemas modulares. Un sistema orientado a
;etossepuedeer.  -derfdcilmente, facilitando asf su desarrollo, depuracién y mantenimien-

.. DOQ, se basz  un medida sencillas; un sistema de computadora €s un modelo que

:presentaun sutc Juito del mundo real; la estructura de ese sistema se simplifica en gran
.2dida si cada v le las entidades u objetos, del problema que se esta modelando cor-
:sponde directar  :e con un objeto que se pueda manipular internamente en el sistema.

1 proceso de rez: sertar entidades reales con elementos internos en un sistema recibe el
~ombre de abstrac  in de datos. '

.aabstracciénde - osnose concentraen larepresentacién interna de un objeto (una cadena,
-narreglo,unen:: J, etc)

sino en sus atribu- . y en las operaciones que se pueden realizar sobre ese objeto. De esta
{orma, un tipo de 110 abstracto se puede describir concentrdndose en las operaciones que
manipulan a los ot :tos de ese tipo, sin caer en los detalles de representacién y manipulacién
de datos. -

La creaci6n de t: s abstractos permite al disefiador adaptar el disefio a sus necesidades
especificas, se de® - sex capaz de definir tipos de datos que se ajusten al problema que se esta
resolviendoy quz . -eiian ser manipulados después por el lenguaje. Concentrdndose asf enlos
objetos que mari: .la su sistema y las relaciones entre estos objetos, haciendo a un lado la
representaciény : inipulacién de datos, para comprender mejor el problema.
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ELEMENTOS PRIVADOS Y PUBLICOS

Conceptos

Bien, ahora para entender un poco mas acerca del disefio orientado a objetos (DOO),
trataremos algunos conceptos:

CLASE:

Es un tipo abstracto del diseiio orientado a objetos, una clase describe un conjunto de objetos
semejantes. Dicha descripcidn se hace en dos partes:

- los datos que especifican las propiedades de los objetos de esa clase, lamados
atributos.

- y las funciones que manipulan esos datos, lamados métodos.

Un objeto puede recibir mensajes de otros objetos; entonces, debe escoger uno de sus métodos
y dar una respuesta basdndose en los datos que representan su estado.

ELEMENTOS PRIVADOS Y PUBLICOS

Cada objeto cuenta con elementos privados, que solo pueden ser usados por objetos de su
misma clase. Los elementos piblicos representan la interface deiun objeto con su medio

ambiente, (inicamente esos elementos pueden modlﬁcar a los datos privados, los cuales
representan el estado del objeto.

Se proponen dos estrategias para la reutilizacién de c6digo: la composicién y 1a herencia. -

La COMPOSICION pem:ute definir una nueva clase de objetos mediante la unién de un
conjunto de clases ya existentes.

La HERENCIA permite derivar una nueva clase basdndose en otra clase mas general. Una

clase derivada adquiere todas las propiedades y métodos de 1a clase de 1a que se derivo, llamada
clase base.

Ademds de facilitarla reutilizacién de c6digo, 1a herencia es un medio ideal para crear sistemas
con alta extensibilidad. Otraventaja de esta técnica es que permite manipular objetos de clases

diferentes como si fueran de la misma clase, con lo cual es posible definir interfaces uniformes
para diferentes tipos de objetos. :

Lenguajes orientados a objetos

Las técnicas en las que se basa el diseio orientado a objetos como son ocultamiento de
informacién, abstraccién de datos, manejo de clase, eran conocidas y utilizadas por los
ingenieros de software desde hace muchos afios, sin embargo hay pocos lenguajes que brindan
todas las facilidades para escribir programas orientados a objetos, algunos de los mas populares

N
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ELEMENTOS PRIVADOS Y PUBLICOS

s .mula67, Smallt:- [k, Eiffel, Ada o Modula. Estos lenguajes orientados a objetos no habfan
t¢ > hasta hace po.» una aceptacién amplia entre la comunidag de programadores.
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TEMA 8. IMPLEMENTACION DEL SISTEMA
Introduccién

Hasta el momento hemos aprendimos c6mo se efectia el anélisis del sistema; es decir ¢6mo

elaborar un estudio de necesidades y requerimientos de nuestro sistema de informacién antes
de desarrollarlo. .

Posteriormente, conocimos las técnicas para disefiar, con base al anlisis previo, nuestro
sistema, orientdndolo al medio en el que se desarrollard y aplicar4.

Ahora sabremos cémo desarrollar nuestro sistema tomando en cuenta las especificaciones del
diseno y el equipo de cémputo seleccionado.

En este tema conoceremos las formas de plasmar en un equipo de cémputo el disefio de un
sistema. Para ello contamos con cuatro subtemas:

Introduccién

Técnicas de codificacién estructurada
Est&nda;res de Implementaciény
Documentacién

Subtema 8.1 Introduccién

Hasta ahora hemos hablado de c6mo efectuar el anélisis y el disefio de un sistéma que van
dirigidos hacia un objetivo final: la traduccién de las especificaciones del disefio a una forma
que puede ser "comprendida” por una computadora. Hemos llegado finalmente al paso de la
codificacién. El objetivo principal de laimplementacién del sistema es el escribir c6digo fuente
as{ como la documentacién interna de modo que la concordancia del c6digo con sus
especificaciones sea facil de verificar, asf como facilitar la depuracién, las pruebas y
modificaciones al sistema. Para ello se debe elaborar un cédigo claro utilizando 3 pardmetros:

Técnicas de codificaciép estructurada
Estdndares de implementacién y

Documentacién.

Cada uno de estos puntos lo tocaremos especfficamente en los siguientes subtemas.
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TEMA 8. IMPLEMENTACION DEL SISTEMA

Subtema 8.2 Técnicas de codificacién estructurada.
Las técnicas de codificacién tienen comio fin facilitar la traduccién del disefio detallado de los
mddulos que componen un programa a un lenguaje de programacién especifico, manteniendo
la estructura jerdrquica definida en la fase de diseiio.
La programacién estructurada es la aplicacién de métodos basicos de descomposicién de
problemas para establecer una estructura jerrquica ficilmente manejable a través del proceso
de refinamiento progresivo. Es decir, cualquier médulo, atin el m4is complicado, se detalla
utilizando las reglas basicas de la programacién estructurada que son:

Secuencia

Decisién

Repeticién

A continuacidn explicaré cada una de estas reglas,

La secuencia se define como una estructura de proceso que consiste en enunaar, una después
de otra, una serie de instrucciones.

PROCESA(A,B)

Gréficamente se representa como se muestra en la figura, en donde cada instrucci6n esta
encerrada en un cuadro y mantiene una jerarqufa. Esto es, se van ejecutando las instrucciones
una después de la otra.
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- TEMA 8. IMPLEMENTACION DEL SISTEMA

CA=10
: B=40
PROCESA(A,B)

Esta figura muestraun ejemplo ¢n donde estd parte de un programa que contiene instrucciones

simples exclusivamente. Una proposicién simple puede ser una asignacién o un Hamado a un

procedimiento; una proposicién compuesta es un if-then-else 0 un while-do. Todas estas
proposiciones se pueden presentar como una secuencia.

La segunda regla bésica, la decisién, es una estructura de proceso que permite especificar
alternativas en la ejecucién de instrucciones, dependiendo de una condicién.

PRINT A PRINT B

e

Gréficamente se representa como se ve en la figura, en donde la condicién que determinaré
la alternativa a seleccionar estd en unrombo y de éste se desprenden las alternativas a seguir.

Un ejemplo de codificacién de una decisién se muestra a continuacién. Las alternativas a
realizar se presentan con cierta sangrfa para detectar con facilidad la dependencia de su
ejecucién con respecto ala condicién. Comunmente se utiliza la proposicién if-then-else para
su construccién.
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TEMA 8. IMPLEMENTACION DEL SISTEMA

IF A>BTHEN
PRINT A
ELSE
PRINT B
ENDIF

2 tltima regla bésica, la repeticién, es una estructura de proceso que permite la
>cificacién de Iz zjecucién iterativa de una serie de instrucciones. -

‘a figura se puece observar la representacién gréafica de la repeticién. La condicién que
:rminaré el mirm2ro de iteraciones estd encerrada en un rombo.

A=A+l

PRINT A

—

- «odificar unarepeticién, como se muestra en la figura, se deberdn sangrar las instrucciones
: se estardn iterando. Es comiin utilizar las proposiciones while-do o repeat-until para
¢ ‘ificar la estructura‘de repeticién.

WHILE A<10
A=A+1
PRINT A

END
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TEMA 8. IMPLEMENTACION DEL SISTEMA

Una vez que han quedado claras las tres reglas basicas de la codificacién estructurada,

podemos decir que la programacién estructurada se basa en un teorema el cual establece lo
siguiente: :

Cualquier médulo de un programa con una entrada y una salida que tenga todas las

proposiciones en algiin camino de la entrada a la salida puede especificarse usando solamente
secuenciacién, decisién y repeticién.

La propiedad de una entrada y una salida permite ¢l anidamiento de construcciones dentro
de otra en cualquier forma que se desee. Esto es, por ejemplo, si tenemos una proposicién de
decisién, una alternativa puede ser otra proposicién de decisién que a su vez una de sus

alternativas sea otra proposicién de decisién. La codificacién correspondiente a este ejemplo
se muestra en la figura.

WHILE A>B
A=A-1
WHILE B>0
B=A/B
WHILEB>1
PRINT B
END
END
END

El proceso de la codificacién, que es la comunicacién entre los humanos y las computadoras
mediante un lenguaje de programacién, es una actividad humana y es por ello que las
‘caracteristicas del lenguaje afectan directamente a la calidad de la comunicacidn, tienen un
impacto importante sobre el éxito de un proyecto de desarrollo de software y pueden

influenciar la calidad del disefio (ya que practicamente el disefio detallado se dirige hacia un
lenguaje de programacién especifico)..

La eleccién de un lenguaje de programacién para un proyecto especifico debe tener en cuenta
sus caracteristicas y ciertos criterios.
+

El problema asociado con la eleccién del lenguaje puede desaparecer si solo se dispone de un
lenguaje o si el cliente demanda uno en particular. -

. rd
Los criterios que se aplican durante la evaluacién de los lenguajes disponibles estdn:
1) area de aplicacién general

2) complejidad algoritmica y computacional
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TEMA 8. IMPLEMENTACION DEL SISTEMA

3) entorno en el que se ejecutard el software

4) consideraciones de rendimiento

5) complejidad de las estructuras de datos

6) conocimiento de la plantilla de desarrollo de software y

7) disponibilidad de un buen compilador o compilador criuzado.
Actualmente C es el lenguaje elegido comunmente en el desarrollo de software de sistemas.
Y volviendo con las técnicas de codificacién estructurada podemos decir que en un nivel
fundamental, todos los lenguajes modemnos permiten al programador representar secuencias,
decisiones y repeticiones -que son las construcciones l6gicas de la programacién estructurada.
La mayorfa de los lenguajes de programacién modernos proporcionan un sintdxis para la
especificacién directa del if then else, del do while y del repeat until. Otros lenguajes, como
Lispy APL, requieren que el programador emule esas construcciones dentro de los limites de
sintaxis del lenguaje.
Con frecuencia se menciona que el apegarse estrictamente a las técnicas de codificacién
estructurada existe la necesidad de emplear variables auxiliares, segmentos de c6digo repetido

y un excesivo llamado a subprogramas, dando como resultado una utilizacién ineficiente del

espacio de memoria y del tiempo dé ejecuci6n. Es por ello que hablaré de la eficiencia de
cédigo.

La eficiencia del c6digo fuente estd directamente unida a la eficiencia de los algoritmos
definidos durante el disefo detallado. Sin embargo, el estilo de codificacién puede afectar a
la velocidad de ejecucién y a los requerimientos de memoria. Las siguientes directrices se
deben seguir siempre en el proceso de traduccidn del disefio detallado al e6digo:

- Simplificar las expresiones aritméticas y l6gicas antes de convertirlas en cédigo.

- Evaluar cuidadosamente las iteraciones anidadas para determinar si se pueden sacar
fuera de ellos algunas sentencias o expresiones.

- Cuando sea posiiﬂe, evitar el uso de arreglos multidimensionales.
- Cuando sea posible, evitar el uso de ap‘untadores y listas complejas.
- Usar rapidas operaciones aritméticas.

- Usar cuando sea posible aritmética entera y expresiones Booleanas o l6gicas.
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TEMA 8. IMPLEMENTACION DEL SISTEMA

Por lo anterior, podemos decir que las técnicas de codificacién estructurada no son en sf las
que propician la ineficiencia sino los algoritmos y las estructuras de datos los que afectan la
velocidad de ejecucién y el espacio en memoria respectivamente.

Subtema 83 Estindares de Implementacidn.

A continuacién veremos qué son y para qué nos sirven los estdndares de implementacién,
dentro de la implementacién de un sistema.

Los estindares de codificacién son especificaciones para un estilo de codificacién preferido.
Dada una situacién de elegir los caminos para lograr un efecto, se especifica un camino
preferido. Los estindares de codificacién a menudo son vistos por los programadores como
mecanismos para restringir y devaluar las habilidades para resolver problemas creativos de los
programadores. La creatividad siempre ocurre dentro de un marco de trabajo bésico de
estdndares. Los artistas siguen los principios basicos de estructura y composicién, los poetas

se apegan al ritmoy a la métrica del lenguaje. Sin un marco de trabajo de estdndares que guien
y canalicen una actividad, la creatividad se vuelve un caos sin sentido.

- Asf, esdeseable que todos los programadores de un proyecto adopten un estilo de codificacién
similar, de modo que se produzca un cédigo de calidad uniforme.

Algunos de los estdndares cue se pueden aplicar en todas las situaciones son:

- El uso de la instruccién GOTO debe evitarse en circunstancias normales. Esto es, utilizarse

tinicamente para lograr el formato de las construcciones de la codificaci6n estructurada enlos

tenguajes primitivos. La proposicion GOTO es valiosa para las salidas multiples y prematuras
de los ciclos, y para transferir el control al c6digo manipulador de errores. Como pueden
observar en su pantalla tenemos primeramente un cédigo en el que se emplea‘la instruccién
GOTO sin necesidad y posteriormente ¢6mo debe ser.

- Introdiizcanse tipos de datos definidos por el usuario. Muchos lenguajes de programacién
proporcionan tipos de datos definidos por el usuario. El uso de distintos tipos de datos hace
posible distinguir las entidades propias del problema. Por ejemplo si definimos un tipo de
datos llamado colory declaramos los colores: amarillo, rojo, azul, verde y anaranjado; podemos
saber que Unicamente, de toda la gama de colores que existen, se van a utilizar esos.

- Examfnense cuidadosamente las rutinas que tengan menos de 5 0 més de 25 proposiciones.
Un subprograma que tiene més de 25 proposiciones ejecutables probablemente contiene una
o m4s subfunciones bien definidas que pueden agruparse como subprogramas distintos e
invocarse cuando se necesiten. Se dice también que 30 proposiciones ejecutables es el limite
superior de compresién para una sola lectura de un subprograma escrito en un lenguaje de
programacién. Unsubprograma que tiene menos de cinco proposiciones normalmente es muy
pequeio para proporcionar una funcién bien definida. Existen excepciones obvias a estos
principios generales: por ejemplo rutinas para obtener el valor absoluto o el médulo de un
numero y que tiene menos de 5 lineas pueden ser muy utiles.

. DECFI . 47- o CECAFI

i

s




TEMA 8. IMPLEMENTACION DEL SISTEMA

“tilfncese sangrizs, paréntesis, espacios y lineas en blanco, asf como mérgenes alrededor de
bloques de cor.entarios para aumentar la legibilidad. Si el formato del texto fuente lo
i 20 varios progr:madores, todos ellos deben acordar y apegarse a condiciones esténdar,

‘roporciénense prdlogos estdndares de documentacién para cada subprograma. Un prélogo
© . documentacién contiene la informacién acerca de un subprograma o una unidad de
. apilacién que =5 resulta obvia al leer el texto fuente del subprograma o unidad de

mpilacién.

“Islense las depe:dencias de la miquina en unas cuantas rutinas. Si se necesita cambiar la
~-uraleza de la re~resentacién de datos, 0 si el programa se cambia a una maquina diferente,
iocalizan los de::iles de la dependencia de la méquina y pueden modificarse en consecuen-

i,

‘a profundidad 2 anidamiento de la construcciones de un programa debe ser de cinco o
=n0s. Si el anic.miento se vuelve demasiado profundo, se vuelve dificil determinar las
1d1c10nes bajo 15 cuales se va a ejecutar la proposicién més anidada.

. i claridad de un - rograma depende en gran medida, del estilo del programador. Si bien los
- “incipios de un b 2a estilo de programacién no pueden ser expresados como reglas mecénicas

: la buena progr::nacién, la experiencia nos indica que los estdndares pueden servir como
~.afas de estilo”.

.‘ubtema 8.4 Docu mentacion.

: aprogramacién ¢ r computadora incluye el c6digo fuente de un sistemay todos los documen-
s de apoyo gene::dos durante el andlisis, disefio, implementacién, pruebas y mantemrruen—
:adel sistema.

!.as especificacior.:s de requisitos, documentos de disefio, planes de prueba, manuales de
w.suario y los repcrtes de mantenimiento son ejemplos de documentos de apoyo. Estos
Jocumentos son Ic: productos que resultan del desarrollo y mantenimiento sistemético de la
urogramacion.

Un enfoque sister-atico al desarrollo de la programacién garantiza que los documentos de
:poyo se desarrolizn de una manera ordenada y que esos documentos se encuentren dis-
oonibles cuando se necesiten. Estos documentos deben desarrollarse como un producto
aatural paralelo ai proceso de desarrollo. La calidad, cantidad, duracién y utilidad de los
documentos de apcoyo son las principales medidas de la salud y la bondad de un proyecto de
programacioén.

Los documentos sirven para explicar y/o aclarar lo que sucede en ¢l flujo de control de un
programa. Existen dos tipos de Documentacién:

- Documentacién interna
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TEMA 8. IMPLEMENTACION DEL SISTEMA

- Comentarios explicativos del cuerpo del médulo.

La documentacién interna consiste en un prélogo estdndar para cada unidad de programa; los
aspectos autodocumentados del c6digo fuente y los comentarios internos intercalados en la
porcidn ejecutable del cédigo.

La mejor documentacién de un prdgrama de computadora la constituye la claridad de su
estructura; ademis la documentaci6én més confiable de un programa es el c6digo mismo. Por
lo tanto se recomienda la seleccién de lenguajes que estimulen una programacién legible y
estructurada, evitando la necesidad de instrucciones de flujo arbitrariamente complicadas.
El formato caracter{stico de los prélogos de subprogramas es:

Nombre del autor:

Fecha de terminacién:

Funcién realizada:

v Tra

Rutinas que lo invocan:
Rutinas que invoca:
Autor/fecha/modificacién:

" Resumen

La implementacién de un sistema tiene por objetivo obtener un cédigo fuente claro, que
facilite 1a depuracién, prueba y modificacién y que estas actividades consuman una gran
" porcién de la mayor parte de los presupuestos en la programacién.

P
-

) Eg

Eneste temase analizaron las técnicas de la codificacién estructurada, el estilo de codificacién,
estdndares y principios generales y la documentacién interna y de apoyo del c6digo fuente.
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TEMA 9, Verificacién y validacidn del Sistema 7 ' (

En el tema anterior conocimos las técnicas y consideraciones para implantar nuestro sistema
de informacién en un equipo de c6mputo elegido; sin embargo es muy importante efectuar
verificaciones o pruebas en su implementacién para obtener un sistema confiable y eficiente.
El desarrollo de sistemas de software envuelve una serie de actividades de produccién en las
que las posibilidades de que aparezca la falla humana son enormes. Los errores pueden darse
desde el primer momento del proceso en el que los objetivos se pueden especificar de forma
err6nea o imperfecta, asf como los errores que aparecen en los posteriores pasos de disefio y
desarrollo. Debido a la imposibilidad humana de trabajar y comunicarse de forma perfecta, el
desarrollo de software ha de ir acompafiado de una actividad que garantice la calidad.

Los objetivos de las actividades de verificacién y validacién son el valorar y mejorar la calidad
de los productos de trabajo generado durante el desarrollo del disefio y la implementacién.

La verificaci6n se refiere al conjunto de actividades que aseguran que el software implementa
correctamente una funcién especifica. La validacién se refiere a un conjunto diferente de
actividades que aseguran que el software construido se ajusta a los requerimientos del cliente.
Podemos establecer como

Verificacién al hacer la pregunta: {Estamos construyendo correctamente el producto? es
decir, cémo estamos construyendo el producto, {de manera adecuada?. Mientras que para
establecer a la validacién podemos hacer la pregunta: {Estamos construyendo el producto
correcto? es decir, el producto que se estd elaborando es el que cubre todos los requerimientos.

La calidad de los productos de trabajo generados durante el andlisis y el disefio se pueden
estimar y mejorar utilizando procedimientos sistemdticos de control de calidad, mediante
recorridos e inspecciones y por medio de verificaciones automatizadas para supervisar que sea
consistente y que esté completo. La técnica para estimar y mejorar la calidad del cédigo fuente
incluye los procedimientos sistemaéticos de la prueba de unidad, la prueba de integracién, la
prueba de validacién y la prueba del sistema.

Subtema 9.1 Pruebas del Sistema.

Ahora detallaré cada una de las pruebas que se mencionaron anteriormente.

Iniciaremos con la Prueba de Unidad. La prueba de unidad centra el proceso de verificacién
en la menor unidad de disefio de software. Las pruebas de unidad comprenden el conjunto de
pruebas efectuadas por un programador individual, antes de la integracién de la unidad enun
sistema mds grande. Una unidad de programa suele ser lo suficientemente pequeia como para
que el programador que la desarrollé pueda probarla con minuciosidad. Las pruebas que se
d4n como parte de la prueba de unidad son:

Prueba de interfaz

Prueba de las estructuras de datos
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Pruebas de ¢ >ndiciones de lfmite
Pruebas de ¢ :minos independientes
Manejos d2 :Tores

:mos ahora Pr vas de integracién. Las pruebas de integracién es una técnica sistemdtica
3 construir la es - ~ictura del sistema mientras que al mismo tiempo se llevan acabo pruebas
1 detectar erro: s asociados con la interaccién entre sus médulos. El objetivo estomar los
dulos probadc: 2 unidad y construir una estructura de programa que esté de acuerdo con
;ue dicta el dise o, ' ' :

~.sten dos estra:= as de integracidn;
-Integracién c: : :endente
-Integracién =: . :ndente

»remos cada unz e ellas a continuacién; comenzaremos primeramente con la Integracién
:scendente. :

~laintegraci6n ¢2scendente se va haciendo una aproximacién incremental a la construccién '
: la estructura de srogramas. Es decir, se integran los médulos moviéndose hacia abajo por -
. jerarqufa de cor. rol, comenzando con el médulo de control principal (llamado cominmente -
-ograma princip< ;. Los médulos subordinados al médulo de control principal se van incor-
nrando en la estr ctura, ya sea de la forma primero-en-profundidad o de la forma primero-
i-anchura

"n la integracién rimero-en-profundidad se integran todos los médulos de un camino de i

A
!

»atrol principal < - 1a estructura. Para seleccionar el camino principal se puede hacer de una
-~anera arbitrariz © depender4 de las caracteristicas especificas de la aplicacién.
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as conductores y se combinan los grupos moviéndose haaa arriba por
dei programa.

tlustrativa con el siguiente ejemplo: Siguiendo el esquema que se muestra

;:nan los médulos para formar los grupos 1, 2, y 3. Cada uno de los grupos

mediante un conductor que se muestra como un bloque punteado. Los
s 1y 2 son subordinados de Ma. Se eliminan los conductores Cly C2y
os directamente a Ma. De forma similar se elimina el conductor C3 del
-grarlo con el médulo Mb. Finalmente, tanto Ma como Mb se integran en
sucesivamente. :
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:2gracién progresa hacia arriba, disminuye la necesidad de conductores de
D¢ hecho, si los niveles superiores del programa se integran de forma
2te reducir sustancialmente el niimero de conductores y se simplifica
:2gracién de grupos.

": Prueba de Validacién,

d: la prueba de integracién, el software est4 completamente ensamblado
e nan encontrado y corregido los errores de interfaces, y debe comenzar
-1¢as de software la prueba de validacién y ésta se logra cuando el software
i0 1 las espectativas razonables del cliente. Para la prueba de vahdac16n

e ar 3 puntos.

rvaba de validacidn.

‘3 onfiguracién.

Leta,




Por dltimo pasemos a describir la Prueba del Sistema.
Una vez que el software es incorporado a otros elementos del sistema y se realiza una serie

de pruebas de integracién del sistema y de validacién, se realizan las pruebas generales del
Sistema.

Los pasos dados durante el disefio del software y durante la prueba pueden mejorar enorme-
mente la probabilidad de éxito en la integracién del software en el sistema total.

La prueba del sistema realmente est4 constitufda por una serie de pruebas diferentes cuyo
prop6sito primordial es ejercitar profundamente el sistema basado en la computadora. Los
tipos de prueba del sistema son:

Prueba de recuperacién

Prueba de seguridad '

Prueba de resistencia

Prueba de rendimiento
Bien, en este tema conocimos las pruebas que hay que aplicar ha nuestro sistema tanto en el

momento de su desarrollo como cuando se ha integrado totalmente conla finalidad de obtener
un sistema de alta calidad.




ANALISIS Y DISENO DE SISTEMAS DE COMPUTO

LECTURA: PRUEBAS DE UNIDAD.

|
En las pruebas de unidad se prueba la interfaz del médulo para
asegurar que la informacién fluye de forma adecuada hacia y desde
la unidad del programa que estd siendo probada. Se examinan las
estructuras de datos locales para asegurar que los datos que se
mantienen temporalmente conservan su integridad durante todos los
pasos de ejecucidén del algoritmo. Se prueban las condiciones limite
para asegurar que el mddulo funciona correctamente en los limites
establecidos como restricciones de procesamiento. Se ejercitan
todos los caminos independientes (caminos bdsicos) de la estructura
de control con el fin de asegqurar que todas las sentencias del
médulo se ejecutan por lo menos una vez. Y finalmente, se prueban
todos los caminos de maneio de_ errores. '

Antes de iniciar cualquier otra prueba es preciso probar el flujo
de datos de la interfaz del mé&dulo. Si los datos no entran
correctamente, todas las demds pruebas no tienen sentido. Myers, en
su 1libro sobre prueba 'de software, propone una lista de
comprobaciones para la prueba de interfaces:

1. ¢Es 1igual el ndamero de parimetros de entrada al nGmero de
argumentos?

2. ¢Coinciden los atributos de los parémetros y los argumentos?
3. ¢Coinciden los sistemas de unidades de los parédmetros y de los
argumentos?

4. ¢Es igual el nimero de argumentos transmitidos a los médulos de
llamada gque el nimero de parametros?

5. ¢Son iguales los atributos de los argumentos transmitidos a los
médulos de llamada y los atributos de los pardmetros?

6. ¢Son iguales los sistemas de unidades de 1los argumentos
transmitidos a los médulos de llamada y de los parametros?

7. iSon correctos el nGmero, los atributos y el orden de los
argumentos de las funciones incorporadas?

8. ¢Existen referencias a parédmetros que no estén asoc1ados con el
punto de entrada actual?

9. ¢Entran sdélo argumentos alterados?

10. :Son con51stentes las definiciones de variables globales entre
los médulos?

11. :;Se pasan las restricciones como argumentos?

Cuando un médulo lleve a cabo E/S externa, se deben llevar a cabo
pruebas de interfaz adicionales. De nuevo, de Myers:

1. ¢Son correctos los atributos de los archivos?

2. ¢Son correctas las sentencias de apertura?

3. ¢Cuadran las especificaciones de formato con las sentencias de
E/S?

4. ¢;Cuadra el tamafio del buffer con el tamafio del reglstro°

5. ¢Se abren los archivos antes de usarlos?

6. .Se tienen en cuenta las condiciones de fin de archivo?

7. ¢Se manejan los errores de E/S?

8. ¢Hay alg(n error textual en la informacidn de salida?

Las estructuras de datos locales de cada médulo son una fuente
potencial de errores. Se deben disefiar casos de prueba para
descubrir errores de las siguientes categorias.

1. tipificacién impropia ¢ inconsistente
2. iniciacién o valores implicitos erréneos
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3. nombres de variables incorrectos (mal escritos o truncados)

4. tipos de datos inconsistentes

5. excepciones de desbordamiento por arriba o por abajo, o de
direccionamiento

Ademis de las estructuras de datos locales, durante la prueba de
unidad se debe comptobar {en la medida de lo posible) el impacto de
los datos globales sobre el médulo (p.ej., el COMMON de FORTRAN).

Durante la prueba de unidad, la comprobacién selectiva de los
caminos de ejecucidn es una tarea escencial. Se deben diseflar casos
de prueba para detectar errores debido a cilculos incorrectos,
comparaciones incorrectas o flujo de control inapropiados. Las
pruebas del camino bisico y de bucles son técnicas muy efectivas
para descubrir una gran cantidad de errores en los caminos.

Entre los errores mids comunes en los cédlculos estan: 1)
precedencia incorrecta o mal interpretada; 2) operaciones de modo
mixto; 3) inicializaciones incorrectas; 4) falta de precisién; 5)
incorrecta representacién simbélica de una expresién. Las
comparaciones y el flujo de control estin fuertemente emparejadas
(p. ej., el flujo de control cambia frecuentemente tras una
comparacién). Los casos de prueba deben descubrir errores como: 1)
comparaciones entre tipos de datos distintos; 2) operadores légicos
o precedencia incorrectos; 3) igualdad operada cuando los errores
de precisidén la hacen poco probable; 4) variables o comparadores
incorrectos; 5) terminacién de bucles inapropiada o inexistente; 6)
fallo de salida cuando se encuentra una iteracién divergente, y 7)
variables de bucles modificadas de forma inapropiada.

Un buen disefio dicta que las condiciones de error sean
previstas de antemano y que se dispongan unos caminos de manejo de

errores que dirijan-‘o terminen de una forma 11mp1a el procesamiento

cuando se dé un error.

Entre los errores potenciales que se deben comprobar cuando se
evalGa la manipulacién de errores estin:

Descripcién 1n1nte11g1b1e del error

El error sefialado no se corresponde con el error encéntrado.

La condicién de error hace que intervenga el sistema antes gue
mecanismo de manejo de errores

El procesamiento de la condicién excepc1ona1 es lincorrecto.

La descripciédn del error ne proporciona suficiente informacién
para ayudar en la localizacién de la causa del error.

Un-P-rDuNH
« pae s

La prueba de limites es' 1la Gltima (y probablemente la més
importante) tarea del paso de prueba de unidad. El software falla
en sus condiciones limites. O sea, a menudo aparece un error cuando
se procesa el elemento n-simo de un arreglo n~dimensional, cuando
se hace la i-ésima repeticidn de un bucle de i pasos o cuando se
encuentra los valores mdximo o minimo permitidos. Los casos de
prueba que ejerciten las estructuras de datos, el flujo de control
y los valores de los datos por debajo, en y por encima de los

madximos y los minimos son muy apropiados para descubrir estos
errores.
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.I8I8 Y DISENO DE BISTEMAS DE COMPUTO

‘URA: PRUEBA: DE VALIDACION.

validacién iel software se consigque mediante una serie de

bas que dermlestran la conformidad con los requerimientos.

Un

de prueba :raza las pruebas que se han de llevar a cabo, y un
‘2dimiento - prueba define los casos de prueba especificos que
1 usados p2a demostrar la conformidad con los requerimientos.
2 el plan c.z10 el procedimiento estardn disefiados para asegurar

que se

se satisfz:2n todos los requerimientos funcionales,

mnzan todor los requerimientos de rendimiento,
.mentacidn :3 correcta e inteligible y que se alcanzan otros
.arimientos p. ej., portabilidad, compatibilidad, recuperacién

rrores, fac.lidad de mantenimiento).

que

la

Una vez gu» se procede con cada caso de prueba de validacién,
.2 darse u-r- de dos condiciones: 1) Las caracteristicas de
‘ionamientc o de rendimiento estidn de acuerdo
izificacionss y son aceptables, © 2) Se descubre una desviacién
.as especif::aciones y se crea una lista de deficiencias.
‘laciones ¢ errores descubiertos en esta fase del proyecto
mente se pu:ilen corregir antes de terminar el plan. A menudo es
:sario negc.lar con el cliente un método para resolver las

ciencias.

Repaso de .a configuracién

con

las

Las

lemento im::rtante del proceso de validacidn es el repaso de la
.iguracién. 21 repaso intenta asequrar que todos los elementos
la configuricidn del software se han desarrollado de forma
-uada, esta: catalogados y tienen el suficiente detalle para
litar la f.se de mantenimiento dentro del ciclo de vida del

ware.

Pruebas al‘a y beta

7irtualment: imposible que un encargado del desarrollo del
.ware pueda srever cédmo un cliente usaréd realmente un programa.
‘ueden inter>retar mal las instrucciones de uso, se pueden usar
‘larmente e-trafias combinaciones de datos y una salida que
‘en estar ciara para el que realiza la prueba puede resultar

.teligible mara un usuario normal.

cuando se construye software a medida para un cliente,

se

;a a cabo ura,serie de pruebas de aceptacién para permitir que
:liente valide todos los requerimientos. Llevado a caboc por el
una prueba de
stacién puecde ir desde un informal "paso de prueba" hasta la
~ucién sistendtica de una serie de pruebas bien planificadas. De
~6, la prueoa de aceptacién puede tener lugar a lo largo de
2nas o meses, descubriendo asi errores acumulados gue pueden ir

rrio final =2n lugar del equipo de desarrollo,

~adando el sistema.

Si el software se desarrolla como un producto a ser usade por

s clientes, no es practico realizar pruebas de aceptacién
nales para cada uno de ellos. La mayoria de los constructores de
ductos de scfi:ware llevan a cabo un proceso denominado prueba

a y beta para descrubrir errores que parezcan que sblo el

ario final purde descubrir.

La prueba 1fa es conducida por un cliente en el lugar de
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desarrollo. Se usa el software de forma natural, con el encargado
del desarrollo. "mirando por encima del hombro" del usuario y
registrando errores y problemas de uso. Las pruebas alfa se llevan
a cabo en un entorno controlado.

La prueba beta se lleva a cabo en unoe © mis lugares de
clientes por los usuarios finales del software. A diferencia de la
prueba alfa, el encargado del desarrollo normalmente no esti
presente. Asi, la prueba beta es una aplicacién "en vivo" del
software en un entorno que no puede ser controlado por el equipo de
desarrollo. El cliente registra todos los problemas (reales o
imaginarios) que encuentra durante la prueba beta e informa a
intervalos requlares al equipo de desarrollo. Como resultado de los
problemas anctados durante la prueba beta, el equipo de desarrollo
del software lleva a cabo modificaciones y asi prepara una versién
del producto de software para toda la base de clientes.




ANALISIS Y DISENO DE SISTEMAS DE COMPUTO

LECTURA: PRUEBA DEL SISTEMA.
Prueba de recuperacién‘

Muchos sistemas basados en computadora  deben recuperarse de los
fallos y resumir el procesamiento en' un tiempo previamente
especificado. En algunos casos un sistema debe ser tolerante a
fallos de procesamiento no deben hacer que cese el funcionamiento
de todo el sistema. En otros casos, se debe corregir un fallo del
sistema en un determinado periodo de tiempo a riesgo de que se
produzca un serio dafio econdmico,.

La prueba de recuperacién es una prueba del sistema que fuer:za
el fallo del software de muchas formas y verifica que 1la
recuperacién se lleva a cabo apropiadamente. Si la recuperacidn es
automitica (llevada a cabeo por el propio sistema) hay que evaluar
la correccién de 1la .reinicializacidén, de 1los mecanismos de
recuperacién del estado del sistema, de la recuperacidn de datos y
del arrangque. Si la recuperacidn requiere la intervencién humana,
hay que evaluar los tiempos medios de reparacién para determlnar si
estdn dentro de unos limites aceptables.

Prueba de seguridad

Cualquier sistema basado en computadora gque maneje informacidn
sensible o 1lleve a cabo acciones que puedan impropiamente
perjudicar (o beneficiar) a 1los individuos es objeto de
penetraciones impropias o ilegales. La penetracién incluye un
amplio rango de actividades: "destripadores" que intentan penetrar
sistemas como deporte, empleados disgustados que intentan penetrar
por venganza e individuos deshonestos gue intentan penetrar por
obtener ganancias personales ilicitas.

La prueba de seguridad intenta verificar que los mecanismos de
proteccidn incorporados en el sistema lo protegeradn, de hecho, de
la penetracién impropia. Citando a Beizer [BEI84]): "Por supuesto,
la seguridad del sistema debe ser probada en su invulnerabilidad
frente a un ataque frontal pero también debe ser probada en su
invulnerabilidad frente a atagques por los flancos o por la
retaguardia®.

Durante la prueba de seguridad, el encargado de la prueba
juega el papel de un individuo gue desea penetrar en el sistema.
iTodo vale! Debe intentar hacerse con las claves de acceso por
cualquier medioc externo del oficio; debe atacar al sistema con
software a medida, disefiado para romper cualgquier defensa que haya
sido construida; debe bloquear el sistema, negando asi el servicio
a otras personas; debe producir a propésito errores del sistema,.
intentando penetrar durante la recuperacién; o debe curiosear en
los datos pGblicos, intentando encontrar la clave de acceso al
sistema.

Con el suficiente tiempo y los suficientes recursos, una buena
prueba de seguridad terminari por penetrar en el sistema. El papel
"del disefiador del sistema es hacer que el coste de penetracidn sea
mayor que el valor de 1la in-“srmacidén obtenida mediante la
penetracién.

Prueba de resistencia

Durante los anteriores pasos de prueba, la técnica de la caja




blanca y de la caja negra. daban como resultado la evaluacién del
funcionamiento y del rendimiento normales del programa. Las pruebas
de resistencia estan disefladas para enfrentar a los programas con
situaciones anormales. En esencia, el sujeto que realiza la prueba
de resistencia se pregunta: ":;A qué potencia puedo ponerlo a
funcionar antes de que falle?

La prueba de resistencia ejecuta un sistema de forma que
demande recursos en cantidad, frecuencia o vol(menes anormales. Por
ejemplo: 1) disefiar pruebas especiales que generan diez
interrupciones por segundo, mientras gue una o dos son las
normales; 2) incrementar las frecuencias de datos de entrada en un
orden de magnitud con el fin de comprobar cémo responden las
funciones de entrada; 3) ejecutar casos de prueba que requieran el
méximo de memoria o de otros recursos; 4) disefar casos de prueba
gue puedan dar problemas con =1 esquema de gestién de memoria
virtual; 5) diseflar casos de prueba gque produzcan excesivas
blisquedas de datos residentes en disco. Esencialmente, el encargado
de la prueba intenta tirar abajo el programa.

Una variacién de la prueba de resistencia es una técnica
denominada prueba de sensibilidad. En algunas situaciones (la m&s
comin se da con algoritmos matemdticos) un rango muy pequeiio de
datos dentro de los limites de una entrada vilida para un programa
puede producir un procesamiento extremo e incluso errdéneoc o una
profunda degradacién del rendimiento. Esta situacién es andloga a
la existencia de una signularidad en una funcidén matem&tica. La
prueba de sensibilidad intenta descubrir combinaciones de datos
dentro de una clase de entrada valida que pueda producir
inestabilidad o procesamiento incorrecto.

"Prueba de rendimiento

Para sistemas de tiempo real o sistemas empotrados, el software que

proporciona las funciones requeridas pero que no se ajusta a los

requerimientos de rendimiento es inaceptable. La prueba de
rendimiento estéd disefiada para probar el rendimiento del software
en tiempo de ejecucidn dentro del contexto de un sistema integrado.
La prueba de rendimiento se da durante todos los pasos del proceso
de prueba. Incluso al nivel de unidad, se debe asegurar el
rendimiento de los médulos individuales a medida que se llevan a
cabo las pruebas de la caja blanca. Sin embargo, hasta que no estén
completamente integrados todos los elementos del sistema no se
puede asegurar realmente el rendiminento del sistema.

Las pruebas de rendimiento a menudo van emparejadas con las
pruebas de resistencia y a menudo requieren instrumentacién tanto
de software como de hardware. O sea, a menudo es necesario medir la
utilizacidén de recursos (p. ej., ciclos de procesador} de una forma
exacta. La instrumentacién externa puede monitorizar los
intervalos de ejecucién, los sucesos ocurridos (p. ej.,
interrupciones) y muestras de los estados de la mdquina en un
funcionamiento normal. Instrumentando un sistema, el encargado de
la prueba puede descubrir situaciones que lleven a degradaciones y
posibles fallos del sistema.
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LISI8 Y DIS NO DE SISTEMAS DE COMPUTO

TURA: MANT- IMIENTO DEL SISTEMA.
" Mantenim: -nto estructurado frente al no estructurado

i sb6lo s: dispone del c¢édigo fuente comoc elemento de
figuracién. la actividad de mantenimiento comienza con una
orosa eval. -zién del cédigo, a menudo complicada por la pobre
umentaciér .nterna. Las sutiles caractristicas, tales como la
ructura de  programa, las estructuras de datos glabales, las
erfaces de sistema, el rendimiento y/o las limitaciones del
-2fio, son dificiles de descubrir y frecuentemente mal
2rpretadas. s dificil asequrar cudles son las ramificaciones de
.2ios lleva: :s Gltimamente en el c6digo. Es imposible llevar a

J pruebas ' : regresién (repetir prueba anterior para asegurar

las modi: taciones no han introducido fallos en el software
-viamente - =2rativo), ya que no existe ninglin registro de
.ebas. Lo - .2 hacemos es un nmantenimiento no estructurado vy

amos el pr -io (en esfuerzo desperdiciado y en frustraciones
-sonales) < 2 se adjunta a todo software que no ha sido
‘arrollado i -diante una metodologia bien definida.

Si exists na completa configuracién del software, la tarea de
tenimientc :o>mienza con una evaluacién de la documentacién del
.eflo, Se det rminan las importantes caractristicas estructurales,
rendimient: v de interfaz del software. Se estudia el impacto de
; correcior: o modificaciones requeridas y se traza un plan de
zuacién. Se -odifica el disefio. (usando técnicas idénticas a las
icutidas en capitulos anteriores) y se revisa. Se desarrolla
vo cddigo : =nte, se realizan pruebas de regresién mediante la
lormacidn cc :tenida en la Especificacidén de Prueba y se vuelve a
~zar el sof: ‘are.

Esta se- :encia de sucesos constituye el mantenimiento
ructurado v :parece como resultado de una anterior aplicacién de
1 metodologi - de ingenieria del software. Aunque la existencia de
1 configurac .5n del software no garantiza un mantenimiento libre
problemas, se reduce la cantidad de esfuerzo requerido y se
tora la cali iad general del cambio o de la correccidn .

Costos de mantenimiento

costo del nantenimiento de software ha crecido réapidamente
rante los Ul:imos veinte afios. Los porcentajes de factura total
. software gue se gastan en el mantenimiento de software
:stente son: para los afios 70’s de 35-40%, para los afios 80’s de
-60% y se es:tima gue para los afios 90’s serd de 70-80%. Aunque
s promedios industriales son dificiles de asegurar y estéan
ertos a mucr-as interpretaciones, una organizacién de desarrollo

. software ti:ica gasta entre el 40 y el 70 por ciento de todo su
nero en el mantenimiento correctivo, adaptivo, perfectivo ¥y

sventivo.

Los costcs @n dblares del mantenimiento son los mads obvios.
n embargo, c:ros cotos, meénos tangibles, pueden en Gltimo lugar

.r la causa ¢= nuchas preocupaciones. Citando a Daniel McCracken
~2180]:




Los retrasos en las nhuevas ampliaciones y en los grandes
cambios medidos en aflos se van alargando. Como industria, ni
siquiera podemos hacer frente -digamos s8lo poner al dia- a lo
gque nuestros usuarios quieren que hagamos.

McCracken alude a la organizacién en la barrera del mantenimiento.
Un costo intangible del mantenimiento del software viene dado por
una oportunidad de desarrollo que se propone o se pierde debido a
que los recursos disponibles deben estar dedicados a las tareas de
mantenimiento. Otros costos intangibles incluyen:

insatisfaccién del cliente cuando una peticidn de reparacién
o de modificacidén aparentemente legitima no se puede antender
en un tiempo razonable

. disminucién de la calidad global del software debido a los
errores latentes que introducen los cambios en el software
mantenido
trastornos en otros esfuerzos de desarrollo al tener gue
"poner" a trabajar a la plantilla en tareas de mantenimiento.

El costo final del mantenimiento de software es una dramitica
reducciédn de la productividad (medida en LDC por persona-mes o en
punto de funcién por persona mes) que se encuentra cuando se inicia
el mantenimiento -de viejos programas. Se ha informado de
reducciones de la'productividad de 40 a 1 [BOE79]. O sea, un
esfuerzo de desarrollo que haya resultado en un costo de $25 por
linea de cédigo desarrollada, costarfa’ $1.000 por cada linea de
cddigo que sea mantenida.

El esfuerzo gastado en el mantenimiento se puede dividir en
actividades productivas (p.el., andlisis y evaluacién, modificacién
del disefio, codificacién) y actividades "menos productivas" (p.
eje., tratar de comprender lo que es el cédigo; <tratar de
interpretar 1las estructuras de datos, las caracteristicas de 1la
interfaz, los limites de rendimiento). La siguiente expresién
[BEL72) proporciona un modelo del esfuerzo de mantenimiento:

= p + K exp(c-f)

donde M = esfuerzo total gastado en el mantenimiento
p = esfuerzo productivo (descrito arriba)
k = una constante empirica
¢ = una medidad de la complejidocad que se puede atrlbulr a la
falta de un buen disefio y de documentacién
f = una medida del grado de familiaridad con el software.

Este modelo indica que el esfuerzo (y costo) puede aumentar
exponencialmente si se usa una pobre aproximacién de desarrollo de
software (o sea, una falta de ingenieria del software) y si la
persona o grupo gue usan la aproximacién no estd disponible para
llevar a cabo el mantenimiento.

Problemas

La mayoria de los problemas asociados con el mantenimiento de
software se debe a las deficiencias de la forma en que el software
ha sido definido y desarrollado. Aqui aparece el clésico sindrome
del pague ahora o pague después™ La falta de control Yy disciplina
en las dos primeras fases del proceso de ingenieria del software
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casi siempre se traduce en problemas para la Gltima fase.
"Entre 1los muchos problemas clasicos asociados con el
mantenimiento de software se encuentran los siguientes:

. A menudo es excepcionalmente dificil comprender un programa
"ajeno". A medida que existen menos elementos de configuracién
del software, mayor es la dificultad. Si s6lo existe el cédigo
indocumentado, es de esperar que aparezcan serios problemas.

. Ese personaje "ajeno" a menudo no se encuentra alrededor para
pcder explicarse. La movilidad entre los profesionales del
software es actualmente muy grande. No podemos esperar una
explicacién personal del software por el que 1lo ha
desarrcllado una vez que se reguiere el mantenimiento.

. No existe una documentacién apropiada o esti mal preparada. Un
primer paso es el reconocimiento de que el software debe ser
documentado, pero para que la documentacién sea de algtn valor
debe ser comprensible y consistente con el cédigo fuente.

. La mayoria del software no ha sido disefiado previendo el
cambio. A menos que el método de disefic prevea el cambio
mediante conceptos tales como independencia funcional o clases
de objetos, las modificaciones del software ser&n dificiles y
propensas a errores.

. El mantenimiento no se ve como un trabajo atractivo. Muchas de
las causas de esto vienen dadas por el alto nivel de
frustracidn asociado con el trabajo de mantenimiento.

Todos los problemas que se acaban de describir se pueden, en parte,

atribuir al gran nGmero de programas actualmente existentes que ha
sido desarrollados sin tener en cuenta la ingenieria del software.

Tampoco se debe ver como una panacea el uso de una metodologia

disciplinada. Sin embargo, la ingenieria del software por lo menos

proporciona soluciones parciales a cada problema asociado con el
mantenimiento.

Como consecuencia de 1los problemas asociados con el
mantenimiento de software, surgen varias cuestiones técnicas y de
organizacién. (Es posible desarrollar software gque esté bien
disefilado. y sea f&cil de mantener? ;Podemos mantener la integridad
del software cuando tiene que ser modificado? ¢Existen enfoques
técnicos y organizativos que se puedan aplicar con éxito al
mantenimiento de software? En las secciones gque Vienen a
continuacién se discuten estos y otros puntos.




ESTRATEGIAS DE DESARROLLO E
IMPLEMENTACION DE SISTEMAS
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1.1 ESTRATEGIAS DE DESARROLLO E IMPLEMENTACION DIZ
SISTEMAS

tLa Ingenieria de software es un conjunto de actividades cuyo
objetive ea el desarrollo de software méia conflahle, menoa costnso,
y tue funclone eflciontemnnte pobre midgquinnn realan. Abharca un
conjunto de tres elementos:

- métodos
-~ herramientas
- procedimientos

Los métodos abarcan 1la planificacién y estimacién de
proyectos, amndlisis de los requerimientos del sistema y del
software, disefo de las estructuras de datos, argquitectura de
programas y procedimientos algoritmicos, prueba y mantenimiento.

Las herramientas de la ingenierfa de software suministran un
soporte automitico o semiautomitico para los métodos. lloy en dfa,
existen herramientas para soportar cada uno de los diversos
métodos. ’

Los procedimientos unen a los métodos y herramientas vy
facilitan un desarrollo racional y oportupo del software de
computadora. Definen la secuencia en la que se aplican los métodos,
los controles que ayudan a asegurar la calidad y coordinacién de
los cambios en el software.

Las herramientas serdn analizadas a detalle en el capitulo
siguiente, por otra parte dado que los procedimientos vienen
inherentes tanto a la metodologfa como a las herramientas electas,
estos no serin desarrollados con tanta profundidad.

METODOB ESTRUCTURADOS

Los métodos estructurados consisten de un conjunto de reglas,
tareas, y técnicas, para ayudar en el desarrollo de sistemas en uno
o mas de sus estados {estrategia, andlisis, diseho, etc).

- l.os métodos estructurados empezaron a ser utilizados en
circulos académicos a finales de los 60's, y alcanzaron popularidad
en el Ambito comercial a mediados de los 70's. Estos métodos
ofrecieron una solucién a los entonces existentes estindares de
desarrollo no estructurados y carentes de diseno.
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Dentyo de los métodos cutructurados se encontraban las
graficas estructuradas de Yourden, diagramas de Warnier/orr,
diagramas de Jackson, la técnica estructurada de Chen para el
disefo estructuralo de datos, dlagramas de entidad relacién, etc.

A medlados de loa 70's, James Martin dlo inicic al concepto de
clceclo du vida para unlfliecar y controlar todo el proceso da
desarrollo de un sistema. Este método llamade Ingenieria de
Informacién (IE) en el que se sigue un. enfoque top-down, Be
fdentifican las necesidades de informacién durante la etapa de
andlisis con el fin de delimitar los alcances del sistema. Las
metodologlias CASE (Computer Aided System Engineering) fueron
construidas siguiendo este enfoque.

Las Herramientas CASE empezaron a ser desarrolladas a
principic de los 80's para soportar y automatizar algunas de las
tareas encontradas en los métcdos estructurados de desarrollo.

Algunos de los métodos mds conocidos para el desarrollo de
sistemas dentro de la ingeniaria de software se detallan a
continuacién.

Método Warnierjorr

Warnier/Orr no es proplamente una metodologia para la construccién
de sistemas, existen los diagramas Warnierf/Orr , el método de
Warnier ({(légica de estructura de datos, construccién de sistemas
l6gica, y construccién lbégica de programas) y el método de Orr
(Desarrollo de sistemas estructurados) estdn  unides pero
estrictamente hablando no existe una metodologlia Warnierjforr.

Es muy comin gue se confunda la metodologfa con los diagramas,
tal vez esto Sea porque los diagramas son la parte mis visible de
la mayorfia de las metodologias; sin embargo, una metodolegia es
mucho mds gue s6lo diagramas y reglas de sintaxis.

Dentro del contexto de ingenieria de software un método es un
procedimiento o una técnica que realiza unha porcién slgnificante
del ciclo de vida de un sistema. Una metodologia es una coleccitn
de métodos basados en upa filosofia comin gue juntos cuhren parte
o todo el ciclo de vida de un sistema.

El nombre correcto de lo que mucha gente llama metodologlia
Warnier/Orr es: Desarrollo Estructurado de Sistemas de Datos (DSSD
pData-Structured Systems Development) y es el resultado del trabajo
conjunta de mucha gente.
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En 1972, el articulo de Terry Baker "Chief Programmer Team
Operations" en el semanario de siatemas IBM, reunié varlas ideas de
programacibén estructurada, disefio Top-Down e implementaclién, eato
tuve un qgran impacto aen el campo de la computaciédn, Fue entonces
ciraenl ppgeea S0 e pevabac P ot ructirada e o Pab e Hnldoas,

A principios de los 70’8 Ken Orr descubre gue la estruclura
jerdrquica de los programas es reflejada en la escrucie.a
jerdrquica de los datos y fue por ese tiempo que Jean Warnler habia
hecho el mismo descubrimiento, pero ademds habia construido una
metodologia sistemdtica alrededor de este descubrimiento.

La programacifén estructurada de los datos significa que pueden
ser construldas soluciones predeciblemente correctas para una
amplia gama de problemas de prograpaciétn. La técnica de datos
estructurados fue extendida para resolver programas complejos y
arbitrarios.

Se desarrolld un esquema en el cual las entradas fisicas-son
copvertidas a entradas légicas; las entradas légicas se convierten
en salidas légicas; Finalmente, las salidas lbgicas son convertidas
en salidas fisicas.

Con este proceso de diseflo de programas comienza la estrategia
del disefo orientado a objetivos, éste inicia con la estructura de
salida y trabaja hacia atrds, iniclia con la salida légica, entrada
16gica y finalmente entrada fisica.

Poco a poco DSSH se movid de la metodologia de disefo de
programas. a una metodologia de disefo de sistemas. Después la
metodologia fue expandida para abarcar el disefio de bases de datos,
definicién de reguerimientos y finalmente 1la planeacion vy
arquitectura de los sistemas.

A nivel conceptual DSSD aGn contiene rasgos caracteristicos a
nivel de programacién. Por ejemplo, atin se enfoca (en su fase de
disedo) a trabajos haclia atrds desde las salidas. DSSD trabaja
hacia atris hasta la base datos légica y luego hacia las entradas,
.La base de datos 16gica se transforma en una base de datos
relacional y normalizada (ver figura 1.1.1).

Mientras que una definicién completa de los requerimientos
(salidas mids algoritmos) es un excelente punto de partida en el
disefo, no es propiamente el punto desde el cual empezar la
definicion de los requerimientos. As{ a través de los afos, DSSD se
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ha extendido hasta cubrir primero el contexte, luego las funciones
y finalmente los resultados del sistema,.

Se hicieron necesariana un ndmero de herramiontas para
facilitar este proceso. Los dlagramas de Entidades ayudan a definir
el contexto del sistema, y los dlagramas de linea de montaje (una
forma modificada de los diagramas Warnier/Orr) ayudan a definir el
flujo funcional del sistema.

Las metodologfas estructuradas de datos tienen ventaja sobre
muchas metodologias orientadas a procesos, dado que son mis
riqurosas y por tanto proporcionan una mejor base para la verdadera
integracién a través de todo el ciclo de vida de un sistema. DSSD
ha sido usado exitosamente en un gran rango de sistemas de
software, desde sigtemas comerciales en linea hasta sistemas de
control de tiempo real. Clentoa de personas lo han aprendido y
cientos de sistemas han sido desarrollados con este método,

; DSSD es un acercamiento a la ingenlerfa de software que ha
proporcionado un marco de trabajo estable para incorporar nuevas
tecnologlias conforme éstas surgen. Por ejemplo, se han incorporado
los prototipos de diseflo en linea y en tiempo real sin sacrificar
lo ya realizado.

Método Ganea / Barson

Este método estd basado en el modelado 16gico el cual consiste en
tomar las ideas vagas necesarias acerca de los requerimientos y
convertirlas en definiciones precisas tan pronto como sea posible,
este proceso puede realizarse ripidamente si se cuenta con una
técnica grafica que nos permita tener la esencla del sistema sin ir
al problema de la implementacién fisica, con esto pudiera hacerse
por ejemplo un prototipo.

El modelado ldgico puede verse como un proceso de 7 pasos:

1.- Desarrollo de un Dlagrama de Flujo de Datos (DFD) general que
describa lo que ocurre en cada 4irea de la empresa. Para
simplificar los diagramas se emplean solamente cuatro simbolos
que producen un diagrama mostrando la naturaleza l6gica de
cualquier sistema de informacién a cualquier nivel deseado de
detalle. Los DFD nos muestran los limites de una Area dentro
del sistema y de la empresa misma, los diagramas no son
técnicos, es decir son f&ciles de entender por cualquier
persona familiarizada con el Area deacrita, nos muentran dataos
almacenados y los procesos que transforman 508 datos.

SISVI'MA PARA 1A AUIOMANIZACHEN DI INCOQRMALION ORALCI
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NDerlvar una liota do los datos que asrén almacenados en éndl
aimacén de Jdatos, la lista puede afinarses revisando los datos

de entradafuallda al nlatoma y doterminando que rspressnta
Cada dalo,

Revisar lo que el andlisis entlidad-relacifn pueda decirme
acerca de la estructura de los datos. Obtener las Entidades y
Crear un diagrama con las entidades que se han definido,
después buscar las relaciones existentes entre las antidades
Yy dibujar lineas que nmuestren estas relaciones.

Por cada par de entidades se tiene una relacién entre sus
elementos, la relacién puede ser uno a une, muchos a uno o
muchos a muchos., Estos diagramas nos dan mucha informacién
acerca del sistema, mostrindonos todas las relaciones qua
existen entre las entidades involucradas (ver figura 1.1.2).

’
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Figura 1.1,2 Todas las relaciones
identificables entre entldades
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4.- Emplear la informacién de los datos para describir un modelo
que haga una liga entre dos tablas bidimensionales., Las tablas
deberdn estar normalizadas.

5.- Redibujar ¢) DFD para reflejar una vista mis precisa del
sistema de datos com. +esultado del anilisis del modelo
entidad-relaciéon y de la normalizacién. :

6.~ Particionar este modelo l6gico de procesos y datos dentro de
unidades e procelimientos, separar los procedimientos que
Poedan ner o becutadon mananl o avtomdticamente.

1.7
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7.- Especificar el detalle de cada unidad de procedimiento que se
requiere para implementar el sistema: FExtraer la unidad del
DFD y mostrar donde queda dentro del sistema, detallar las
tablas accesadas por esa unidad, mostrar un esquema  do
pantallas y reporton invelucradaa en ba unidad y dotallar 1a
légica y los procedimientos gue seran implementados.

Una vez definidos los procedimientos se puede decidlr si seri
un prototipo o se debe implementar directamente en algdin lenguaje.

Los pasos 6 y 7 no sopn estrictamente hablando un modelado
16gico dado que tratan de convertir el modelo l6gico en modelo
fisico, sin embargo son parte del flujo natural a través del
proceso que comienza en la definicién de sistema y termlna con el
disefo fisico.

Método Entidad-Relaciédn

Es una metodologla estructurada gque puede .istemdticamente
convertir los requerimientos del usuario en una hase de datos bien
difefada. No es propiamente una metodologia sino una aproximacidn.
Este método se basa en lo siguiente:
- Desarrollar un diagrama entidad-relaciédn {ERD Entity Relational

Diagram). Este paso identifica Entidades , Relaciones y atributos
asociados ademds de la llave primaria de cada tipo de entidad.

DEPRRIANCNID ENPLENDD | e provrcro
¢ s N
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Figura 1.1.3
Diagrama Entidad Relacidn
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Una entidad es upa cosa, un concepto, una organizacién o un
evento de interés para la organizacitn qus se esatis modelando, Una
Entldad ‘Flpo es una clasltficacién de entldades que satisfacen
ciarton critorios. Una relaclon os una Interacoién entre entidades.
Unn relaclén tipo ¢u una claslficaclén de relaciones basada en
cierto criterio. Usualmente los sustantivos corresponden a las
entidades mientras que los verbos corresponden a las relaciones.

El siguiente paso es ldentificar la cardinalidad de los tipos
de relaciones, es decir con cuantos elementos de una entidad B se
puede relaclonar un elementc de una entidad A y visceversa. Se
identifican después las propledades (atrlibutos) de cada Entidad-
Relacién y se expresaran grificamente con circulos (o ellipses). Las
llaves primarias son identificadas con un doble circulo.

= Convertir los diagramas entidad-relacién en archivos
convencionales y estructuras de bases de datos. Existe un
conjunto de reglas para hacer esto. .

i

- Desarrollar los programas de aplicacién basados en los
archivos y estructuras de la bhase de datos. 51 se esti usando
un Sistema Manejador de Bases de Datos (DBMS) ‘'es posible
escribir en este momentc un programa en SQL (System Query
Language) para expresar la consulta a los datos.

Fl modelado Fntidad-Relacién puede ser usado ho 86lo como una

herramienta de disefio sino como la base para el modelado en
sistemas manejadores de bases de datos.

Método Yourdon

El métode Yourdon es una coleccién genérica de ideas de ingenleria

de software desarrolladas por muchas perscnas guienes han trabajado
para la compafia Yourdon. Las ideas de todas estas personas se
reunieron y se les di6 el nombre de técpicas estructuradas:
programacién  estructurada, disefio estructurado, y analisis
estructurado, con esto Fd Yourdon intenta enlazar su metodologla a
las demAs etapas del proceso de desarrollo de un slstema, para
crear una metodologia que compita con los métodos que af cubren
completamente el ciclo de vida de un sistema, es decir, los métodos
que inician con la etapa de estrategia y andlisis, disefo légico y
fisico hasta la implementaclién, transiciédn y produccién.
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Debido a 1a continua influencia dm nuevas ldeas de gente
nueva, el método Yourdon est& en contlnuo desarrollo, de tal forma
que actualmente el método Yourdon ea muy diferentae del de hace 10
afo#t, ahora 8e han iIncorporado las mejores ldeas de disefo

orientado a objetos y de andlisis.

Este método consta de dos partes: herramientas y técnicas, Las
herramientas son una variedad de diagramsas grificos usados para
modelar los requerimlentos y la arquitectura de un sistema de
informacién. El maés familiar de estos diagramas es el diagrama de
flujo de datos (DFD), este diagrama ha sido extendido para soportar
sistemas de tiempo-real. Los DFD incluyen control de flujo vy
control de procesos (ver figura !.1.4).

Este método incluye ademds diagramas entidad-relacidén {ERD’S)
y diagramas de transiclén de estados (S51D’'s $State ‘Transition
Diagram3a). Para terminar de definir los requerimientus de un
sistema pueden emplearse las cartas de estructura para mostrar la
organizacién de les méddulos que serdn implementados,

fara complementar la descripcién del ..stema es necesario un
soporte textual adicional, un diccionario de datos que nos describa
c6émo est& compuesto cada elemento y un conjunto de especificaciones
de procesos que nos describa el comportamiento de los procesos en
cada nivel.

La técnica del método Yourdon consta de guias que nos llevan
de la nada a un modelo del sistema bien organizado. Esta técnica
consiste en particionar (top-down}) el sistema en funciones.
Actualmente el método usa una técnica conocida como particién de
eventos, inicia dibujando un diagrama de contexto el cual permite
definir los alcances del sistema y las interfaces con fuentes
externas. Después de las entrevistas al usuiario se escriben una
serie de eventos que ocurren en el madio ambiente externo y a las
cuales el sistema responde, esto nos permite dibujar un primer
diagrama de flujo de datos, Por ejemplo, Si un sistema consta de
100 eventos tendrd 100 burbujas en el DFD, dJdado lo anterior es
posible particionar los eventos en varios y unirles en un solo
proceso, esta técnica es parecida al discio orientado a objetos.

El Disefo Estructurado Yourdon consta de 4 pasos:

1.- Diagramas de Flujo e Datos
Muestra los  sistemas comao un o conjunbo  de prooesog gque
tranaforman diatos, Los diagramas de (lujo de daton pon moestran
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relacién entre los procesos y el flujo de informacién entre ellos,
Los requerimientos en tiempo real son mostrados en los Diagramas de
Flujo de datos via el control de flujo y el control de procesos,
tas comportamientoa dapendientes del tiempo son mostradoa con
L 1
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mode lados de una forma simple en moudelog de cht ddad,
2.- Cartas de Estructura

Las carta de estructura son una Jerarqulia de unidades
procedurales que documentan el control del programa, el flujo de
informacién entre programas y la logica del programa. Se emplean
las técnicas de Andlisis de Transtormacién y de Anélisis de
Transaccién.

i.- Evaluacibén del bDisefo

Fn este paso se mide la calidad del disefo, para ello son
empleados los criterios de acoplamiento y cohesién.

4.- Preparacién para la Implementacién.

La légica disefada del programa es empaquetada en unidades de
implementacién f!uica, llamadas unidades de carga.

Método de Ingenleria de Informacidén (I1ENM)

El método de Ingenierfa de Informacién sigue un enfogque top-down,
desarrollando modelos en cada una de las etapas del ciclo de vida
que cubre (estrategia, andlisls y disefo), forzando el desarrolle
de sistemas al manejo de metas y planes de estrategias.

I[EM ofrece wmodelos de alto nivel para la representacidn total
de una empresa durante la etapa de estrategia y diagramas de
estructura de datos detallados (entidades, relaciones, atributos),
descomposicién funcional, flujo de datos y diagramas de
dependencia, y definicién de reportes y pantallas durante el
*andlisis de las necesidades de la empresa". Diagramas mostrando
detalladamente la l6gica del programa, incluyendo el manejo
procedural y criterios de seleccién durante subsecuentes disefos y
construcciones de sistemas. Matrices para el mapec de las
especificaciones del anilisis y del disefio, para el mahejo de
metas, conjuntando los rcaquerimientoa de datos y procesos, vy
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asegurando una terminacldén e integracién de éstos- a nlvel de
apilicacion.

HAlala etaraa

Lemarco es un método de andlisis estructurade orlentado a procesos.
Es utilizado para definir los requerimientos de un sistema en las
etapas de andlisis y disefio. Durante la etapa de andlisis, DeMarco
obtiene todo el conjunto de informaclén manejada por los procesos
actuales y los nuevos requerimientos de é&sta y loa utiliza para
obtener la descripcién de la funcionaljdad del slstema a construlr.
Utiliza diagramas de flujo de datos como técnica de representaclién.
Pasos que sigue:

.

1.- Construir el modeleo fisico actual (DFDs).

|
2.- A partir del modelo €isico, construir el modelo légico actual
-{DFDs) .

1.- Construir el modelo 1é6gico del nuevo sistema a desarrollar
incluyendo OFnDs, definiciones del diccionario de datos, y
especlficacionea de los nuevos procesos.

4.~ Crear una familia de nuevos modelos flsicos (DFD}.
§.- Obtener el costo y tiempos estimados para cada modelo.

6.- Seleccionar el modelo mids adecuado.
Hétodo Jackson

Jackson es una técnica de dlseflo orientada a datos, la cua)l se baaa
en las estructuras de datos requeridas para obtener la estructura
de los procesos. Empieza asumiendo que la etapa de anAdlisis ha sido
terminada. ’ .

En este método el sistema es visto como’ un conjunto de
procesos, los cuales se adecuan al manejo de laas estructuras de
datos, las cuales se consideran estdticas. Utiliza bisicamente dos
técnicas de dlagramacion: diagramas de redes, en loa cuales ae
muestra el tlujo de informaciébn a través de los procescs, y

.
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diagramas arborescentes, en los cuales se muestran las relaciones
jerdrquicas entre procesos y datos. :

Pasos que Slgue.

1.- Dlbujar lea diagramas de estructura ¢de drbol mostrando cl
flujo de datos entre cada proceso,

2.- Tomar todas laa estructuras .anteriores y formar un solo
programa.

3.- Mostrar las operaciones necesarias para obtener la informacién
de salida de la informacién de entrada y asignar cada una de
éstas a los componentes del programa {(procesos).,

4.~ Transcribir el programa a un texto estructurado, aqreqanido
tanto l6gica de seleccién como ciclos,

CAS E*Mathod

CASE*Method es una metodoleogia gue quia 105 proyectos hasta su
terminacién, a través de la aplicaci6on de técnicas rigurosas para
el desarrollo de sistemas. CASEAMethod permite aprovechar los
beneficios de 1la tecnologia CASE dando un marco de trabajo
estructurado para guiar y controlar el desarrolle productivo a
través de todo el ciclo de vida.

Esta Metodologia abarca el andlisis estratégicoe, andlisis
detallado y disefio relacional de sistemas, permite llevar el
control del sistema en todas las etapas de su ciclo de vida de una
manera eficiente, ordenada y con la certeza de alcanzar los
objetivos del sistema. :

Durante las etapas de estrategia y andlisis «del ciclo de
desarrollo del sistema, CASE*Method establece una comunicaci6én mas
efectiva con los usuarios a través de técnicias, entrevistas y
diagramacién. Al entender los regquerimientos de los usuarios desde
el principio, se evitan revisiones costesas posteriores durante el
desarrollo de sistemas. ‘ .

Una vez identificados los requerimientos CALEAMethod define el
camino optimo para completar estas tarens ripidamente y con
precisién, basindose en la teorla velacional y extensos controles
de calidad,
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El método CASE es un método top-down, en el la gente est$
antes rue loa documentos, a8 un método de autochequeo, la
implementacion ea Independiente de loa requerimlentos, esté
disefado para nl camblo, se implementa on forma metédica en todo
tloempoe.

CASE*Method soporta todas las etapas del ciclo de vida ide un
sistema. i

ESTRATECIA

MHALTSIS '
|

DISERO
|

[_E6HIRUCEIOH OOCUBCHIRCION
|} - {]
TRANSICTON

1
PRODUCC 108

Figura 1.1.5
CASE*Methaod Enfoque estructurado
para el desarrollo de sistemas

CASE*Method comienza con el principio del ciclo de “vida,
involucrando a usuarios y administradores en la especificacién de
los objetivos, requerimientos y prioridades que se necesitan para
desarrollar el sistema.

Mientras se preparan e incrementan modelos detallados, pueden
verificarse y contirmsise con los usuarlos, creande prototipos
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conceptuales del sistema compt. Lo. Utilizando el enfoque tog-down,
combinado con técnicas bottom-up para el chequeo cruzado,
CASE*Method incrementa la calidad en cada atapa.

Después de completar el anilisls, se crea el discfio flaico y
1é6qico para un desempefo y flexibllidad éptimos. La documentaclén
e ilmplementacién del aistema ocurren paralelamente, mientras ge
construyen los sistemas y se realizan pruebas de unidad. La
transicién incluye el entrenamiento dal usuario, la conversién de
datos, y las pruebas del sistema, basado en una planeacién anterior
durante el andlisis y diseho.

Etapa Estratégica
los objetivos,

- Establecer prioridades y restricciones del

negocio.

- Determinar los Modelos de Negoclo.

- Establecer el compromiso administrativo, ganado a través
de involucrar usuarios c¢lave y secciones interactivas con
retroal imentacién. -

- Realizar el plan de desarrolloc y arquitectura del sistema.

Etapa de Anfliasis

- Especificacién de los modelos detallados de la informacién
necesaria para el sistema, via los diagramas Entidad-Relacién.

- Crear los modelos de los requerimientos funcionales utilizando
técnicas de descomposicién.

- Reallzar diagramas de flujo de datos y matrices de chequeo
cruzado.

- Realizar el plan de transicién incluyendo la conversién y el
entrenamiento.

- pefinir la frontera del sistema.
Etapa de Disaiio

- Establecer la arguitectura detallada del sistema.
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- Transferir las especificacliones conceptuales a disefhos tisicos

y légicos.
- Reallzar el disefo relaclonal de bases de datos Incluyende
consldaraciones de remndimlonto y tamafio,

- De las especificaciones funcionales,

realizar el disefio da
médulos para sistema de aplicacioén. :

- Realizar el disefio para la transiclén y la arquitectura de
pruebas.

- ytilizar las matrices que llustran referencias cruzadas de los
componentes del sistema, para control de cambijos.

Etapa de Construcclén
- Creacién de la base de datos relaclonal.
- Impleméntauién de los sistemas de aplicacidn.
- Pruebas de unidad y revisiones del usuario. '
= Asequramiento de la calidad y aceptacion.
Etapa da Docu;entacién
- Documentacién del sistema.
- Material de entrepamiento, operaciones y gufas del ugunrio.
Etapa de Transicién
- Conversién de los datos.
- Ejecutar las pruebas de simulacibén paralelas.
~ Ejecutar las pruebas del sistema para verificar la
funcionalidad, rendimiento, utilidad, recuperaclén, integridad
y seguridad.
- Aceptacién del usuario.

- Convertir el sistema para que sea completamente operaclonal.




e

12
SISTIMA FARA LA AMTOMATIZACKIN DE INFORMACION DRACTL MU MITAS

Etapa de producclén
- Realizar las prucbas de integridad.

- Fjecutar los procedimlentoa de soparte y monitoreo del
slstema.

- Registro de los requerimientos.
- Ccambio en los procedimientos de control.

- Reallzar revisiones regulares.

ANALISIS COMPARATIVO DE LAS METODOLOGIAHE DE DESARROLLO

Método Warnlerjforr (DSBSD)

-1
DSSD es un método enfocado a datos el cual contempla dnicamente la
etapa de disehfo. Deriva las estructuras del programa de las
estructuras de los datos siguiendo una estrateqgia bottom-up, pone
atencién en las salidas requeridas para obtener las estructuras del
programa y las estructuras de los datos de entrada.

Pasos que sigue:

1.- Fase de planeacidn del proyecto: un plan de proyecto es
desarrollado, conjuntando las metas de la empresa con un
sistema particular de objetivos en un nivel de disefo l6gico.

2.- Fase de definicién de requerimientos: se definen en un nivel
16gico y después en uno fisico los requerimientos de usuarios
y sistema, ademis de las necesidades de hardware. Se
desarrollan diagramas de entidades (Diagramas de Flujo de
Datos) describiendo las entidades y las transacciones due
pasan a través de ellas. Las salidas de los procesos son
mostrados utilizando diagramas de Warnier-Orr y un diccionario
de datos.

3.- Fase de disefo: Se hace un disefo 16gico de la base de datos

normalizada y un disefo légico de procesos, pasando desputs
al disefio fisico. ’
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Vantajas

- Ofreca a lon disefAndorea pasos sencillos a saguir, usando una

sola técnica e diagramacién desdo el principlo hasta ol
final.

- Warnier/0rr es bueno para siz..nas pequefios orientados a
reportes.

Desventajas

- DSSD wutiliza las salidas del sistema para . obtener los
requerimientos del mismo. Esta estrategia bottom-up puede
causar un manejo incompleto o redundante tanto de datos como
de procesoas.

- DSSD s6lo puede contemplar estructuras de datos Jjerdrquicas,
por lo que no se puede utilizar en el dlsefio de bases de datos
relacionaltes ni distribuidas.

Hétodo de Gane and Barson

Gane and Sarson es un método bottom-up que contempla solamente las
etapas de andlisis y disefo.

Pasos que sigue:
1.- Construir el modelo légico del sistema actual (DFDs).

2.- Construir el modelo 1l6gico del sistema a desarrollar
incluyendo  especificaciones estructuradas (DFDs8) , un
dicclonario de dates y la nueva especificaclén de los
procesos. :

3.- Realizar un andlisis entidad-relaci6n.

4.~ Disedar las tablas de la base de datos que soporten al disefo
légico.

5.- Crear un nuevo modelo fisico del sistema que consiste en
redibujar el DFD para que muestre de una forma wmas precisa los
datos del sistema como resultado del anAdliais entidad-relacién
y de la normalizacion,
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6.- Dividir e] DFD en un conjunto de procesos.

7.~ Especificar los detalles de implementacién de cada uno de los
procesos.

Ventajas

~ Las convenciones que se utilizan para los diagramas de flujo
de datos son las mids rigurosas de todos los métodos.

- Los diagramas son fiAciles da entender ya que s6lo constan de
cuatro simbolos.

Deaventajas

~ FE5 un método en el que puede omitir el andlisis conceptual ya
que empieza com una vista légica del sistema existente con lo
que no se podria satisfacer completamente las necesidades de
los usuarios.
)
- Tiene un alcance limitado, ya que contempla de forma
inadecuada las etapas siguientes a la etapa de disefo.

Método Yourdon

El Disefio estructurado Yourdon es un método que cubre la etapa del
diseffio durante el ciclo de vida de una sistema, fue desarrollado
por Ed Yourdon a principios de los 70's. Es altamente recomendado
para soluciones basadas en lenguajes de tercera generacién y se
enfoca al disefo de sistemas en tiempo real.

A finales de 1988 una revista de software publicéd que el 30.2%
de las empresas en Estados Unidos {la mayoria de goblerno, con
necesidades de tiempo-real} emplean para el desarrollo de sus
proyectos el método Yourdon, mientras gue el 29.2% (la mayoria
empresas comerciales) emplean métodos top-down.

Fl método Yourdon examina los sistemas actuales, obteniendo
nuevas soluciones de los viejos sistemas. Este método es capaz de
obtener solucliones para las necesidades de defensa y en general de
cualquiera aplicacién en tiempo-real.

Yourdon estAd hbien adaptado para la etapa de disefo de los

sisteman que requieren de procesamiento en tiempo real y se

1.20

—t—

ASHEMA PARA 1A AUIOMALIZAUION 1 INIDEMACKIN URACLE WETOD01L,00AS

anadlisis extensa. Este método puede
con solamente una’ légica

requiere de una etapas de
diclgir una funcionalidad complela
procedural limitada (IGL).

vanta jan

- Es ideal para aplicaciones de tlempo real.

- Tiene un diccionario de datos para la captura de detalles
tales como atributos e identificadores dnicos.

- Ho depende de los datos, dade que se concentra en la légica
para los programas.

.
- Yourdon es lo mejor para sistemas peguefios con requerimientos
de procesamiento procedural y sistema de archivos simple,

Desventajas
- No ofrece una técnica propla para el modelado de entidades o

disefo de datos, pero recomienda el uso de la técnica Chen de
Entidad Relacion.

| FiF1 (A6 i'* tRiece >—| ((FRILENTO

Entidad

Fiqura 1.1.6 Modelo

Relacién de Chen

Esta técniva es muy superficial ya gue no nos da mucha
informacién acerca de las relaciones entre entidades. Esta forma de
representacidén no es muy rigurosa y la normalizacién es imposible.

- Ho se crea un madelo de requerimientos de . informacién
conceptual,
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- Sus diagramas no se prestan para deacribir log requerimientos
de] sistema, éstos son vistos Gnicamente come un mecanismo de
procesos antlcipados del sistema.

- Ho estd disefiado para alternatlvas fulburas, sus DFD's no estdn
bien relacionados con las otras técnicas empleadas por
Yourdon. No es posible saber en esta representacién, donde
toma lugar el proceso dentro de la organizacién. Yourdon no
define el alcance de cada dlagrama de flujo de datos.

- Es un conjunto de té&cnicas que no est#n bien acopladas. Las
cartas de Estructura no corresponden a' los Diagrams Entidad-
Relacidétn. No hay funciones que verifiquen el modelo de datos
ni es posible verificar la légica funcional del programa.

- El alcance limitado de Yourdon es su mayor desventaja ya que
pasa por alto la etapa de anilisis y posteriormente las etapas
de desarrclle y se concentra en el diseio de programas
procedurales.

Matodo de Ingenieria de Informacidén (IEM}

El método de Ingenierfa de Informacién cubre las etapas de
estrategia, anAdlisis y diseno del ciclo de vida de un sistema.

TEM ofrece diagramas de estructura de datos detallados
(entidades, relaciones, atributos), descomposici6én funcional, flujo
de datos y diagramas de dependencia, y definicifbn de veportes y
pantalias.

Ventajas

- Es un método que no estd enfocado a procesos ni a datos,
obtiene los requerimlentos de informacién en un contexto
balanceado entre neceaidades de usuario y planes estratéqgicos.,

- Los prototipos de entidades y modelado de funciones son hechas
en conjuncién con el usuario, para asecgurar la satisfaccion de
éste., .
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pesventajas
cumontacién,
- [FM no contempln el entrenamlento a uaunrlos, iﬂmtrucClﬁﬂ ¥y
ni dlsefo en tiempo roal. Lag etapas de €©
producctén aon Lratadaa an forma minime.

- Los modelos de IEM son dificiles de leer.

Método DaMarco

a procesos.
peMarco es un método de ansdlisis estructurado qrtc"tﬁ?Zélgnente-en
Al igual que el métode Gane and Sarson es utilizac )
las etapas de andlisis y disepo.
ventajas
e sistemas ya

- DeMarco empieza el andlisis utilizando lnsdjsehadores a
existentes, lo cual ayuda a los analistas Yy
tener un punto de inicio. )

L cyicdad.
- El modelado del sistema es iniciado con facilida

Dasventajas

. djseho.

- peMarco s6lo contempla las etapas de andlisis Y

Jischa el nuevo
ya existente,
Jos nueavos

- Tiene un enfoque bottom-up, en el cual S©
sistema tomando las especificaciones de.‘"‘ode
teniendo como problema la posible pérdida
requerimientos.

H&todo Jackson

cual se basa
Jackson eS una técnica de disefo orientada a datos;rlﬂa estructura
en las estructuras de datos requeridas para obtﬁ"“to de procesos.
de los procesos, el sistema es visto como un CO“}zn. diagramag de
ytiliza basicamente dos técnicas de diagramaclon: ‘
redes y diagramas arborescentes.

Ventajas
n proqramacién.

. ; n
= Fu utll cuamlo se Ulenen peopniivg necamnidadon
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- Es capaz de contemplar requerimientos tanto a nivel sistema
como a nivel proceso (mbdulo).

Desventajna

- EkEsta 1llmitado al manelo secuenclal de reqgistros y al
procesamiento en batch por lo que lgnora la tecnologla de
bases de datos.

- Solo contempla la etapa de diseio.
CASE*Method

CASE*Method el un método que contempla todas las etapas del ciclo
da vida. Hediante la utilizacién de este método se pueden conocer
las necesidades de los usuarios, sin que éstas tengan que ser
especificadas por sistemas existentes. Utiliza técnicas bottom-up
como hprramienta para asegurar la exactitud y terminaclién de una
tarea. .

Ventajas

- CASE*Method es flexible, ya que se puede adaptar con facllidad
a proyectos de cualquier tamafio y complejidad.

- Enfatiza la wutilizacién de referencias cruzadas con el
propésito de detectar posibles errores, usando para elleo
matrices y diagramas de flujo de datos durante las etapas de
andlisis y disebo, -

- Utiliza entidades conceptuales y el modelado de funciones para
mostrar los requerimientos esenciales de la empresa, lo gque se
traduce a un disefo Sin errores, es decir, se puede saber
desde un inicio si el sistema va a satisfacer completamente
las necesidades del usuario.

- Soporta el manejo de prototipos de interfaces con el usuario
(pantallas, reportes, etc) durante las etapas de disefio y
construccién. .

~ Sus técnicas de diagramacitn son faciles de wutilizar vy
enbender.
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- Ofrece sugerencias para la elaboraclén de documentaciédn del
osistemn.

Desventajas

- Ho se puede aplicar el desarrollo de sistemas de tle;po rea).

- Necesita de una técnlca para especificar a detalle el disefo
de los médulos.

Observaciones Finalas

!
Después del estudio y andlisis comparativo de diversas metodologlias
de desarrollo de sistemas, hemos podido ohservar que existen una
gran diversidad de métodos para el desarrollo de sistemasn.

5in embargo y de acuerdo al estudio realizado, se observa que
algunas metodologias ya han quedado ohbsoletas, pues se enfocan al
desarrollo en lenguajes de tercera generacién o blen son para
sistemas de base de datos jerdrquicas, muchas de éstas metodologlias
cubren sb6lc una parte del ciclo de vida de un sistema, es decir son
incompletas, la mayoria de ellas se enfocan al disefo haciendo'a un
lado una de las partes mids importantes como lo es el anflisis.
Algunos métodos emplean para sus modelos diagramas que son muy
dificlles de entender, por lo cual se requlere de un entrenamiento
especial para aplicarlos, otros métodos por el contrario emplean
diagramas tan simples que por lo mismo dichos diagramas resultan
incompletos.

Por otro lado basamos en la tendencia actual del mercado de
Software hemos encontrado lo siguiente: una revista de Softwarae
publicé gue hay un interés creclente en los métodos de ciclo de

“vida completo y top-down. De la misma manera en que la programacién

estructurada reemplazd al cébdigoe no estructurado de los 70’'s asi
también en los B0's se muestra una adopcién gradual de las técnicas
estructuradas que cubren completamente el ciclo de vida de un
sistema.

Las caracteristicas del sistema que se desea |mplantar, se
adaptan completamente a un modelo de bases de datos relacional y
hemos podido observar con el estudio de las metodologlias, que
muchas ¢e ellas no fueron pensadas para este tipo de
implementacibn.
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T

Se necesita implantar un sisitema de informacién compartida,
gque sea sencille de aprender por los usuarios finales y que incluya
una documentacién adecuada, ademis de que contemple modificaciones
futuras conforme la empresa crezca.

Para el caso de estudic 3¢ esta tesis se necesita un sistema

de bases de datos relacional y se emplear4 para ecte desarrollo los.

productos basados en la metodologia CASE.

El Método de Desarrollo de Sistemans CABE*Method, es uia
metodologla completa y moderna @nfocada a la Cecnologla de hases de
dates relacional que cubre completamente el ciclo de vida de un
sistema, nos brinda una estrategia de planeacién de sistemas de muy
alto nivel, nos permite realizar un andlisis detzllado del sistema.
Cuenta con técnicas de referancia cruzada que aseguran gque el
modelo sea completo y exacto. Sus DFD's son mis rigurosos que otros
métodos. Se basa en 'la comunicacifn entre usuarios ¥y
desarrolladores en el disefio de aplicaciones de 4a. generacién y
estados de post-diseio.

El método CASE es un métode TOP-DOWN, es un método de
autochegqueo, la implementacién es independiente de los
requerimientos - tanto de hardware como de software, estid disefiado
para el cambio, se implementa en forma metddica en todo tiempo.
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INTRODUCTION

Welcome to EasyCASE Plus

Welcome to EasyCASE Plus version 3.1, a powerful yet casy-lo-use, casy-to-lcamn
Computer Aidcd Software Engineering (CASE) tool. EasyCASE Plusis a
graphical software cavironment designed to make the sofiware development
process more efficient and consistent. EasyCASE Plus features a consistent,
industry standard IBM SAA/CUA compliant graphical user interface (GUI),
similar in appearance and usage to the Microsoft Windows and OS/2 user
interfaces, and a dBASE 11 Plus compatible data dictionary.

You can usc FasyCASE Plus to perform structurcd analysis, structured design,
and data and information modeling, EasyCASE Plus supports the following types
of diagrams:

Data flow diagrams {DFDs)
Transformation graphs (TRGs)
Stalc transition diagrams (STDs)
Structure charts (STCs)

Entity relationship diagrams (ERDs)
Data structure diagrams (DSDs)
Data model diagrams (DMDs)
Entity life history diagrams (ELHs)

Logical data structure diagrams (LDSs)
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With EasyCASE Plus you can create charts according to these methodologics:

» Yourdon/DeMarco

s  Ganc & Sarson

= SSADM versions 3 and 4

s Ward & Mellor

= Hatley-Pirbbai

= Yourdon/Constantine

u Chen

s Martin

» Jackson

=« Bachman

= Elmasri & Navalhc

= Shlacr & Mellor .

Why Use EasyCASE Plus?

EasyCASE Plus automates the analysis and design p_ba.sc of your project’s
developmeat, eliminating some of the more mechanical, repetitive tasks so you
can focus on design logic and conecpls. EasyCASE Plus also prqwdcs support for
real-time systéms development and data and information modeling.

EasyCASE I"lus 3,1, with its casy-to-use graphical user 'mlcrfactf, mak.es it casy to
sclect and manipulate abjects oo charts. The pulldown menus give quick access Lo
commands without having to guess at, or remember, command names. Thc scrotl
bars enable you to access portions of the chart that are not currently visible. The
dialog boxes allow you to sclect options, enter information, etc.
'i'hc intcgrated dBASE 111 Plus format data dictionary makcs.il possiblc‘lo )
athicve a high level of consistency, because once you've described an object in the

- data dictionary, you can reuse the object, plus any relationships it may have, over
and over, on the same or different diagram types.

** EasyCASE Plus Verslon 3.1 Beglnner's Tutorlal

You can link objccts and charts in a hicrarchy to provide functional
decomposilion. Once the abjects or charts are linked, you can casily move back
and forth between the various tevels, You can alsa link text fifes to objects, and
edit them using your preferred fext editor, In addition, you can link chart objects
tes records, elementa, snd control tablea ta define data structures. '

EasyCASE Plus lets you document your system as you proceed with the design,
You can access text files, export diagrams into a word processor or desktop
publishing program, export the data dictionary to a database, create and print
reports and output the charts directly to a printer, plotier, or file.

How EasyCASE Plus Works ,

You use the chart editor (FASY CASE.EXE) ta create, save, load, modify, and
priat charts. You describe objects oo charts to the dala dictionary from within the
chart editor, and link the charts {and the objects on them) with other charts to
create a hicrarchical sysiem of diagrams. The chart editor is completely
integrated with other parts of the product. You can access the other portions of
the product via the Utility meou, You can also access other cxternal programs
(such as your word processor or database) via the Utility meou.

Yau usc the Data Dictionary and Reporis Manager (DDRM.EXE}) to add,
modify, delete, copy, and rename dictionary entries. You can also browse data
dictionary entrics, export and imporl enlries, and pack and sort the dictionary.
You can also merge data dictionarics from other projecis and/or other users.
You can also print predefined chart and data diclionary reporis to check the
consistency and logic of your work.

|
|
I
|
The Analysis Manager (ANALYZE EXE) is an optional, add-on module, ‘
included with EasyCASE Professional and the EasyCASE Plus Developer's 1
Edition, that you usc to verily the consistency and logic of your charts and data E
dictionary, and to print chart verification and leve) balancing reports.

The Schema Geaerator (SCHEMA . EXE) is an optional, add-on module,

included with the EasyCASE Plus Developer's Edition, that allows you to

produce database schemas in dBASE and/for SQL format, from catity

relationship diagrams and the data dictionary.

All parts of EasyCASE Plus are integrated and accessible from other parts of the
program. You can also access any of the modules directly from the DOS prompt.

|
EasyCASE Plus Version 3.1 Beginners Tutorial
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About This Tutorial . To get sianted, you should use thesc items in the following order:
. ‘ 1. The first thing you should do is to install the EasyCASE Plus softwarc on
i This tutorial provides basic information on using the product, enables you to your PC. Rexd Lhe Installation Guide fiest, and follow the dircctions to

practice with it, and gives you hints and suggestions on how Lo procced wil!r your install the software,
own work. 1t is designed 10 help you get (amilinr with EasyCASE Plus and ils .

isai inni | little or
most I'rC'!l-lcntly }::leg:;csnéu:;;‘lﬁlt|I:;;:1§cﬂ§1t‘hacl[lc)::::l;gllac:zary\:J::;:z[I ct NOTE: If you want to use this tutorial, you nced 1o install the Sample Project
no expericnee wi .

this book and Chapter 2 of the Chart Editor User's Guide.

: . . files,

: structured analysis, design, and data modeling techniques or methods. €5

2 Rcad this tutorial and go through the practices and lessons to learn the
With EasyCASE Plus, you will find there are sometimes several ways to complslc basics about the product and to become Familiar with how the menus,

: 4 task. This book does not contain complete details on everything you can do with commands, and chart editor work.

P EasyCASE Plus. See the Chart Editor User's Guide for more information on the
tasks you practice here. 3. 0[:10? you are familia!i‘;vilh the prod}:cl, you will know wl;ich commands
and features you would like more information about, Refer to the other
For a comprchensive tutorial about the usage of the chart editor to create an documentation to gt camplete information about EasyCASE Plus.
ERD and populate the data dictionary with database structure deflinitions, plTnsc )
N . 3 's Gui ial wil

B refer to Appendix 1 of the Schema Generator User's Guide. That tutonia ) It . J it 4 L i  Eas SE

H . . ERD and t you arc an expericnced user and have used previous versions o yCA.
i take you through the process of d;:;i?g 2 d;!sa(l;::‘sc::::a:n and (hen using Plus, read the Upgrade chapter in the Installation Guide for information on what
| the Schema Generator to create an $ ’ has changed and how to upgrade your prior version projects. 1f you want to
t become familiar with the new EasyCASE Plus interface, go through Lesson 1 in
: The EasyCASE Plus Package

The EasyCASE Plus package includes the following items: How To Use This Tutorial

i + = Chart Editor User's Guide 1 This tutorial is organized so that you start by learning basic tasks and skills, and

Iastallation Guid . . then advance 1o more complex pracedures.
» lostaliation Guide

» This Introduction provides information about this and the other manuals in

= This Beginner's Tutorial the EasyCASE Plus package.

; « Data Dictionary and Reports Manager (DDRM) User Guide = The Basic Tutorial (Lessons 1 to 4) contains :mfurmalion on starting

EasyCASE Plus and using menus, commands, and dialog boxes; plus guided
practices in scrolling, creatiag a chart, modifying it, options, printing, and
saving. :

i - = Methodology Guide

¢ EasyCASE Plus disk pack with registration curid

= The Intermediate Tutorial (Lessons § and 6) contains information on
identifying objects by accessing the data dictionary, and on linking objects to
other charts, text files, records and elements.

. »  Analysis Manager User Reference (if you purchased EasyCASE Professional)

»  Schema Generator User's Guide (if you purchased EasyCASE Plus

Deveioper's Edition) For cach lesson, you will sce a short description of what is to be covered in the

lesson. Next, the steps for the lesson are lisied. Al the end of each lesson arc

EasyCASE Plus Version 3.1 Beginners Tutorial EasyCASE Plus Verslon 3.1 Beginner's Tutorlal
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suggestions, alternatives, and extra information that you can try when you do your Drag. You move the objects on a chart with the mouse. To move an objedt, scledt
~own work, the object, then press and hold dawn the lelt mouse button until the mouse cursor

‘ : turns into a hand icon, Use the mousc to maove the object to the desired position
Symbols and Conventions on the chart. Release the mouse button to place the object. The same process

applics to dragging seleclion boxes around.

To help you locate information easily, these symbols and conventions are used

throughout the Tutorial: Enter. You enter information. To enter something, you type the information then
press the BENTER key.

» Examples of what you should type appear as;

E

CD \ECPLUS ‘

Caacel. To cancel a command or operation, press the ESC key.

Tutorial Files

= Information you should nole appears as:

There are Tutorial files in' the Samples subdirectory that you will necd to access

= NOTE: Important or supporting information looks like this. for these lessons. These files are:

» Keynames appcar in small capital letters: ESC, s ECPCONTX.DFD

. Kcys that should bc presscd at the same time appear with + bclwccn them:
CTRL+35.

s MODIFYDFD .
Basic Skills T i -
= Bulleted lists (such as this onc) give you information or choices. i s Tutorial :

The Basic Skills section of the Tutoriat introduces th
e Numbered lists indicate pr ural steps. ¢ Basic ton of the Tutorial introduces the EasyCASE Plus user

. interface and the fundamental skills you will need. The lessons are as follows: :

i 4 .

Terminology . Lesson 1 Starting to Use EasyCASE Plus
Throughout the Tutoria! these terms are used consistently to indicate operations: Lesson 2 Creating a Chart . i
Cllck. You click the mouse by pressing and releasing a mouse button. To sclect Lesson 3 Modifying a Chart '
an object you would click the left mouse button while the mouse pointer is over ‘ ‘
the object. Lesson 4 Other Chart File Operations ,

Double Click. You press and release the left mouse button twice in quick

The material in each lesson builds on what you bave learned in preceding lessons.
suceession,

) Intermediate Skills Tutorial
Select. You sclect commands and objects on a chart. When you sclect a menu or :

dialog box command, an operation is exccuted. When you sclect an object or
group of objects on a chant, the object or objects is/are ready for a subsequent
operation, and EasyCASE Plus performs the next command you select on the

lected object(s). To select a command or object, position the mouse pointer
over it and then press and release {click) the left mouse button.

The Intermediate Skills section of the Tutorial takes you through idcntifying.cha.rt
objects, describing them to the data dictionary, and linking them to other objects
as follows:

EasyCASE Plus Verslon 3.1 Beginnars Tutarlal
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Lesson § Interacting With The Data Dictionary

Lesson 6 Linking Chart Objects via the Data Dictionary

The material in cach lesson builds on what you have learned in preceding lessons,

Schema Generator Tutorial

The Schema Generator Tutorial is provided in the Schema Generator User's
Guide and takes you through the design of a samplc database, It familiarizes you
with creating an Entity Relationship Diagram (ERD), interacting with the dta
dictionary, linking chart objects to records, and defining databases using Records
and Elements. It also covers the gencration of SQL and dBASE I1I databasc
schemas using the schema generator product.

EasyCASE Plus Version 3.1 Beginner's Tutorial

LESSON1
STARTING TO USE EASYCASE PLUS

Overview
This lesson covers:
» Running EasyCASE Plus and loading a sample chart
s Choosing commands from the pull-down menus

» Choosing oplions and supplying information via pop-np dialog boxes

» Sclecting chart objects using the mouse

« Scrolling and zooming to vary the display of the chart in the chart window

s  Buxiting EasyCASE Plus

Before you start this lesson, you should have already installed EasyCASE Plus. If
you have not, see Chapters 1 and 2 of the Installation Guide for information on
how to do this,

NOTE: Kecp in mind that EasyCASE Plus s designed to be very flexible, and

that there are often many ways to accomplish your task. At the cnd of cach
lesson, you'll find information about alternative procedures.

This tesson should tuke you about 45 minutes to complete,

. Running EasyCASE Plus

You will begin EasyCASE Plus by loading a chart from a sample project that is
pravided. In the next section, you will use this chart to explore the EasyCASE
Plus user interface,

The following procedures assume you have installed EasyCASE Plus in the

default (C:A\ECPLUS31) directory on your hard drive, and the sample project in
the SAMPLES subdirectory, If you have installed the product into a different

EasyCASE Plus Verslon 3.1 Beginner's Tutorlal
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directory than the default, substitute the names of the dircctorics you have
crcated for \ECPLUS31 and SAMPLES,

To start EasyCASE Plus:
1. At the DOS prompt type:
CD \ECPLUS3?

to go to the directory containing EasyCASE Plus.

2 Al the EasyCASE Plus program dircctory, type:

TSRINT

This loads the memary-resident program TSRINT. It is a small utility task
switching program, enabling you to suspend the EasyCASE Plus charting
program and run EasyCASE Plus’ adjunct programs (such as the Data
Dictionary & Reports Manager), as well as external programs or DOS
commands.

3 At the EasyCASE Plus program directory, type:

EASYCASE SAMPLES ECPCONTX.DFD

1
NOTE: ECPCONTX.DFD is 3 samplc dala flow diagram used for the EasyCASE
Plus tutorial.

4. The User Name dialog is then displayed.

s. Type in your name {up to 24 characters), and click on the ‘OK’ button,

Lesson 1 Starting to Use EasyCASE Plus 11

| Enter User Name |}

User Hame

Figure 1.1 User Name Taxt Entry Box

EasyCASE Plus Verslon 3.1 Beginners Tutorlal

NOTE: If this is the first time you have run the product after installing it, you will
first be required 10 eoter your (registered uscr) name, company and product serial
number, Reler to the lnstallation Guide {or further information about how to do
this, ’

A messape indicating that the program is loading the data dictionary for the
projed is displayed. The sample data flow diagram, ECPCONTX.DFD, is then
automatically loaded aed displayed in the chart window.

For more information on ruaning EasyCASE Plus, refer 10 Chapter 3 of the
lnstallation Guide.

The EasyCASE Plus User Interface

The EasyCASE Plus user interface is designed for clecar, consistent and efficicnt
usc of commands and objects. Il you bave used other windowing applications,
(such as Microsoft Windows 3.0} you will find familiar elemeats here: pull-down
mens, icons, shorteut keys, scroll bars, and pop-up dialog baxes, ‘

Take a few minutes to familiarize yourself with the screen layout:

The sample chart that you loaded (ECPCONTX.DFD) should now be displayedi
in the chart window. This chart is larger than the chart window (8 help illustrate

somc of the display tools. For the remainder of this lesson, you will use this chart

to become accustomed to the EasyCASE Plus user interface. |

1

|
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i
5 LI
. Page 12 Lesson 1 Siarting to Use EasyCASE Plus 13
o Tils Edit_Objects View JJTTER Explode fnaluze Schema ULility flalp Drawing Grid
g. i, RS RN The drawing grid segments the chart into posilions that symbols can occupy. Bach
St By by run:"w,:_f':m" A *box on the grid can hold a symbol which is centered in that box. The chart is a 32
=] Dufault synbol alzm... by 32 grid of these hoxes. The outling of esch box is composed of linely spaced
of. Set default editer. N dots. Al other objects that you place on a churt (connections, couples, tabels and
E Calora... RitC text blocks) will "snap” (aulomatically move) to locations indicated by the more
—3 I futs flow routlng widely spaced dots.
- { Defauilt label to 1D
: Auto redraw after ed it [ Yasen. .
Pronpt for 8 arrovhaads Scroll Bars
R N S S The borizontal and vertical scroll bars make it casy to move around large
diagrams.

R Scroll Arrows. The scroll arrows move the chart one row (up and down arrows)
or column (left and right arrows) at a time. You can increase this scroll increment
to 4, 8, or 16 by using the CTRL, ALT and SHIFT keys, respectively.

a DI -
[ SN (PP S SN TR Scrall box, The Scroll box moves the position of the chart window relative to the
N N AR entire chart, when you drag it along the scroll bar.
Status Line
The Status line contains the chart offset coordinates, the curreat level number (in
1 a linked chart set), the filename, descriplive name, and type of the current chart, T

Figure 1.2 The EasyCASE Plus Chart Editor User Interface € “_ <0 the fiename, deseriplive pame, and type ©ctmente
,‘ Prompt Line
: The Chart Window The Prompt line, located below the status line, displays status and error
! . . messages, or prompts you for your next action.
i A chart contains a maximum of 32 rows and columns roughly equivalent to 6
i sheets of regutar U.S. letter size paper (3 wide by 2 high). The chart Window Redraw Icon Bution
1 displays an 8 column by 9 row section of the entire chart. '
; - This icon, located in the lower right corner of the screen, refreshes the chart
: Menu Bar window. Use this if ‘debris” has been left behind in the chart window as a result of
: ) adding, deleting, or moving chart gbjects or text, :
: The Menu bar {located at the top of the sereen) contains the ten pull-down meau
! options. These are described in more detail in a subsequent section, Quick Zoom ‘con Bution

This icon, located in the lower lelt corner of the screen, is a toggle switch that
fi:  zooms oul 10 display the full chart in the chart window when you click on it, and
£*  then returns 1o actual size when you click on it again.

:
1

|
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Explode Up and Down icon Buttons

These icons, located in the lower left corner of the screen, let you move between
wochart e ne s et et B send vonteal tibile ae elewent that it bas
been previously linked to.

Exit lcon Button

This icon, located in the upper left corner of the screen, allows you to quit the
application, You will be prompted to save the chart if any changes have been
made. You will also be prompted to save your preferred option settings.

Chart Object lcons

These icons, located down the left side of the screen, display the object types
available for the current chart type. The object types displayed here correspond to
those available in the Objects menu. You can select an object type Lo place cither
by using the Chart icoas, or from an eatry in the Objects menu.

The Menus

The ten pull-down menus located in the menu bar across the top of the screen list
all of the EasyCASE Plus commands available as follows:

s File menu commands arc for } accessing projects; loading, merging, saving and
exporting chart files; printlng; and exiting the program.

= Edit menu commands allow you to copy, move, modily, delete, label, and
identify objects within the chart window. They also allow you to select a group
of chart objects to maripulate.

= ObJects menu commands allow you o sclect symbols and connections for
placement on a chart.

»  View menu commands affect the display of the entire chart, or objects on the
chart. They also allow you to zoom in and out of areas of the chart.

= Options menu commands et you set the appearance of the user interface, and
_ the characteristics and defaulis 10 use when creating a chart and adding
objects to it.

=  Explade menu commands allow you (o move between linked objects and
charts,

EasyCASE Plus Version 3.1 Beglnner's Tutorlal
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» Analyre menu commands allow you to invoke Analysis Manager functions, if
installed, inctuding chart rule checking and level balancing. '

s Schemn pen (mnm.nmh allow you fo invoke Schema (‘cncrnlor functions, 1[
tsrallend, $aw i vitog Bty B e e e b e enine s Gens files
s Utlllty menu commands allow you to access the supporting EasyCASE Plus
programs, as well as DOS and external programs.
1
s  Help menu commands provide quick aceess information to enable you to use
EasyCASE Plus cllectively.

The individual compaonents of the user interface and how you use them are
described in Chapters 2 and 3 of the Chart Editor User's Guide, Chapter 2
deseribes how to access commands from the pull-down menus and pop-up dialog
boxes. Chapter 3 describes how to scrolf and zoom the chart using the scrollbars,

mousc and keyboard, ‘
'

Setup Chart Editor Options

Prior to beginning to work through the lessons in this tutorial, please take a
moment to make sure your chart editor options are setup exactly as follows. If
they arc not, you may not get exactly what is described in the tutorial steps.

View Menu |

Drawing grid - On ] !
Display title block Cn
Double 1 bar on ERDs On '
Directed connccts Off
Open arrowheads On
Filled arrowheads Off
Rounded corners On

Options Menu

Default # arrowheads One way single

Foant type Helvetica

Delault symbol size Normal

Auto flow routing On

Default label to 10 On

Auto redraw aller cdit Off '
Prompt for # arrowheads olf '

EasyCASE Plus Verslon 3.t Beginner's Tutordal
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Page 16
Preferences (via Options Menu)
Auto identify of
Aulo label Oft
Allow place néw label On
Auto export lo dBASE off
Auto cxport to SDF off
Auto export to HPGL off
Update label from DDE off
Flag deleted DDEs 1Ds off - »
Warning beep On
Create backup chart On
Use named charts On
Explode Menu
Show cxplosions - On
NOTE: When a menu option is On in the View or Options meny, a checkmark
appears to the leftit. For Preferences, when an option is On, an "X* appears to the
left of it.
Getting Help

Whesnever you are uncertain Zbout the use of a command or proccdurc try using
the on-ling Help facility. In many cases, you can {ind the information you nced
here much more quickly than by referring to the EasyCASE Plus Chart Editor
User's Guide,

v

To access on-line Help:
1 Click on the Help menu option or press the F1 key.

A pop-up dialog box lists the available heip topics, as shown in Figure 1.3,

EasyCASE Plus Verslon 3.1 Beglnner's Tutorlal

ADOUT THE CHART EDIIOR _ 1

CHANGE :PROJECT.

Flgure 1.3 Help Toplcs List
Click on the "Merge Chart' entry.

A text box containing the help information for merging charts is displayed
as shown in Figure 1.4, Since this information extends past the size of the
text box, you can use the scroll bar at the right of the box to scroll forward
and backward through the available help text.

Flgure 1.4 Help Screen for Merge Chart Toplc

Press the BSC key or click the right mouse bullon to remove the help text
box and return to the Help topics list.

EasyCASE Plus Verslon 3.1 Beginner's Tutoral
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4, Press the BSC key or ctick the right mouse buiton again to remave the help
topic list box, and return to the chart.

Selecting Single Objects on the Chart

When you want to move, copy, delete, modily, or label an object, you nced to first
select the object, Chart objects are:

= Symbols

» Conncctions
= Labels

= Blocks

s Text

Sclecting an object highlights it, and indicales to the chart editor that it is ready
for a subsequent editing operation.

The following scctions describe how to select a chart object. For additional
information, refer ta Chapter 5 of the Chart Editor User's Guide.

Selecting a Symbol i

Sclecting a symbol is as easy as simply clicking on it with the mouse. To sclect the
symbol labeled "EasyCASE Plus' on the chart:

1 Position the mouse poinler in the center of the symbol containing the text
label ‘EasyCASE Plus’, as shown in Figure 1.5. ’

2. Click the lcft mouse button.

The object, and the text inside it, are bighlighted and surrounded by small
boxes to indicate that it is sclected,

EasyCASE Plus Verslon 3.1 Beglnner's Tutorlal

House Positiah
fogse Fositian |

Figure 1.5 Selected a Symbol

To de-sclect the selected symbal:

Click the right mouse button, or click the left mouse button clsewhere on !

the screen (anywhere outside of the symbol).
i

The symbol is no longer sclected and the highlight and marker boxes are
removed, i

Selecting a Connection

A small box is displayed midway along the middle line segment of cach
conncction. This is the "handle® you will use ta select the connection.

To select the connection labeled 'Display Data”:

1, Position the mouse pointer over the small box located on the connection
labeled 'Display Data' as shown in Figure 1.6,

2 Click the left mouse button.

)
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The connection, and the adjacent label, are highlighted. Small boxes are
displaycd at the start, end, cornees, and mid-points of the connection Lo
indicate that it is selected, as shown in Figure 1.6.

Display Data |

Flgure 1.6 Selacted & Connection

To de-setect the connecetion:

Click the right mouse button, or click the left mouse buttan etsewhere on
the screen,

The connection is no longer selected and the highlight and marker boxes

are removed.
1

Selecting a Symbol Label

Labels can appear inside symbols, and are sclected as follows:

To select the 'Video Display symbol label:

L

2,

Position the mouse pointer over the symbal labeled 'Video Display'.
Click the lelt mouse button,
The symbol and its label are highlighted.

With the mouse pointer still pos:lmncd over the Video Display symbaol,
click the left mouse button again,

EasyCASE Plus Version 3.1 Beglnner's Tutorial
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The "Video Display label alone is highlighted and enclosed by a dashed
bounding box as shown in Figure 1.7, The I.nbcl is now sclected for a
subsequent operation.

pr

N ﬂi.deo

Difnlay.

Figure 1.7 Selecled & Symbol Label
Selecting 2 Connection Label
Labels can also appear next 10 a conncction, and are selected as follows:

To select the 'Display Data’ conncction label:

1. Position the mouse pointer anywhere over the ‘Display Data' text.
2. Click the left mouse button.

3. The 'Display Data’ fabel is highlighted and enclosed by a dashed bounding
box as shown in Figure 1.8. The label is now selected for a subsequent

operalion.
s |
D GDIEF A TRER . |
'i--;‘_"‘_—"“"%».

Figure 1.8 Selected a Flow Label
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| |
|
To dC-Sc[CC[ thc Iabcl_. ............................... : -+ n E . : .
Click the right mousc button, or click the left mouse button elsewhere on D
the chart (anywhere oulside of the label box). i Do ’
. N P R 3N reiees :
| Selecting a Data Couple TR :
! Custamer . ! R )
Data couples appear next to connections on structure charis. Before you can : Purchase . : R
: sclect a data couple you must first load a structure chart, Orden ... .. il R e

To load a structure chart;

E 1. Click on the ‘File' menu to pull it down.

2 Click on the *Change typc’ option. A list of available chart types will

appear,
3. Click on ‘Structure Chart'. A blank structure chart named
UNTITLED.STC wili appear in the chart window. “
i 4. Click on the File’ meou again to pull it down.

5. Click on the 'Load chart’ aption. A list of available structure charts will
appear.

6. Click on the "Page-Joaes Structure Chart* entry.
C 1

: 7. Click an "'OK; the chartawill load.

To select a data couple:

; L Locate the data couple 'Customer P.O. Data' on the connection between
: function symbol 1.0 Fill Customer Purchase Order®, 2nd function symbol
*1.3 Add Customer P.O. Record™. You may need to scroll the chart ane
click to the left to access it easly.

2, Position the mouse pointer over the small round base of the data couple.
3 Click the left mouse burton,
The couple and its label are highlighted and surrounded by small boxes

f . that indicate it is selected ready for a subsequent editing operation, as
: shown in Figure 1.9,
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Flgure 1.9 Selected a Data Couple

A couple tabel is selected in the same way as for a connection label by clicking on
the label text.

To return to the EasyCASE Plus Coatext Diagram, follow the instructions in
steps 1 through 6 above, but choose Data Flow Diagram (Yourdon symbol sct) in
step 3 and EasyCASE Plus Context Diagram (ECPCONTX.DFD) in step 5.

[
v
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Selecting a Group of Objects

In addition to sclecting single ubjects, you can select a number of objects tagether
a3 a group or ‘block’, Once sclected, you can then perform the standard move,
copy, delete ar save operations, just as you would for single ohjects.

To select a group of objects visible in the charl window:
1 Pasition the mouse pointer just outside the upper leit corner ot tue

external entity symbol labeled "Keyboard.

2 Press and hold down the left mouse button, The mouse pointer will‘changc
into an icon in the form of a hand with a pointing finger.

NOTE: If you accidentally click on a symbol, just press Esc, or click the right
maouse button, to cancel the operation.

3. While still holding down the left mouse button, move the poiater one grid
square down and to the right, as shown in Figurc 1.10.

A dashed box will appear; the top left corner of which is located at the
mouse pointer position when the left butlon was pressed.

3

Keyboard .

T

DR o = o ST

Figure 1.10 Drawing the Chart Oblect Group Selection Box
4, Still holding down the {eft mouse button, mave the mouse pointer down

and to the right of the symbol labeled Microsoft Mouse”. The botlom left
corner of the dashed selection box will follow the mouse pointer.
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The dashed box should encompass the ‘Keyboard' and 'Microsoft Mouse'
symbols, as well as their connedions, as shown in Figure 111
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Figure 1.11 Sefecting a Group of Chart Objects

5. Release the left mouse button.

The block of objects is highlighted and enclosed by a dashed bounding box
and is selected for a subsequent operation, such as move, copy, delete, or
save block.

To de-sclect the groub of selected chart objects:

Click the right mouse butten or click elsewhere on the chart (outside of
the selection box).
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NOTE: When you also want to include objects in your sclection that are outside NOTE: In both cases, you can increase the scroll increment to 4, 8 or 16 columns
of the currcat chart window (on the chast but not currently displayed), the chart or rows at a time by holding down the CTRL, ALT, or SIIFT key respectively white
window will scroll 2« you hold the left mouse button and enlarge the sclection box clicking on the scroll arrow.
as it contacts the edge of the chart window,
. Scroll Boxes -
Scrolling

Scrolling makes it possible for you to sce portions of the chart that are oot
currently displayed in the chart window. The chart drawing area is 32 rows by 32
columns. The chart window displays 9 rows by 8 columas, or appro:umatcly 25%
of the entire chart, - .

The EasyCASE Plus screen bas two scroll bars. The one down the right side of
the screen scrolls the chart vertically. The one acrass the bottom of the screen
scrolls the chart horizontally.

Scroll Arrow Buttons

The scroll arrows, located at each end of the scroll ba.rs, move the chart one row
or column at a time.

Figure 1.12 Right and Down Scroll Arrow Buttons

Ta seroll down a few rows:

Click on the down arrow, located at the bottom of the vertical scm'u bar,
several times. The chart window scrolls down the chart one row at a time.

To scroll right a few columns:

Click on the right arrow, located at the right end of the horizontal scrol?
bar, several times, The chart window serolls right across the chart one
column at a time.

Easy'C.ASE Plus Version 3.1 Beglnners Tutorlal

The seroll box, located belween the scroll arrows on cach scroll bar, moves the
chart window over the chart and allows for more rapid scrolling.

To scroll toward the bottom of the chart:

L Position the mouse pointer over the sceoll box on the vertical scroll bar.
2. Press and hold down the left mouse button,

The scroll box is outlined by a dashed box. This outline follows the mouse
pointer along the scroll bar as you mave the mouse.

3. While holding down the left mouse button, d.rag the seroll box outline
down to the end of the scroll bar,

4 Release the left mouse button,

The bottom area of the chart is now displayed in the chart window.

You do the same type of operation with the scroll box on the harizontal seroll
bar.

Zooming

The zoom [eature cnables you to quickly swilch back and forth between macro
and micro views of your chart. There arc three zoom Jevels available ranging
Irom actual size 1o a mode whercby you can sec the entire chart on the screen.
You can zoom using any of the following approaches:

= Click both mouse buttons simultancously N

= Click on the Quick Zoom icon

s Select the 'Quick Zoom' option from the View Menu

= Press the CTRL+ 2 key combination . |

EasyCASE Plus Verslon 3.1 Baginner's Tutorlal
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The quickest way to zoom is with the mouse buttons or Quick Zoom icon.

)

To zoom using the mouse bultons:

O |

L Press and hold down the right mouse buiton. o SRty NP c=: I I DRI I ()

. ] i
i 2. Then, press the left mousc button also. Q H
E 3 Release both buttons simullancously, — :
4, The full chart-is reduced to appear in the chart window, as illustrated in g
Figure 1.14. * i
5. Repeat Steps 1 through 3 to zoom back to the actual size chart. Z
6. The actval size chart is re-displayed in the chart window, :

NOTE: The position of the mouse pointer when you click the buttons determines

‘ what arca of the chart will be displayed in the chart window when you zoom from
full chart back to actual size display.

O

To zoom using the Quick Zoom icon:

:ﬂl?ﬁa: lu::l- 0 File:

: 1. Click on the Quick Zoom icon (located in the lower left corner of the chart
window} as shown in Figure 1.13.

Figure 1.14 Zoomed (Fuil) Chant

NOTE: When you quick zoom from full chart to actval size.using lhc.Quick.
Zoam icon, CTRL+Z keys, or 'Quick Zoom' menu option, the chart window is
centered on any selected object. If an object is not s_clcclcd. you are rcm‘m:d to
the position where you were located when you previously 'quick zoomed' from
actual size 1o {ull chart mode. .

Zooming Using the View Menu Commands

; ’ ' Figure 1.13 Quick Zoom Icon The View menu commands, as shown in Figurf: 1.15, give you greater flexibility in
j — choosing which part of the chart you want to display when you zoom.
2. The full chart appears in the chart window, as illustrated in Figure 1.14. 1 - o
. s The Full Chart command displays the entire chart with all objects in reduced
3 Click on the Quick Zoom icon again (o z0om back 1o the Actual Size size. ’
chart,
‘ . s Thé Half Size command displays only the half of the chart that you sclect. The
1 The Aclual Size chart is then re-displayed in the chart window, objects are casier (o see than in full chart mode.
EasyCASE Plus Version 3.1 Baginner's Tutorial EasyCASE Plus Version 3.1 Beginner's Tutorlal
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»  The Actual Size command displays objects at normal size, so you can sec
detail and work with the objects.

IIEYR Options Explode Nnalyze
" fActual size

Half size
Full chart

" Redrauw chart Ctrl+R
Quick zoon Ctrl+2

; J Drauing grid

1. J Display title block

Doukie 1 bar own LRDs
Birected comwnis

{ Open arrouheads
Filled arrowheads h

I Rounded corners

Figure 1.15 View Menu
Zooming between Actual Slre and Full Chart

.
Your chart should be displayed at actual size, the size you used for creating and

modifying the chart.

To zoom to the Full Chart display:
1. Select the View menu.

2. Sclect the Full Chart option,

3 The enlire chart is then disptayed in the chart window, as illustrated in
Figure 1.16.

Use the same approach to move from Actual size to Half size view. While at
Actual size view, choose the Half size option from the View menu.

To zoom back to Actual Size display:

1. Scleat the View menu,

EasyCASE Plus Version 3.1 Beglnner's Tutorial

Sclect the Actual Size option

A selection box is displayed. The mouse pointer is positioned at the Lop

left corner.of this Lox.

=| Fila Fdit Objects View Options Explode fAnaluyze Schomsa Utility  Hel

i R

Figura 1.16 Actual Size Zoom Selacilon Box

Press and hold down the leflt mouse button,

Use the mouse to drag the selection box over the area of the chart that you

want to display in the chart window at actual size.

Release the left mouse bulton.

You are prompted to verify that this is the sclected arca to zoom into,

EasyCASE Plus Version 3.1 Beginners Tutorial
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Figure 1.17 Prompt to Verify Zoom Action
1

8. Click oa 'OK' to accept your choice.

NOTE: If you want to reposition the selection box, click on ‘Redo’ and reposition
the selection box over the desired chart area. Click on 'Cancel’ or press the ESC
key to cancel the operation and remain at (ull chant view.

Zoeming From Full Chart to Halt Size

Set the zoom level so the chart is displayed in Full Chart mode.,

To zoom to the Half Size display from the Full Chart mode:

1. Select the View menu.

2. Select the Half Size option,
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Figure 1.18 Chart Window Displayed in Hail Size Mode
3, Use the same approach as deseribed in steps 3 through 8 of the previous

section to zoom from Full chart 10 Half size. The selection box is larger
hecause more of the chart can be seen at Hall size than Actual size.

Use the same procedure 1o move from Half size to Actual size view., While at
Half size view, choose the Actual size option [fom the View menuy,

Redrawing the Chart Window
You can redraw (refresh) the chart window at any time simply by clicking on the

Redraw icon located at the tower right corner of the chart window (between the
right and down seroll arrows), as shown in Figure 1.19.
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Flgure 1.19 Redraw Icon

NOTE: You can also press the CTRL+R key combination, or choose the Redraw
Chart command from the View menu, 1o redraw the chart,

Exiting EasyCASE Plus

To exit EasyCASE Plus and return to DOS, choose the 'Exit to DOS' command
from the File meny. You arc prompted 1o save any changes made to the current

chart, if any.

To exit EasyCASE Plus:

1. Seleet the File menu,

2. Click on the ‘Exit to DOS' option.

3. If you have changed the current chart and have yél (o save it, you are
prompted to save the changed file,

4, Click on the 'No' option to discard any changes made.

5. The exit dialog box is then displayed, prompting you to verify that you

want to exit the program.
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————{ Exit Progran |———-n
% Save Optlons. . __‘ .

[EXIT ] Y [Cancall

Figura 1.20 Exit Prompt

The "Save Options' sciting allows you to choose to save your current
options and configuration (these options are available in the View and
Options menus). By default, the ‘Save Opuon.s setting is turned Oan. Lcaw:
it at this setting.

6. Click on the "Exit’ opli(;n to exit the program.
The FasyCASE Plus program is ended, and you are returned to the DOS

prompt,

Allcmaluvcly, you can alsa exit EasyCASE Plus by clicking on lhc "Exit’ icon, as
follows:

1. Position the mouse pointer over the ‘Exit’ icon buttoo located at the top |
left corner of the screen, as shown in Figure 121,

Figurae 1.21 Exit Icon
2. Click the left mouse button on the icon,

3. ¥ou arc then prompted 1o save the current chart and option settings, just i
as when you chose the ‘Exit to DOS' command at the File menu. i
i
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You can also exit by pressing the CTRL + X key combination.
Alternatives

Starting EasyCASE Plus from the DOS Command Line
Wiy display a list of proedts:

s Usc the /P switch. This switch displays a listing of projects and directorics
alter the welcome screen,
-
The command is:

EASYCASE /P

This switch cnables you to select an existing project directory, or enter the
namée of a new project directory. When the product runs, you should sce a
dialog box similar to Figure 1.22 from which you can access a project ina
subdircetory or navigate through the drives and directory structure on your
disk to a project dircctory located elsewhere,

~—| Saelect Project Drive & Directory }—
D :STUTNECPLUSITY

Figure 1.22 Project Directory List

EasyCASE Plus Version 3.1 Beginner's Tutorlal

To display a list of available chart files of a specific type:

Entcr a chart type after the project dircctory name to display a list of available
charts of that lype. For example:

FASYCASE SAMPLES ED

displays s lsting of she Data Flow Diagrams (DFD) available in the
SAMPLES project dircctory.

To bypass the User Name Entry screen:

Use the /N switch. This switch tells EasyCASE Plus to use the name of the
last user to log in to EasyCASE Plus. The command is:

EASYCASE /N

When E’.as}CASE Plus starts, you are not prompted for your name,

- EasyCASE Plus Version 3.1 Beginner's Tutorlal



LESSON 2
CREATING A CHART

Overview
This lesson covers:
» Beginning a new chart
=  Placing symbols on it
= Connccting the symbols tc_:gclhcr
s Labeling chart objects

= Adding a title to the chart

= Saving the chart

Before you start this lesson, you must have installed EasyCASE Plul.s with the
Samples project. You should also be familiar with the material covered in
Lesson 1. ) 1

I

EasyCASE Plus should now be running, If it is not, follow the slcps provided in
Lesson 1 to run EasyCASE Plus and access the sample diagram.

It should take you approximately 45 minutes to complete this lesson,
Beginning a New Chart

A projcct contains chart files that contzin objects and data dictionary entrics
(storing the object definitions) in common. These chart Bles may also be linked in |
a hicrarchical structurc. Whenever you create (and save) & new chart, the chart
files are added to the current project directory (in this case, the SAMPLES -
project). All of the components of a project are stored in this common project
dircetory.

i
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You use the ‘New Chart’ option in the File menu to ereate a new chart, of the View Options Explode
current type (in this case, DFD).

External Entity
A new, blank chart with the tempaorary file name of UNTITLED.DFD is Data Process
displaycd in the charl window. Data Store
SplltsMerge Q
The title block, located initially at the top left of the chart window, displays Multi-Data Process
current chart inflormation, including its type, filename, user name and date.
Data Flow
You will use this chart (o create a new context diagram for a sample order
processing system. This order processing system handles information for % Data Interfacs
management, payroll, inventory, and customers, It consists of a ceotral data
process, which defines the entire processing performed by the system; several
external entities, which represent things external to the system, with which the Figure 2.1 Objects Menu for 8 DFD
system interacts; and several connections which carry data into and out of the
system, between the central data process and the external entity symbols, All
symbols and connections are labeled with text to describe their function.
Adding a Symbol Sclect the Da.t_a Process’ abject type entry.

The first step in creating your chart is to add symbols 1o it. The types of symbels

available for placement on this {data flow diagram) chart are listed textually in

the Ohjects menu, and are represented graphically in the form of icons down the

left edge of the sereen.
k]

The vertical order of the objed icons displayed down the left side of the screen
corresponds 1o the order of object types listed in the Objects menu.

For the Tutorial, you will use the default chart cditor settings when creating the
chart.

In this lesson, you will first place all of the symbols before proceeding to label and

connect them together,

NOTE: The default setting for a DFD determines that the Yourdon symbol set is

uscd. At the end of this lesson, some of the available options are described.

First, place a Data Process symbol:
1 Sclect the Objects menu,

EasyCASE Plus Verslon 3.1 Beginner's Tutorial

Position the mouse pointer in the center of the grid square located at
column 4 row 5.

Click the felt mouse button.
A circutar data process symbol is displayed and appears sclected

(highlighted and cnclosed by small boxes). This data process will represent
the processing unit for the catire order processing system.
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= File Edit Objects View Optiona Explode fMmalyze Schena LHillty Halp

n
ok
ol

[als]els 5%
lol: L, Row: 1 Lewel: O File: UNTIILED.DED

Flgure 2.2 Da{a Process Placed and Selected

Neat, place some External Entity symbols:

External catitics arc real world objects the order processing system interacts with.

1. Sclect the ‘External Entity object type entry from the Objects menu.
Allernatively, select the External Entity icon (rectangle) displayed at the
left of the chart window.

EasyCASE Plus Version 3.1 Baglnner's Tutorlal

Hepiieon

Figtire 2.2a Qbject Icons for a Yourdon/Demarco DFD
Position the mouse pointer near the upper left corner of the chart window.
Click the left mouse button,

A rectangular External Entity symbol is displayed and selected.
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scts Ulew Optlons Explode Analyze Schena Uiility Help
- . i

=] Flle £4lt 0ObJ
B Y]

Figure 2.3 External En rr’ry Symboi Placed and Selected

5. Place three more External Entity symbols, one each in the upper right,
lower right and lower left corners of the chart window. You do not need to

choose the External Entity object type again to place a symbol. Symbol
placement is a repeatable command.

When you have finished, the chart window should look like this:

EasyCASE Plus Version 3.1 Beglnner's Tutorlal
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BleOiliew

Figure 2.4 Chart with ali Symbols Placed

NOTE: If you make a mistake and want to cancel an action ($uch as selecting an
object), click the right mouse bution, To delete an unwanted object, select the
object and choose the ‘Delete Object/Group' oplion from the Edit menu, or press
the DEL key. You will be prompted to verify the delete,

Labeling the Symbols

Having just positioned a number of symbols on the chart, you should then label
them according to their various functions. You will use the Label Object
command {rom the Edit menu.

First, tabel the centrul Data Process symbal:

1. Select the Dauta Process symbol by clicking on it (be sure to click near the
center of the symbol). It will become highlighted.

EasyCASE Plus Verslon 2.1 Baglnners Tutorlal
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2 Select the 'Label Object’ option from the Edit menu.

3 A text entry window is displayed in the center of the screen for you to
enter the label text.

4 Type “Ocder Processing System”. Press the ENTTIR key between each word
to place them on scparatc lines as shown in Figure 2.5.

-'________

Figure 2.5 Symboi Label Taxt Entry Window -
5. Press the F3 key when you have eatered the text.

6. The label is displaycd at the upper left of the symbol and seleeted
(highlighted and enclosed within a dashed box).

7. Pasition the mouse pointer over the dashed box, then press and hold down
the left mouse button.

A small hand icon is displayed, positioned automatically over the label.

This indicates that you can move the label by moving the mouse while you
are holding down the lcft mause butlon, as shown in Figure 2.6.
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9,

10.

Figure 2.6 Hand Icon Positioned to Mave Symbol Label

While still holding down the left mouse button, use the mouse to drag the
dashed box to the center of the symbol as shown in Figure 2.7.

Figure 2.7 Hand Icon Moving Symbol Label
Release the lelt mouse button.

The text will move 1o that position, as shown in Figure 2.7a.

L
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Figure 2.7a Final Symbol Label Placement

NOTE: If you want (o change the text layout of your label, select the label, then
choose Label Object again, You can edit the lext as you wish. Remember that the
label 1ext ediling operation is completed whenever you press F3,

Next, label the External Entity symbols:

1.

Selcet the upper keft External Entity symbol by clicking on it. It will be
highlighted.

Choose the Label Object cammand again, Allernatively, press the ALT+L
key combination, .

Type “Customer” in the label text box, then press the F3 key.

Position the label in the center of the symbol, as you did for the Order
Processing System data process symbol, .

Repeat Steps 1 to 4 for the remaining three External Entity symbols
labeling them as follows:

{Upper right) *Supplier”
(Lower right) “Payroll®

(Lower left) *Management”

EasyCASE Plus Verslon 3.1 Beglnnar's Tutorlal
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NOTE: If you wish, you can usc the arrow keys on your keyboard te position the
lahel, rather than using the mouse, Press the ENTER key when you are finished
moving the dashed box 1o complele the operation,

When you are finished, your chart should look like this:

Figure 2.8 Chart with ali Symbols Labelled

Connecting the Symbols
A number of symbols have been placed and labeled on the chart. The next step is
to add connections between them, To do this, you will use the Data Flow option

from the Objects menu, or the data flow icon.

To connect the "Order Processing System” and "Customer” symbols together: -

1. Select the 'Data Flow aption from the Objects menu,
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| 2. Seleat the ceatral data process symbol labeled "Order Processing System” 4. Sclect the External Enlity symbol labeled *Customer” by clicking ou it.

by clicking oa it (click ncar the center).
This will be the target symbo! for the data flow. A aumber of small boxes

arc displayed around this symbol, as shown in Figure 2.11, These represent

L This will be the source symbol for the data flow. A number of small boxes
Lt discrete positions at which a connection can enter the symbol, !

arc displayed around the symbol, as shown in Figure 2.9. These represent
discrete positions at which a connection can exit the symbol,

Figure 2,11 Flow Entry/Exit Ports

5. Scicct the box midway on the lower side of the Customer symbol by

Figure 2.9 Selected Source Symbol for Data Flow to Begin clicking on it, as shown in Figure 2.11a. ;

3. Selcet the box half way down the Icft side of the symbol by clicking on it
using the mouse.

The small box that you sclectgd remains displayed at this location, and the
other boxes are erased (sge Figure 2.10). This indicates where the
connection will leave the symbol. -

: Processing © . Figure 2.11a Select Fiow Entry Port for Customer Symbol

. System .

A connedtion is thea drawn automatically from the *Order Processing
System” symbof to the "Customer* symbol, using a horizontal and a vertical
line segment, and with an arrowhead at the destinatjon cnd, as shown in
Figure 2,12,

ot Figure 2.10 Selected Orlgin lor Connection Attachmant
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POrder. . .
- Processing
: System . :

6. Repeat Steps

Figure 2.12 Initial Connection Placed

1to § using the *Customer” external entity as the source
symbal and the *Order Procgssing System” data process as the target
symbol, .

Route the connection fro

top of the "Order Processing System"” symbol, as shown in Figure 2.13.

The completed data flow ¢
at the points you have chos
System (o the Customer, and a different data flow b

System.

Your chart should now look like this:

EasyCASE Plus Version 3.1 Beginner's Tutorlal

m the right side of the "Customer” symbol to the

onnections are displayed, connecting the two syn‘lhols
en. There is a data flow from the Order Processing
ack to the Order Processg

POrder, . . .
: Processing : -
System | :

Figure 2.13 Data Flows Connecling a Data Process and an Extarnal Entity

Next, place connections for the remaining symbols, Refer to the chari in Figure
2.14 to complete your conneclions, Refer to the following table which shows the
source and target symbols for the data flow connections:

Source Symbol

Target Symbaol

Customer®

Order Processing®
Order Processing System
Supplier

Order Processing System
Payroll

Order Processing System

Management

Order Pracessing System®
Customer*®

Supplice

Order Processing System
Payroll

Order Processing System
Management

Order Processing System

Tablo 2.1 Source and Target Symbols for Connections

“*Connections already placed in preceding sections,
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3. Type "Statement” in the Jabel text entry box that appears, as shown in
Figure 2.15. !
| f
o1 LABEL — x
Statementfl = R '

Figura 2.15 Connaction Label Text Entry Box

4. Press the €3 key.

5 The label is displayed inside a highlighted, dashed box next to the i
connection's "handle’, ‘

6. Using the mouse, position the connection label, as you did for the symbol !
labels, by dragging it so that it is located next to the connection, as shown
in Figure 2,16, B . \

Figura 2.14 Chart with ali Connectlons Complated

Addlng Labels to the Connections

so far, your chart has all'of the symbals labeled and conncctions placed. The next

sk is to label the connections between the symbols. This procedure is similar to
" |abeling symbols {se€ the previous section, *Labeling a Symbol™).

To labe! a connection:

Select the connection (lowing from the *Order Processing System™ data
rocess symbol ta the "Customer” external entity symbol, by clicking on the

small box (‘handle’) on the connection. It will be hightighted and small

boxes will be located at cach end, and also at the corner and midpoint of

cach line segment.

Eg'rd'eri P
. Processing ¢ . .
:System . . 1 . l

1.

2.1 Choose the Label Object command from the Edit menu, or press ALT+L

Figure 2.16 Hand Icon Positioned for Moving Connectlon Label |
(|

EasyCASE Plus Verslon 3.1 Beglnner's
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Repeat steps 1 to 6 above for each other conneetion on Lhe chart, using Table 2.2

as a guide Lo the label to use for each remaining connection.

Refer 1o the following table and Figure 2.17 to lubel yuur connections.

Source Symbol

Target Symbol

Connectlng Label

fieed i aest et

Order Processing
System

Customer

Order Processing
System

Supplier

Order Processing
System

Payroll

Order Processing
Syslem

Management

*Connection already labeled in preceding section.

Customer

Order Processing
System

Supplicr

Order Processing
System

Payroll

Order Processing
System

Management

Order Prockssing
System *

siaement®
Payment
Inventory Request

Inventory Delivery
Report

Sales Commission
Request Form

Sales Commission

Sales Report System

Sales Quotas

Tabla 2.2 Label Text for Connections

Upon completion, the chart should look like the following:
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Figure 2.17 Chart with all Connections Labeled

NOTE: As an alternative to using the ‘Label’ option from the Edit meou (or press
ALT+L) 1o label an object alter each is placed, you can automatically invoke the
Label text eatry box,

To do this:

1.

2.

3.

Choase the Options menu. -
Select the ‘Preferences’ option.

In the dialug box that appears, click on the 'Auto Label’ entry so that an X’
appears to the left of it, as shown in Figure 2.18.
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——{ Set Options f——

Figure 2.18 Preferences Dialog Box Containing the Auto Label Option set to
On

4, Click on ‘Cancel'.

Adding a Title to the Chart

Your chart should now be displayed with all symbaols and connections labeled.
You can add a title to describe the purpose of the chart if you like. To do this, use
the Text Block' option from the Edit meny. -

To add a title to the chart:
1. Select the Text Block' option from the Edit menu, or press the ALT+T key
combination,

2 Position the mousc painter in the upper right corner of the chart window,
as shown in Figure 2.19.
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=} File EdIt Objects View ﬂptlom Explode fns lyze Schom Utllllu N-lp

Figure 2.19 Mouse Polnter Pas!rioned te Place Text Block I

3. Click the left mouse button. This d:ﬂncs the location for the chart title text |
block.

2.19.

4. A text entry box appears in the center of the screen, as shown in Figure L
1

5. Type "Sample Order Processing System” then press ENTER. Then type
*Data Flow Diagram {DFD)" as the title for your chart, as shown in Figure
2.19a.

b
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TEXT BLOCK : —
Samplé’Order Processing Susten:i
pata:Flou Diagran: (DFDIH .

Figure 2.19a Text Block Entry Box .
6. Press the 3 key to accept the title text.

7. The title is displayed at the location you chose previously (steps 2 and 3),
as shown in Figure 2.20. :

8. 1f you want Lo move the title, usc Lhe same procedures you used to position

a label. That is, press the left mouse button, drag the text block outline to
the desired location, then release the mouse button to place the text block.

9. Your completed chart should look like this:

EasyCASE Plus Version 3.1 Beglnner's Tutorlal
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Figure 2.20 Compileled Chart.

NOTE: 1If you want to change the text of your title, select the title then choose the
Text Block' option again. You can cdit the text as you wish.

Saving the Chart

It would be a good idea to save the chart at this point. Use the Save As command
from the File menu to do this using a new chart file name.

i

Select 'Save As' from the File menu,
You are prompted for the new filename to use.
Press the "Delete’ key to erase the current name (untitled dfd),

Type in "tutor]”, You do not aced (o enter a file extension, as it will default
to the current chart type {DFD in the example), as shown in Figure 2.21a, '
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The chart fife is saved in the SAMPLES project directory and the chart window is
Save Filanana: re-displayed. Notice that the Title Block information and status linc is updated to
reflect the new chari bame and file name (tutor] and tutor1.d{d, respectively).
l} You can now contisue working on the chart you have created. E
SyGE [No™] C ; ' '

L:¥0s:) St Cancol) Alternatives . i
) Therc arc a number of oplions you can use to customiZe your chart creation ”
i Figure 2.21a Filename Text Entry Box process. The lollowing are some options available in the Opuun.s and View menus
i . that relate o this tesson: .
: 4, ClickonYes. . ‘
a on Fes * Default Symbol Set *
: . {
; 5. A listing of th t DFD chart file names is then displayed
i ?_Zlb;nagn?l yo: ::lfsromptcd cfo: the zhar:nn:me l;:u;sp ayed (sce Figure The default symbol set used for DFDs is the Yourdon/DeMarco set. For Data
1 ) Flow Diagrams, your other oplions are the Gane & Sarson and SSADM symbol
! The name of a new chart defaults 1o its file name. The chart name can be a scts. When you choosc one of these options, the appearance of the chart symbols
i longer (up to 32 characters) descriptive name for the chart and is cntered changes. Try it by choosing the ‘Change Chart Type' entry in the File meny, then
into the data dictio for laler ac click on the Gane & Sarson DFD option. The chart is redrawn using this symbol
: ’ set as shown in Figure 2.22. Repeat the process to choose the SSADM symbol i
| Select dfd Nano | sct, and then return ta the Yourdon/DeMarco symbol set. ‘
: I
: |
}
i

: Ve jects  (Yourdon DeMarca),
:‘Coptext Dlagrnn

L3 0K [Cance]]

Figure 2.21b Listing of Avaliable Chart Names with the Current Name Shown

. in the Upper Text Entry Box

6. Click on 'OK' to accept "utor1” as the DFD chart name,
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Y.
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Figura 2.22 Gane & Sarson DFD Symbol Set

Default Symbol Size

The defauit symbol size is Normal, the size you have been using throughout this
lesson. You can change this sctting to Small, Large, Extra Large and Giant. i you
do, cach symbo} you place subsequently will be drawn using the chosen size. This
feature is accessed via the Default Symbol Size entry in the Options menu.

Auto Label

This sctting determines whether or not you are automatically prompted to label
an object when you create it. It is 'OfF by default, allowing you Lo create all of the
objects before labelling them. When it is 'On,’ the label Lext entry box will pop up
automatically whenever you place a new symbol on the chart, This cntry is found
by choosing the Preferences entry from the Oplions menu.

EasyCASE Plus Verslon 3.1 Beginner's Tutorlal

Allow Place New Label

This oplion allows you to repaosition a label after it has been placed using the
mouse or keyboard. The defsult setting is 'On. When this sctting is 'OIT,’ the label
is placed inside a symbol, or adjacent to the selection marker for a connection,
aad you cannat adjust ita position. To do so, you must use 'Maove Object /Group’
command afler placing it. This option is found by choosing the Preferences entry
from the Options menu.

Automatic Flow Routing

When you place connections, this option automalically chooscs a routing between
symbols that accounts for the proximity of diagram clements. This oplion is 'On’
by default, When it is ‘On,’ only horizontal and vertical line segments arc drawn
between points on connections. When you turn it 'Ofl, single, straight-line
scgments arc drawn directly between points and connections. This option is found
in the Options méno,

Default # of Arrowheads

All of the data flow connections you used were one-way single-headed
connections. This is the default setting, However, you can also use one-way
double-headed, two-way single headed, two-way double headed, or no
arrowheads on conncctions, by default. This feature is accessed via the Options
mend,

Open Arrowheads
This setting is 'On’ by default. When you turn it 'Off; the conncelion arrowhcads

are closed in, but unfilled. This option applies to all connections on the chart.
This is an option in the View menu.
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Flgure 2.23 Dlagram with Closed and Filled Arrowhead's

Filled Arrowheads

This setting is ‘'OIF by default. When turned 'On,’ this setting displays solid (filled
in) connection arrowhcads. This option applics to all conncctions o the chart.
This is an option in the View menu.

Rounded Corners

The corners on the connections you used were rounded, the default setting.
Turning this sclting 'Off' produces sharp corners. This option applies to ali
connections on the chart. It is an option in the View menu.

Display Title Block

Turn this sctting 'Off to suppress the display of the Title Block in the upper left
corner of the chart window. It is *On’ by default. This is an option in the View
menu,
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NOTE: The Title Block cannet be edited or deleted, however, it can be.moved.,

Drawing Grid

This option turns the drawing grid 'Off for & clear chart background as shown in
Figure 2.24, 1t is *Oa’ by defuult. Even when turned *OfF, the grid is slways active.
This is an eption in Lthe View menu.

={ Fila Edjt Objects View Optloms KExplode Analyze Schena ULITIty Help
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Figure 2.24 Chart with Drawing Grid Off

Auto Redraw After Edit

This option is found in the Options meau and defaults to 'Ol When it is "'On,’
then wherever you use an editing command (such as Move or Delete

Object /Group), the screen will be redrawn automatically on completion of the
cdit operation. This removes the need for you 10 elick on the redraw icon (or
select Redraw chart from the View meau, or press CTRL + R) 10 redraw the
screen. Screen redraws may be necessary after an cditing operation Lo remove
any scrcen "debris’ resulting from the cdit.
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LESSON 3
-MODIFYING A CHART

' ' I Overview
. For this lesson, you will start with a chart that is incomplete, contains some
defiberate ervors, and is in need of repair. In fixing and completing the chan, you
will use the following functions: -
=  Loading a chart
= Moving a symbol
w Copying a symbo!
= Deleting s symbel
®  Resizing a symbol
= Moving a block of symbols
1 F = Copying a block of symbols
s Deleting a block of symbols
# Changing a symbol labei
@ Changing a symbol type
=  Changing conncctions
e Moving the entire chart

To complete this lesson, you will need to be familiar with the material covered in
Lessons 1 and 2.

This lesson should take you approximately 45 minutes to complele.
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NOTE: You should be using the default settings for EasyCASE Plus, If you have
changed any scttings, restore the default values for the duration of this lesson.
Otherwise, the results of the instructions may be different,

Loading a Chart

First you will nced to load the chart to modify, Use the MODIFY.DFD chart
stored in the SAMPLES project direclory. This chart is a variation on the
TUTOR1.DFD chart you created in Lesson 2,

To load the chart:

1. Choose the Load Chart command from the File menu, or press CTRL +L.

A dialog box is then displayed listing the data flow diagram (DFD) charts
in the SAMPLES project directory that are available for loading,

.

Sanple Projac Conl-x‘ Dlngran
Snnpla Projec
,Saﬂple ProJectsProcess 1.DFD
"~ SampleiProjectProcess 2 DFD

L. 0k :1] fCancel]

——————{ Select Name of Chart to Load |——

Figure 3.1 Listing of Available DFD Chart Files

2 Sclect the MODIFY chart entry (MODIFY.DFD) by clicking on it.

3. Click on'OK’

Altdrnatively, double click on the chart entry.

EasyCASE Plus Version 3.1 Beginner's Tutarlal
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4. The chart is then loaded and displayed in the chast window, as shown in

Figure 3.2, |

You will observe that there are 8 number of problems with the layout of this !
diagram, which you are abaut v correct in the following steps. These ‘corrections’
will allow you Lo gain Tumiliarily with the micthods avaituble for manipulating
existing chart objects,

|
=] File Edit Objocts View Qptlions D!Plodl Rﬂlm Scilnl m“llu Hlll

TIOLTED

Figure 3.2 Chart to be Worked On in this Lesson

Moving a Symbol .
Among the problems you will notice on the chart is the placemeat of the symbols.
Yot will begin modifying the chart by moving the Order Processing System dala

process symbol to a mose cenltral lacation, I
. ; {
To move the data process symbaol labeled “Order Processing System®:

EasyCASE Pius Verslon 3.1 Beginner's Tutorlal
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1 Posilion the mouse pointer over the data process symbol Jabeled "Order When you have finished, your chart should look like this: -

Processing System” (be sure to locate it in the center of the symbol),

=| Tile Edit Objects View Cptlons Explods finaluze Sch-n HRillty 'h.l'

2. Press and hold down (he leli mouse button. N

The symbol is hightighted and a small hand icon is displayed (see Figure
1.3). Thia indicates that the symbol is selected and you can move it by
moving the mouse while you are halding down the left mouse button,

1
Figure 3.3 Hand Icon Positjoned Ready to Move Symbol

Figure 3.4 Chart with Moved Symbol

3 While still holding down the Jeft mouse button, move the mouse to move
the hand icon toward a central location between the four surrounding
(external entity) symbols. An outline of the symbol follows the mouse

Copying a Symbol

Besides moving symbaols, you can also duplicate them. This feature can be very

cursor. useful when you are creating large and complex charts.
4. Release the left mouse button, In this scction, you will use the Copy command from the Edit menu (o make a
. xicrnal entity symbol as follows:

5. The symbol will move 1o the new location. The connections and their copy of the Management externa Yy . .
associated labels arc automatically redrawn for the new position, as shown L. Select the external entity symbol labeled "Management™ by clicking on it. Tt
in Figure 3.4. will be highlighted.

6. Click on the Redraw icon at the bottom right corner of the séreen to 2. Choose the Copy Symbol/Group command from the Edit menu.

relresh the screen and remove any 'debris' resulting from the maove.
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3 Press and hold down the left mouse button. A small hand icon is displaycd Deleting a Symbol
‘ in the selected (Management) symbol.
It is a simple procedure (o remove an object from the chart. Although it was a
uscful example, the new Mantgement symbol thut you just created is not

necessary in (his diagram.

While holding down the left mouse button, use the mouse (o move the
outline of the symbol to a position just below the original Management
symbol as shown in Figure 3.5,

e

In this section you will delete the symbol with its associaled label and connedtion
by using the Delete command {rom the Edit menu, as follows:

w| File fdit Objects VUlew Dptione Explode Analyze Schena Utillty Help

i doo N R IR 1. Select the new Management symbol by clicking on it. It will be highlighted.
i . 2 Choose the ‘Delete Object/Group’ option from the Edit menu, or press - ]’
the DEL key. .

A dialog box is displayed in the center of the screen, prompting you to
confirm deletion of the selected symbol, as shown in Figure 3.6.

Figure 3.5lCopylng the ‘Management’ Symbol

5. Rclease the left mouse button,
, An cxact copy of the Management symbal, and its label, is drawn at the Figure 3.6 Prompt to Confirm Deletion of Sefected Symbot

ncw location. 3. Click on 'Yes', or press the ¥ key.

4. The Management symbol along with its label, and the data flow connection
to the original Managecment symbal, is deleted. I you get a dialog box
requesting you 1o confirny deletion nlso of the Manusgement entity deta
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dictionary entry, click on the No option button or press the ESC key to
remove i,

5. Click on the Redraw icon to relresh the screen to remove any 'debris’
resulting from the deletion.

Your chart should row look like figure 3.4 ogain.

Resizing a Symbol
You may decide that your chart can be clarified by changing the sizes of the
symbols. The Customer and Management external entity symbols are smaller in
size than they should be.

In this scction you will resize these symbels by using the Change Symbol Size
command from the Edit menu,

To resize the Customer and Management symbols:

1. Select the Customer symbol by clicking on it. It will be highfighted,

2. Sclect the "Change Symbeol Size' option from the Edit menu.

3. A pop-up list box containing the available symbol sizes is then dispiaifcd

(sec Figure 3.7). Available symbol sizes are: Small, Normal, Large, Extra
Large, and Giant. The Small size cnlqry is highlighted initially.

EasyCASE Plus Version 3.1 Beginner's Tutorial
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Figure 3.7 Select 'Normar Entry Symbol Size from List
4, Sclect the Normal entry by clicking on it.
The Customer symbol is then redrawn using this (larger) size.
5. Repeat Steps 1 10 4 for the Management symbol.

6. Click on the Redraw icon to refresh the screen.
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2. A highlighted, dashed box is then displayed around the label text
("lnventory’) showing that it is selected. Il the symbol is sclected, ¢lick on

it again until only the label is selecied.

Your diagram should look [ike that in Figure 3.8.

={Flle Edit Objects View Options Ixplode Analyze Schems UHility Help
n 7 : H H :

R R

—2

Figure 3.9 Selected Symbol Label

3 Selet the "Label Object’ option from the Edit menu, or press ALT+L.

4 A text entry box is displayed in the center of the screen conlaining the
current label for the symbol,

5. Press CTRL+Y to delete the current line of text.

6. Type in the new label "Supplicr” (sec Figure 3.10).

LABEL }——

Supplier - o

Flgure 3.8 Resired Symbol

Changing a Symbol Label

You may nced to change the Iabel on a symbal, The procedure for doing so is
similar to that used for creating a label, as you did in Lesson 2. Although the
Inventory symbol is useful, it is wrong for this diagram.

In lhislscuion, you wall usc the LabeI_Objccl command from the Edit menu to
change the Inventory label as follows:

"L Click twice on the Inventory symbol to select its {abel, as shown in Figure
39.

t -

. Figure 3.10 Label Text Entry Box.

7. Press the 13 key.

TR TRIN
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8. The new text for the label will appear at the current label position inside
the symbo!, as shown in Figurc 3.11. You do not need to reposition the
label. Press the ENTER key, or click the right mouse button, to accept the
default labe) position.

Supplier .

Figure 3.11 Label Positioned Inside Symbol

Changing a Symbol Type

You can casily change the type of a symbot as you develop your chart. You may

bave noticed that a Multi-Data Process symbol type has been {wrongly) uscd for
the Order Processing System. This should be a regular Data Process symbol,

In this section, you will usc the Change Objct Type command from the Edit

menu (o correct il ¢

To change the symbol type for the Order Processing System:

1. Sclect the Order Processing System symbal by elicking on it (click near the
center of the symbol), It will be hightighted.

. Select the ‘Change Object Type' option from the Edit menu.

3. Alist box will pop up in the center of the sereen containing the available
symbol types for the current (DFD) chart type, as shawn in Figure 3.12,
The ‘Multi-Data Process entry is highlighted initially.
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External Entity L

Data Store - . . - -
 Split/Horgo. -
. ‘Multi-Data; Process:

Figure 3.12 List of Available Symbol Types for a DFD
4, Select the 'Data Process' option by clicking on it,

The symbal is redrawn using the new symbol 1ype (without affecting the
current label).

Moving a Group of Objects

The Supplicr and Payroll external entity symbois are both too close to the Order
Pracessing System symbol. Rather than moving these independently, you can
move them both together as a single unit (group).

In this section, you will use the Move command to move these symbols together
as a group.

To move the Supplicr and Payroll external entity symbols together as a group:

1. Select the Supplier and Payroll symbols 1ogether as a gfoup by drawing a
sclection box around them, as described in Lesson 1, A dashed sclection
box appears around the Supplicr and Payrotl symbols, both of which will
be highlighted.

2, Posilion the mouse pointer over the sclected group of symbols, inside the .
sclection box. :

-

1 Press and hold down the lelt mouse button. A small hand icon is displayed
{sce Figure 3.13}.
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Customer.

iOrder. . .
Processing .

yskLes .

Faha'geiue;-nt:

.......... L e

. Payroll!
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Flgure 3.13 Hand Icon Positioned to Move the Selected Group of Symbols

4, While holding down the left monse buttan, use the mouse to drag the

dashed box onc column (grid squaze) Lo the right.

, 5 Release the left mouse button.

6. The group of seleeted symbals is placed at the new location. Natice that

the associated connections and labels are also relocated.

and erase the selection box.

8. If necessary, elick on the Redraw icon 1o remove any ‘dehris’ resulling

7 Click the right mouse button to de-select the Supplier and Payroll symbols -

from movement of the selecied symbols.
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Your chart should now look like this;
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Figure 3,14 Chart with Moved Group of Symbols

Copying a Group of Objects

Earlier in this fesson, you duplicated a single symbol (using the Copy Symbol
command). You can also duplicate a group of symbols, rather than creating or
copying the symbols independently. This process is similar 10 the Move

Object /Group procedure just deseribed.
In this section, you will use the Copy command.

To copy the Supplicr and Payroll symbels together as a group:

1, Select the Supplier and Payroll symbols together as a group, just as yoi) did
for the Move Block procedure (see steps 1 to 3 of "Moving a Group of
Symbols™). A dashed selcotion box appears around the highlighted

symbuls,
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2. Choose the ‘Copy Symbol/Group’ option lrom the Edit menu. When you have finished, your chart should now loak like this:

3. Press and hold down the left mouse button, A hand icon appears (scl:

-Lru- Edit Objecta View Optlons mloao nuluu Sch.lu Wity H-lp
Figure 3.15). H i i

Figura 3.16 Chant with Copled Group of Symbols

Figura 3.15 Hand Icon Pgsifloned to Copy Symbol Group
4, Use the mouse 1o drag the dashed selection box two columns (two grid Deletmg a GI’OUP of Ob]ects

1o the right of th 1y [ position.
squares) fo the right of the symbols” current position Any medificalions you can make to a single object, you can aiso make to a group

of objects. This is also the case for delete operations. Rather than incorporating
the extrancous, duplicate Inventary and Payroll symbols into the chart, or deleting
them individually, delete both of the new symbols in a stngle operation.

5 Release the left mouse button.

6. A copy of the fwo selected symbols is placed at the new location,

7. Click the right mouse button to de-select the Supplies and Payroll symbols. In this section, you will usc the Delcte Group command.

To delete the new (right-most) Supplicr and Payroll symbols together as a group:

1. Select the Supplier and Payroll symbols together as a geoup (just as you
did for the Move Group and Copy Group procedures),

EasyCASE Plus Version 3.1 Beginner's Tutorlal EasyCASE Plus Version 3.1 Beginner's Tutorlal




"Page 86 i

2 Sclect the 'Delete Object/Groug' option from the Edit meny, or press the
1 DEL kcy. .
'

a You arc prompted to verify that you want to delete any Data Dictionary
Entrics (DDE) aseocisted with the symbols as they arc deleted.
. EasyCASE Plus automatically displays this prompt whencver you dclcte a
: sy!nbol or group of symbols, whether or not there are existing Data
Dictionasy Eatrics for the symbols. At this point in Lhe tutorial, you have
fot yet linked chart objects to entries in the data dictionary, Hence, 1his
dialog box is irrelevant at this poinL

Figure 3.17 Prompt for Delation of Associated Data Dictionary Entrles
4. ' Click on the "'Do NOT Delete DDES' option.
5. Click on "OK.’

6. ' Theselected symbols, and their labels, are erased from the chart,

Your chart should now look like figure 3.4 again.
Modifying Connections

Wheacever the logic for the diagram changes, you can change the data flow to

accommodate it. EasyCASE Plus gives you a number of ways to modify

\ .
coamections; .

- lC'hangc the direction of a connection

b
4
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« Change the end point pasitions of a connection (i.c. where it connects with &
symbol)

® Teroute the connection (i.c. changing the path of the connection)

«  Change Lhe dcslin-n'linn and/or sonrce symbaols for o connection

» Delete a connection

= Change the number of arrowhcads or symbols on the end(s) of a connection
Every conncction has a small box at the mid-point of a line segment. This is the
*bandle® you will use 1o select the connection, When a connection is selected, &

marker is displayed at each corner and mid-point of the line segments that
constitule the conncction, as well as at cach end. These markers fundlion W twe

ways:

- = Asasclect point to grab and move the connection line segments

» Asa select point for removing and possibly resouting sections of the
counection

The lollowing excrcises will lustrate how to modify conncctions.
Changing the Direction of a Connection

Changing the direction of a data flow is quick and casy. For example, the
direction of the conncction between the Order Processing Sysiem symbol and the
Customer symbol is incorrect and needs to be reversed.

In this section, you will use the Change Direction command from the Edit meou
o reverse the dircction of the connection, as follows:

L Sclect the data flow connection that originates {rom the Order Processing
System symbol and enters the Customer symbol (click on the connection’s
handle). The connection is highlighted and markers are visible at various
posilions on it.

2. Select the "Change Dircction’ aption (rom the Edit menu,

3 The data llow is reversed so that it represeats a flow of data from the .
Customer external entity symbol into the Order Processing Sysiem data
process symbul,
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I e

k) A dialog box pops up in the center of the sereen requesting you to confirm

Whea you are finished, the Customer and Order Processing connections should
deletion of the selecicd symbol (see Figure 3.19).

look like this:

yE :‘f"ﬁa“'

S S
& L L L L ERAI RIS
3’ :::::::::::::::::::i:::::s'fm:j.;:

‘ ETHIRIRIRIRIRIE SEIRSCICIENE SRUERE fF EUEN SUEUEN SESCIRICICN SSSEOS

Eustomer. | - . 0 0 120010 D

| .;———]| Delete Comnection 1 |——1

SESS ‘ i [VES'] [ No. 3

Flgure 3.18 Chart with Fidw Diraction Changed Figure 3.19 Prompt to Contirm Deletion of Selected Connection

Deleting a Connection 4, Click on the 'Yes button, or press the ¥ key.

You can delete a connection just as you would a symbol. As an lustration, delete 5. ‘The connection is crased from the chart {see Figure 3.20).

onc of the conncctions (¢ the Supplier symbol,
You will usc the Delete command from the Edit menu 1o accomplish this,

To delete the connection:

1 Select the lower of the twe data flow connections lerminaling in the
Supplicr symbol. The connection is highlighted and markers appear along
it.

2, Select the 'Delete Object /Group” option from the Edit menu, or press the
D key.
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Figure 3.20 Chart with Connection Deleted

Changing the End Point for a Connection
* 1

You can relocate the end of a connection, or even both ends, Lo a different point
on the symbol, or even to another symbol, In the example diagram, the end points
for the conneclions between the Order Processing System symbol and the
Supplicr symbol arc wrong at the Suppticr end. Ia this section, you will change
the connection's end points on the Supplier symbol to a slightly different position
on the perimeter of that symbal to clarify the data flow.

Supelier |

I‘él}-;

! Figure 3.21 Poor Connection End Polnt at Symbol

EasyCASE Plus Varslon 3.1 Baglnner's Tutorlal

To change the connection end point at the Supplier exicrnal entity symbol:

1. Scleet the data fMlow connection that is an input to the Supplier symbol,
The connection is highlighted with all of its markers displayed. You will be
accessing one of the markers at the ¢nd of the conncction.

i Order. |
Processing .
: Syskem .

Flgure 3.22 Selected Connection

2 Click on the marker box located at the connection’s €nd point, coincident
with the Supplier symbol as shown in Figure 3.22.

3 The preceding section of the connection is removed (from the selected end
point back to the last change in dircction), The marker moves (0 the new
end point, as shown in Figure 3.23,
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Figure 3.23 Connection with Last Segment Removed
4. Click the right mouse button once (o remove the other line scgment.
5. Sclect the Supplicr symbol by clicking on it.

6. The allowed ead points for conncction on the perimeter of the symbol are
indicated by markers, as shown in Figure 3.24.

Figure 3.24 Available Entry Ports at Destination Symbol!

T Click on the marker located hall way down the left side of this symbol.
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8. The connection is then revoutcd Lo this new end point,

N S.up-pli‘ew .

Figure 3.25 New Placement of Flow

Rerouting a Connection

'Although connections between symbols are automatically routed, sometimes the

routing uscd for a connection may conflict with other chart objects. Ta illustrate
this, you will add a new External Entity symbol just below the Order Processing
System symbol. You will then reroute the affected data flow inputs for the
Management and Payroll symbols so that they no longer pass through the new
symbol,

First, add a new external entity symbol that conflicts with lhc Management and
Payroll data flows as follows: .

1 Choose the 'External Entity option from the Objects menu,

P Click on the grid square midway between the Management and Payroll
extcroal entily symbols, as shown in Figure 3.26,

3. An external entity symbol is placed at that positien on the chart, on top of

the connections between the Order Processing System symbol and the
Management and Payroll symbols, as shown in Figure 3.26.
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: Figure 3.26 Placement of Extra External Entity

N‘,cn, reroute the affected Management apd Payroll connections:

il Select the Payroll data flow (click on the small box or “handle” located on
the conncction). The connection is highlighted and its markers are
displayed.

2 Click the left mouse bution on the connection end point marker at the

Payroll symbol end. .
The last lin segment is removed from the conncection at the selected end

: and the end point marker moves to the new end point position, as shown
1 in Figure 3,27.
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Figure 3.27 Connection with Line Segment Removed
3 Click the right mousc button, or press the BACKSPACE key, once oaly.

The remaining line segment is removed from the connection, There are no
line segments left on the conncetion,

4, Click the left mouse button inside the Payroll symbol.

Markers are displayed around the Payroll symbol to indicate allowable
catry positions for the connection,

5. : Click on the marker located midway along the top of the Payrolt symbol.

The connection is rerouted to the new end point, avoiding the cxiernal
entity symbol, as shown in Figure 3.28.
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The resulting connections should look like this:

:

N Ile Edit Objecls View Optlona Euplndn nn-lum Schuu unlltu lhl'p

: Or-der':_ i : : i ! :

Processing .
: Swstem .

Q
=8

LT g

Figura 3.28 Payroll Symbol with Connection Moved

6. Repeat Steps 1 through 5 for the Management data flow.

tobi b, Kou: L level: O File: NUDIFY.DFD  Tutorial Rudify Chart

Figure 3.29 Manually Rerouted Connections

Changing the Destination Symbol for a Connection

Besides changing a connection's end points on a particular symbeol, as you did for
the Supplier symbol, you can change the destination symbot for a connection. In
this section, you will try this by moving the destination for the data Mlow input
connection from the Payroll symbol to the new symbol.

To change the destination of the data flow from the Payroll symbol to the new

symbol:
1. Select the Payroll data flow (click on the small box or “handle” located on
) the connection). The connection is highlighted and all of the markers are
displayed.
| .
2 Click 0a the connection end point at the Payroll symbuol end.
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e

The tast line segment is removed from the connection,
Click the right mouse button, or press the BACKSPACE! key, once only.

Another line segment is removed from Lhe conncction, as shown in Figure
330.

P Order. .
Processing .
.\ System .

I Payroll,

Figure 3.20 Connection with LIne Segment Removed
Click the [eft mouse button in;idr. the new symbol.
The end points are displayed by marker boxes.
Click on the ead pont marker located on the top of the new symbal that is-
directly below the source end point on the Order Processing System

symbol, :

The connection is rerouled to the new symbol destination, as shown in
Figure 3.31.
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Figure 3.31 Reroutad Connection Dastination

Changling the Number of Arrowheads on a Connectlon

You can change the number of arrowheads uscd lor a specific connection, or for

-all connections. The Default # Arrowheads sctting in the Options menu affects

all connectioas. You use the Change # Arrowheads command in the Edit meny -
to change the number of arrowheads for a particular connection,

To cha-ngc the nymber of arrowheads for the connection beiween the Supplier
external entity and Order Processing symbols;

I Select the connection between the Supglier and the Order Processing
System symbols by clicking on its "handle.”

- The connection is highlighted, and its markers are displayed. You will
_observe that this conncction currently has a single arrowhead on it at the
Supplicr end. . N
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2 Sclect the ‘Change # Arrowheads' option from the Edit menu. Moving the Entire Chart
While you are develaping a chart, you need not be overly concerned about its

! position in the charl window. You can casily chiange this by moving all of the
chart objects together as a single unit, For example, the anly remaining problem
with the MODIFY chart in its position ln relution 1o the Title Dlock,

A dialog box is displayed listing the available arrowhead characteristics, as
shown in Figure 3,32,

—— Select # Arrowheads |——

In this section, you will use the Move Chart command to reposition the chart.

To move the entire chart as a uait: :

° 1. Select the Move Whole Chart command from the Edit menu.

o

1A fbjects View Optlons

Fra-t

Deleta object group Dal
Move object group RAlL+H

FEANCEL] Copy synbal /group

Change object type...
Change synbol siza...
Changa # Arrowheads...
Change direction

Figure 3.32 Number of Arrowhesds Optlons Diglog Box

3. Click on the 'Two-Way Double' setting. Salect group Cirl+C
Hova whole chart
4, Click on the ‘OK' button. 1 Text block... AlteY
.
S.  The Supplicr connection is drawn with double arrowhcads at cach end of Labe}l chject... AltL
i [dentify object... Altel

Flgure 3.34 Edit Menu containing the Move Whole Chart Command

This automatically zooms the chart window 1o full chart mode. The entire
chart is visible and sclected, shown by a dashed box outlining all of the
objects (except the title block) on the chart.

Supplier -

2. Press and hold down the left mouse button.

"3 Still holding down the left mouse button, drag the selection box one grid
square down and (o the right of the chart's present position (as shown in
Figure 3.35).

Figure 3.33 Connection Drawn with Double Arrowheads at Each End
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Your chart is now complete and, aside from possible spacing dilfereaces, should
look like this:

= Fila Edit Block Ulew Ohjects DOptions Ewploda UL1]ity
Dy -
IT,‘

=] Flle TdIt Objecis View Options Explode fnalyze Schema ULility Help

Tk

iellion

R pmem

Flgure 3.35 Selection Box ‘Dragging’ Chart Outline to New Location

!
4. Release the left mousc butlon,
5. A dialog box pops up in the center of the screen, prompting you to confirm
the placement of the chart,

6. Click on the 'OK’ option button to confirm the ncw position and re-display
the chart at Actual size.

Figure 3.36 Chart Re-positioned in Chart Window

This concludes the current lesson,
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In addition to the Data Flow Diagram (DFD) chart Lype, EasyCASE Plus also
offers several other chart types:

Chart Type Fite Extension

Transformation Graph TRG

Structure Chart STC

Entity Relationship Diagram ERD

State Transition Diagram STD

Data Structure Diiagram .DSD *
Data Mode| Diagram .DMD

Entity Life History .ELH

Logical Data Struclure . LDS

Creating a New Chart

For further practice, you may want to creale the following ERD chart:

P Teropesssd by ! ZJFNMW Frim |

PR

I_llblr s

Figure 3.37 Alternative ERD Chan

EasyCASE Plus Version 3.1 Beginner's Tutorial

You use the Change Type command from the File menu to access a different
chart type as lollows:

1. Sclect the "Change Type’ option from the File menu. If necessary, press the
15C key to bypass the Save chart 7' dialog box if il appears,

A listing of the supponted charl types and symbol sets is displaycd In the
form of & pop-up list box, as shown in Figure 3.38.

Data flow - YourdonsDeMarco (dfd)
- Data flow — Cane- & Sarson. (dfd)
“Data flow = SSADK 4 (dfd). .
Transfnrnatiun graph -'Yuurdun (trg) :
“fransforeation graph - Gane & Sarson. (trg)
State:transition dfagran (std) :
Structure chart. (stc):
¢ Entity relationship —-Chen (erd]
.. Entity relatlonship — Martin-(erd) ..
*”Duta nodel diagram:- Bachnan (dnd) '
" Data nodel diagran - Martin - (dnd i
."Data.structure.diagran (dsd) .
““Entitg Jife history - SSADH v4 (elh)u»
: ;Logical data structure - SSADN v4 (lds

Figure 3.38 Listing of Supported Chart Types and Symbol Sels

2 Click on the 'Entity Relationship Diagram-Bachman {(ERDY cotey to
select it

L The EasyCASE Plus chart window screen is cleared and the Tile Block
and screen information updated for the new chart "UNTITLED.ERD",

Froiect: D\TuﬂECPLUSm\SAMPLES\_' S
Ieaname Unjiled.erd :
harl crealedon .

Figura 3.39 Changed Title Block
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4, Notice the changed object type icons displayed to the left of the chart
window. These represent available chart object types for an ERD. The
cotries in the Objects menu are similarly updated.

LESSON 4
OTHER CHART FILE OPERATIONS

Overview
This lesson covers:
= Saving a sclected group of objects to a new chart
»  Merging a saved charl into a currently foaded chart
= Dcleting a chart '
For this lesson, you will use the TUTORL.DFD chart you created in Lesson 2.
This lesson sl':outd take you approximately 15 minutes to complete.

Saving a Group of Chart Objects

Rather than always saving Lhe complete chart, you may only waat to save &
sclected part of a chart. You can do this with the Save Block option in the File
menu.

To save the Order Processing System, Supplicr and Payroll symbols arca of the
chart: )

Figure 3.40 Bachman ERD Objects Icons

1. Select the Order Processing System, Supplicr and Payroll symbols wi|.h
their associated connections as a group, following the procedure provided
in Lesson 1, as shown in Figure 4.1,

Il necessary, refer 1o the procedures in Lesson 2 and this lesson to create a chart
bascd on the sample that you have chosen.

For More Information

See "Sclecting, Placing & Manipulating Chart Objects” in Chapter 5 of the
EasyCASE Plus Chart Editor User's Guide.
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Figure 4.1 Selected a8 Group of Chart Objects

2 Scleet the "Save Block' option from the File menu, or press CTRL+B.

i A dialog box pops up prompting you for the filename to use for saving the

selected block, as shown in Figure 4 2. The default filename is
FRAGMENT DFL),

+

Save Filenane: | fragment.did |

[ Yes) L Ho ] {Cancell

Figure 4.2 Prompt for Chart Filename to Save Selected Object Group

4. Click on the "Yes' option to save the selected chart object group to a new
chart using this defaull filename.
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5.

6.

A second dialog box then pops up prompting you for the name to use for
the new chart, as showa in Figure 4.3, The default chart name is
*{ragment”.

———————] Saloct dfd Name }——F—

1D: jfragmonl]]

.. Sample”
Sanple

anple.

:- tutorl

. DFD ﬂbJBCtS (Cane & Snrson)
4. DFD ObJjects -(SSADH): ..
;. DFD Objects: (?ourdon/DeHarcol
«|:. EasyCASE Plus Context Diagran
-7 Sample (EasgcnSE Plus) DFD :

‘DFD~

l’ruJect Contaxt Diagrnn
anple Project’ Level O DFD
anple Project Process 1 DFD
Project.. Process 2 DFD
‘Tutorial” Modlfg Chart

L 0OK.1

fCancell m_

Figure 4.3 Prompt for Fragment Chart Name

Click on ‘OK’ 10 accept the defauh chart name presented.

The selected charl area is saved 1o Ole FRAGMEN'I'.DFD 'mllhl: cuerent
project directory.

The saved block of objects is still selected. Leave the Llock selecied for the next
(Merge Chart) operation.
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|
Merging a Chart

You might want to merge a saved chart into the current chart. This procedure
could save you time if you plan on using the same chart structure on more than
one chart,

To merge the FRAGMENT chart you just saved into thc current chiast:
1. Choose the 'New chart’ command from the File menu.

: ‘ 1N fdit Objects View

Heuw chart... Ctri«N

Changa type... CirlsC
Load chart... CtrleL
Merge chart...

Delete chart...

Save block... Ctrl+B
' ) Save chart Ctril+S
Save fis. ... Ctrl-+A
Export chart.. Cirl+E

Print/Plot... Ctrl+p
Printer setup...

' Change project..

fbout. ..
Exit to DDS... Ctrl+X

Flgure 4.4 File Menu
2 An cmply chart is displayed.
3 Select the "Merge Chart’ option from the File menu.

4. A listing of the DFD charts avaitable in the current project dieectory is
then displayed, as shown in Figure 4.5,
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5. Click on the FRAGMENT chart entry (the chart object group that you
previously saved).

—————| Select Hame of DFD Chart to Load |--———

B

‘DFD Objécts (Yourdon/DaMarca) oblectyd. d{’df'
CooyCASE Plua Contoxt Dlagran ocpcontx.dfd

. Sanmple (Eaau(.‘nbli Plus) DFD sapycase .dfd
_'Sanpla DFD T sanple.dfd ;-
“ Sampla Praject Conlext Dlngrnn context. dfd; -

~ Sanple Project Level B DFD . sop_B.dfd

= Sample Project Process 1 DFD sop_l.dfd

| Sanple Project Process 2 DFD = sop 2.dfd '
~ Tutorlal Hodify Chart. nodify.dfd

fragaent fragnont .dfd |

0k % {Cancell

Figure 4.5 List of Charts Avallable to Merge
6. Click on the 'OK'’ option button.

7. A dialog box pops up to conflirm merge of the FRAGMENT.DFD chart,
as shown in Figure 4.6.

——————— Werge chart 7 }———
[ YES | L Ho 1] &

Figure 4.6 Prompt to Confirm Merge Chart

8. Click on the “Yes' button,

9. - Position the mouse pointer in the upper lefl corner of the chart window as
shown in Figurc 4.7, :
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Figure 4.7 Mouse Polinter Positioned to Merge Chart
1

10.  Click the left mouse button onec.,

The FRAGMENT.DFD chart is then merged with the Yank chart at the
original position of the saved block, as shown in Figure 4.8,
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=|Flle Edit Objects Ulew Optlons Explode finalyze Schens UL1lity Help

Flgure 4.8 Marged Chart

Deleting a Chart

You no longer nccd the FRAGMENT.DFD chant containiné the saved block of
objects, so delete this chart, rather than using up storage space as lollows:

1, Select the "Delete Chart' option from the File menu (see Figure 4.4).

2. A listing of the available DFD charts in the current project directory is
displayed.

3 Click on the FRAGMENT chart entry.

4, Click on 'OK.
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SI Y h d fy th delele th
. ou are then prompted to verify that you want to delele the
: FRAGMENT.DFD chart, as shown in Figure 49. LESSON S -
i DESCRIBING CHART OBJECTS TO THE DATA
DPalote chart filae : fragnent.dfd 7 DICTIONARY
T.YEST) € N3
:' .
Figure 4.9 Prompt to Confirm Deletion of Selected Chart File Overview

6.  Click onYes’ This lesson covers:
T You are then prompied to verify that you want to delete the data a  Overview of chart object identification
dictionary cotry associated with the deleted chart, as shown in Figure 4.10, . :

! Delete Object Entry from Data Dictionary 7 = Identifying objects

Object Type: did = Data Dictionary Entry (DDE) screen access

Identifler : f A .
entifier roamen You should now have 8 working knowlcdge of the skills covered in Lessons 1

through 4. The exercises in the following lessons build on these fundamental

" [YES] [ Ro) oo

To save time, certain operations are mentioned but not the mechanics of bow to

Figura 4.10 Prompt to Confirm Delation of Deletad Chart's Data Dictionary achieve them, as these have been covered in prior lessons in detail,

4 ENN
i For cxample, rather than directing you to load a chart and specifying the steps

involved, you are simply directed 1o load the chast. Refer 10 the appropriatc parts
of the previous lessoas if you need to refresh your memory.

8 Click on 'Yes.'

The data dictionary entry for the FRAGMENT chart is marked lor
delcetion, and the FRAGMENT.DFD chart is deleted.

[

This lesson should take you approximately 15 minutes to complete.

You will nced to use the TUTOR1.DFD chart you created in Lesson 2 to
complete the exercises in this lesson. If this chart is oot currently loaded, you will
nced Lo load it now, as described in Lesson 3.

NOTE: To permanently remove an identifier [rom the data dictionary, use the

* Pack command in the Data Dictionary and Reports Manager (DDRM} utility,
For More Information The Data Dictionary
'Sce “Selecting, Placing & Manipulating Chart Objects” in the EasyCASE Plus
' Chart Editor User's Guide.
1
|
| |

The data dictionary stores information aboul chart objects and consists of
"entrics® or groups of attributes defining an object. Each ¢ntry in the dats-
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dictionary has a unigue identifier. However, 1.i.liple chart ebjects can be
identificd by a single cntry in the data dictionary.

s :g'dpr R Ne—
'___9_ . F1o essing.

System |

NOTE: In the EasyCASE Plus documentation you will see dala dictionary eatries
referred to by the acronym DDE,

t,

Some of the sttribules (hal you speaily in i aata S sy oo
cstablish functional relationships or “links” to associated chnns or lext lnlc.-,. urto
define data structures {such as records and clements). You will learn bow to use
these features in Lesson 6.

When you created objects in (he Basic Skills Tutorial the objects were simply . Figure 5.1 Selected Data Process Symbol
graphic symbols that you could modify or delete without affecting anything clse in
the diagram or project. They were not identified in the data dictionary and so did
oot have any potential for “real” functional refationships, and were not re-usable

clsewhere in the project.

2 Sclect the sdentify Object’ option from the Edit menu, or press ALT+1.
3. The identifier dialog box for the symbeol is displayed, with the cursor

located in the text entry box at the top of the dialog box, as shown ia
Figure 5.2,

———| Select Data Process Hane |————-
-\ e

It is as though to be operable, each object has to have the equivalent of a Social
Security number to uniquely identify it and that enables it to develop recognized
assocations with other data. The key word is "data™, An object has to have a data
componcnt, its unique name 1o the data dictionary, before it can be a functlional
member of the chart,

By identifying chart objects and defining them in the data dictionary, you begin to
- lap the full potential of EasyCASE Plus.
1

ldentifying Chart Objects *

Throughout the Basic Skills Tutonal you created and modified objects that were
00 identificd in the Data Dictionary. This is the main method of developing
charts, When you have completed a chart, you can then go back and “manually”
identify each object. This method is good for quickly prolotyping charts, without
having to be concerned with the undeelying functional aspects. You can also
manually identify objects immediately alter you place them.

.

PRD NN D

NRNNN oo

Manually ldentifying Chart Objects

Having created the TUTOR1.DFD chart without identiflying any of the objects I 0K 1] " [Cancel]}

(symbols and connections), you can now identily them as follows:

1 Select the dala process symbol labeled "Order Processing System”.

) Figura 5.2 Identitier Diéfog Box
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Any identifiers for any ather Data Processes already defined in the data
dictionary for the Sample project are lisied below the text entry box.

NOTE: 1fthe symbol was already identificd, the identifier would appear in the
text entry box and highlighted in the list.

4 Y Udey i e oot v boe g chweecin Fipae
5.3. This will be thc symboli idcnuﬁcr : :

l————[ Select Data Process Name }——

:|Order, Process Ing Systen]:

Ci:0K: D CCancel]

Figura 5.3 Symbol Identifler in Text Entry Box
5. Click on the *OK’ button.

6.  The symbol's Data Dictionary Entry data entry screen is displayed as
' shown in Figure 5.4. The top two lines of the dialog box show the name
. (Order Processing System) and type (Data Process) of the sclected symbol
| you just identified.

EasyCASE Plus Version 3.1 Beginner's Tutarlal
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————————{ Chart UbJject DDE Screen j o---

DDE Hame: Order Processing Susten
PDE. Type : Data Process
Lagt Mod: John R. Hopking
Creator : John R. Hopking
ﬂhinr-t Explodos To @
RTINS FEf T
Nane i -

Feh-19-1992
Feb-19-1992

Aljas: :
Misc #1: - - -
Misc #2: -
Misc #3:

LLABEL) [Defin] [Desérl [ OkS) [QQft)

Figure 5.4 Data Dictionary Enlry Screen

Notice the current attributes defined for the chosen objeat:

The Name (icld shows the ideotificr for the symbol (cannot be cdited),
The Type field indicates the type of the symbol (cannot be edited).

The Last Mod (modificd by) attribute is the name of the person who last
modificd the Data Dictionary Entry for this symbol (cannot-be cdited) and the
date the modification was made.

The Creator (created by) attribute is the name of the person who created the
DDE for this symbol (cannot be edited) and the dale of creation,

The [Label] button allows access to the existing label for the object. Although
you can cdit the label, do not do so at this time. It is the same label as the one
you entered by choosing the "Labe! Object’ aption [rom the Edit menu afier
you placed the abject on the chart.
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NOTE: Do not be concerned with the other nphons displayed at this point. W:
will address those in Lesson 6.

7. Click on the "OK' button or press 73 to retuen {o the chart.
Doih the symbol and ils label are xelected.

8. Press the ENTER key to leave the label posilioned at its original position.
You have just defined the selected chart object in the data dictionary.

9. Repeat steps 1 to 5 for the Customer, Managemeat, Supplicr and Payrotl

external entity symbaols, entering identifiers of "Customes®, "Management”, *

“Supplicr”, and “Payroll” for cach respectively.

Automatically tdentlfying Chart 6b]ecls

If you prefer, rather than creating your objects then going back and identifying
them, you can choose to have EasyCASE Plus automatically prompt you to
identify objects when you create them. Although this adds some time o the chart
creation process, you do not have to return to the chart later (o finish defining the
objects in the data dictionary,

As a convenicnee, you can set the ‘Auto Identify option On. In this case,
EasyCASE Plus will prompt you to identify each object as it is placed on the
chart. This saves you the step of invoking the Identify command from the Edit
menu afler placing an object on the chart,

To set the ‘Auto [dentify’ option to On:

1 Select the Options menu.
2. Sclect the Preferences entry,

A dialog box will pep up listing a number of avaitable oplions, as shown in
Figure 5.5,

3 Click on the ‘Auto dentify option to set it to On. When it 15 On, an ‘X" will
appear to the left of this option's text.

EasvyCASE Plus Version 3.1 Beginner's Tutorial

F—_' Set Options J————

futo Identify

Nuto Label

Allow Place Heu Label
Muto Export ta JUNSE
Auto Export to SDF .
‘Ruto’ Export:.to HPGL .
Update:Label: from DDE:
-Flag Deletad DDES IDs”
1Harning baap
-Creaate- backup char
Use named charts

-

AR e foxu

0K .1 LCNNCEL D

.Figure 5.5 Preferences Dialog Box

4, Click on the 'Cancel' button.

NOTE: There arc a number of options in this dialog box that control the
operation of the chart editor, These are described fully in the Chart Editor User's
Guide.

Additional Information

You would use the same approach for identifying connections on any chart type,
and for couples on structure charts.

NOTE: You do not strictly have to identify chart objects. If you de not howcver,

you will be unable to link them to other charts, text files or data definitions as
deseribed in Lesson 6. '

For More Information

See "Describing Chart Objects lo the Data chllunary' in Lthe EasyCASE Plus
. Chart Editor User's Guide.
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LESSON 6
LINKING CHART OBJECTS VIA THE DATA
DICTIONARY E

Overview
This lesson covers:
» The Data Dictionary Entry (DDE) screen
= Establishing a link to another chart
s Using the Explode commands o access the linked chart
» Establishing a link to a text file
» Using the Explode commands to edit the Linked text file
Before beginning this lesson, you should be familiar with the material covered in
Lesson §, in which you simply identified several chart objects and bricfly accessed
the corresponding Data Dictionary Entries (DDEs). You did oot actually add to,
or modify, any of the DDE information.
You will need to use the TUTOR 1.DFD chart you crcated in Lesson 2 {and
updated in Lesson 5) to complete the exercises in this lesson. H this chart is not
currently loaded, you will need to load it as described in Lesson 3.
This lesson should take you approximately 1 hour to complete.
In previous lessons you assigned the fundamental attributes for your Dara
Dictionary Entries. The objects you identificd can now be uscd to establish

relationships: functional links to other charts or text files 10 create a hierarchy for
your project filcs as described in the following sections,
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4. Click on 'OK’ to retain that identificr,

Linking a Chart Object to Another Chart

5. The DDE screen is displayed for the selected *Order Processing System”

In this scction, you will use the Data Dictionary Entry for the “Order Processin r the
yo nd ik ‘ Data Process symbol, as shown in Figure 6.2,

System” Data Process symbol as an example and link it to another chart.

Access the DDE for the "Order Processing System® data process symbol as .Char‘t Object DDE Screen | -
follows: — l ’

DDE Hame: Order Processing System

1. Select the "Order Processing System” data process symbol. It will be
DDE Type: Data Process

highlighted. . !
: Last Mod: John R, Hopkins Feb-19-1892 ]
2 Sclect the 'Identify Object’ option from the Edit meou, or press ALT+1, . Craator: John R. Hopkins Feb—19-1932
Object Explades To :
3. The ideatifier list box is displayed with the identifier *Order Processing J'[gpe : . LFilel ‘
System” in the text entry box, as shown in Figure 6.1. A highlight bar Hane:f]" o ' N

appears over that entry in Lhe list indicating that the identilier is assigned
10 the sclected chart object. ’

—— Select Data Process Hane f———

1D :j0rder Processing -Sustea: ©:’

filias: 7.7~
Nisc 81:
Wisc #2:
Misc #3:

LLAREL]  CDefinl  [Descr] Lok COsit]

< T i : el
' Processing Susten
SO 1.1 " N} Figure 6.2 DDE Screen Displayed for Selected Object
. SOP 1.2
isop 1.3 ° , o

"SOP 1.4 . Note that the Explodes To Type and Name attributes are blank m.dlcztfng that
S0P 1.5 ' the sclected chart object has not (yet) been linked 10 any other child object.
SOP.1.6 .

SoP 1.7 Tn this section, you will create a link feom the *Order Processing S{ystem' data
S0P 2: - process symbol to the MODIFY.DFD chart (another DFD chart in the
SoPi2.1- SAMPLES project directory).

The link associates a specific charl object with another chart. You then use the
L 0K 1] [Cancel] ‘Explode Down' function to load the linked chart.

Ta specify the name and type of the chart 1o link to:
6. Click on the up/down arrow icon next to Object Explodes To - Type ficld.

Figure 6.1 identifier List Box with Objec! Identifier Highlighted
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7.

10.

——-———| Chart Object DDE Screen p——m—

A dialog bor, listing the available child chart types, data definition 1ypes,
and text file types is displayed, as shown in Figure 6.3,

—| Child Object Type }—-

DDE Mame:
DDE Type: o Racord
Lagt Mod: o Element . . |b=19-1992
Creator: o Control Tahla b-19-1992
ObjJect E )

Tupe: o tut: .

Name : ¢-doc:

opps. v

Alias: o cts’
Nisc 81: o apd: AN
Misc #2:
Misc #3: | [Cancell
ELAREL]Y Lhuit]

Flgufe 6.3 Dialog Box Listing Avallable Child Object Types
Click oo the 'dfd' button to selegf il.
Click oo the "OK' oplion bull.on.
The text 'dfd’ appears immediat¢ly to the right of the Object Expledes To -
Type ficld indicating that a link is being established between the selected
data process symbol on the current DFD to another data flow diagram.

Next you will specify which particular DFD, by name, you want to kink to.

Click on the up/down arrow icon next ta the Object Explodes To - Name
field. '

A dialog box appears listing 1he names of all existing, available data flow
diagrams so far described in the data dictionary, as shown in Figure 6.4.

I
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11,

12,

13

————] Select dfd Hame }————\ |
—— 1:|Tatorfal Hodify Chart ||— '
D : -
DD DFD Objects (Cane & Sargon): ’
La DFD Ohjocto (SSADM) 992
C -DFD- Dbjects (Yourdons/DeMarco)’ 992
0} {- EasyCASE Plus Context Dlagran'. |
- Sanplea.(FasyCASE Plus) DFD.
. Sanple DFD .
:Sanpla- PmJect Contaxt Dlagran .
“Sanple ‘Project Level B DFD . -
H -Sample Project Process 1 DFD
M Sanple Project Process.2 DFD
M Tutorial Hodify Cbmt
fragnent ,_o;.,.__ DA sl
L L OK: "1 {Cancell -—J

Figure 6.4 Dialog Box Listing Avaifable DFD Charts
Select the Tutorial Madify Chart’ entry by clicking oa it.
Click on ‘0K

The Data Dictionary Entry screen lor the Order Processing System is
redisplayed as shown in Figure 6.5. Notice the entries in the Object
Explodes To - Type and Explodes To - Name fields arc those you just
chase from the lists. In this example, the DDE screen shows that the data
process named "Order Processing System”™ has been linked 1o snother data
flow diagram (d{d} named "Tutorial Modify Chart.” In the next section you
will traverse Lhe linkage and access the named ‘child’ chart.
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14,

——————] Chart Object DDE Screen j——— —

-DDE Hame: Order Processing Systen
DDE Tuype: DPata Process
Laut Mol @ 2ol B, Hopklneg
Crecator: John R. Hopkina
Object Explodes To
Tupe :(dfd L EALED
Hane s}{TutorfaliModify Chart e

Tal-20-19492
Veb-14 1902

fillag:
Misc H#1:
Misc #2:
Misc §3:

CLiBE)) (RSESHA Deserd LK1 CGuif)

Flgura 6.5 DDE Screen with Linked Chart Eniry

Now click on the [Desaf button.

A text entry box pops up, cm:rlnyi.nilhc DDE screen, as shown in Figure
6.6. This text entry box allows you 1 add a short description aboul the
selected data process. *
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16.

17.

18.

————— Chart Object DDE Screen f—

DDE Hame: Order Processing Systen
DDE Type: Data I'rocess

laat Mod: .John R, Hopking
Cocator: Julin KB, HMoplinng

——-| WHURY DESCRLE LN

Foh-20-1992
Fah-19-1992

(Labell [Deflnd [DESCHL.  [.0k3 [Quitd

Flgure 6.6 Short Description Figld Text Entry Window

Type the following short description for the Order Processing System
cotry: *Process representing the entire Order Processing System®,

Press the £3 key to complete entry of the short deseription.
Click on "OK' to return to the chart,
The object label is highlighted along with the sclceted symbol,

Click the right mouse button, or press the ENTER key, to accept the
currcat position for the symbol labet,

When you accessed the DDE screen in this example, you defined a link between
the sclected chart object and another chart via the data dictionary (chant of type
DFD pamed Tulorial Modify Chart’). You can now ‘explode’ down from the
selected data process to the designated chart, as deseribed in the next section,
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i .
Exploding To and From a Linked Chart

Once you have established a link 10 a chart, it is a simple matier to "explode”
d?wn to the Child chart, automatically loading it into the chart windew ready 1o
be worked on. To do this, you select the object linked to the chart, then use the
‘Down’ optioa from the Explode menu.

To explode 10 the linked chart from the Order Processing System data process:
1. Seled the data process symbol labeled "Otder Processing System” by
clicking on it. The symbol is highlighted.

2. Sclect the Down a lxvcl"oplion from the Explode menv, or press
CTRL+D, or click on the explode down icon Jocated in the Jower left corner
of the chart window.

ETIGLEN Analyze Schema
Top level Ctrlel

. Up a level Ctrl+U
]- Dowun a level! Ctrl+D

H Define top level...
! Update explosions
Show explosions

L]
Figure 6. 7.Explode Menu

! If the current chart has changed since it was last saved, you are prompted
t  to save the chan, To do so, click on the "Yes' butlon.

3! The linked {child) chart (MODIFY.DFD) is loaded and displayed in the
chart window ready Lo be worked on, as shown in Figure 6.8,
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55 Ry A B

Flgure 6.8 Child Charnt Displayed In Chart Window

You can cxplode back to the parent chast (TUTOR1.DFD} by using the 'Up’
optios [rom the Explode mecou, as follows: .

1. Select the *Up a Level option from the Explode menu, or press CTRL + U,
or click on the explode up icon located in the Jower left corner of the chart
window,

2. The parent chart (TUTOR1.DFD) is loaded and disptayed in the chan
window.

Only one chart can be loaded at a time. However, exploding from/to a chart is a
quick and casy way to move between linked charts,
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Linking to a New Charl

You have just defined a linkage from a existing chart object to another chart via
the data dictionary, However, the chart that you wish to link to need not alceady
exist. The new chart is created as you complete the link by allempting lo access it.

To do this, you will use ilic ‘Down a Level' aption fram the Explode uu:nu:

1, Sclect the "Customer” external entity symbol by clicking on it.

2, Select the Toown a Level option from the Explode menu, or press
CTRL+D, or click oo the explode down icon located in the lower left corner
of the chart window.

3 You will be asked if you wish to save the chart if it bas been medificd since
it was last saved.

Click on 'Yes' to save the chart,

4, A dialog box is displaycd and lists the available child object types {charts,
© text files, data definitions), as shown in Figure 6.9,
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I’_,_l_l'lln E41t Dhjocls Visw [Optlons Dtplou ﬂmly’u Schom Ulllltu H-l;

i cniig nhje:t Tupe }—.q :

*+dfd ¢ Rocord

«irg #» Elanant

*ard ¢ Cunlyul Table
+ alc

s std. o tat

+ded ¢ doc-

¢dnd’ ¢ ppe o+~

o] s alh - o cts

¢ 1dg. eapd:

(oo (Cancel]

Figure 6.9 Avallable Child Oblect Types

5. Click on the ‘erd’ entry to choose an Entity Relationship Diagram as the
child chart type you want 10 link to,

6. Chlick on 'OK.’

1. A dialog box is displayed containing the identifiers for ERD chart fypes in
the cusrent project. The 1ext entry box at the top of the dialog box is empty
aud rcady for text entry.

8. Type "Customer Operalions” in the text entry box, as shown in Figure 6.10,
This 1s the name of the ERD 1o link to.
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«[Tile Edit Objects Visw Optlnm Drrlodc

fina lyzs Schnl Ulllltu llIIp

L q;tmgg

_.-—--—-{smce.mmk——-—'_i_i

m[cu‘.tom Creratiomsd .

]

Dala Dictionary Inlrinn

Rats Flow Dlagran
ERD 02 Jocte
IRD Synbals

{Sanple: (Bachnan) EXD .-
Sanple (Martin} Dluhun .
Sanple Chen ERD - .

" ‘Sanple Elmasrl & H.mlu mp ;

;. Sanplw SOP ERD (Bachnan}*

" Sanple SOP ERD (Chen) :

i Sample;SOP ERD (Martin)

Figure 6.10 Child ERD Identjlier In Text Entry Box

9. Click on 'OK

~10. A dialog box then pops up and you are prompited (o verify that you want to

v ¢reate the specified child chart entry in the dota dictionary, as shown in

Figure 6.11,

!
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ﬂl‘llc [4lt ObJects View Uptlomw l’xplod- nn-lu-n Schun-l uulltu Hllp

e r—--—u-— .
: _..____| Creste nou child object DBL 1 |—-—-——-.

bJoct Tupet wrd
tdunt 1l Custlonsr Upuraliume

Figure 6.11 Prorﬁpr to Create Chlid Chant Entry In the Data Dictionary
11.  Click on 'Yes!'

12, You are prompied to coter the filename o use for the ERD chart file, as
shown in Figure 6.12.

13.  Type “CUSTOPS.ERD" in the text cotry box, to be used as the filename
for the child ERD charst.
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Pt e

-,l,'._”.. [drlt- Objects View upt.tuu Ixpluds (i lye  Sbona Uikl

s

[ File E¢it ObJects Ulew Optlons Explode Amalyze Schens UVility Halp

iy

i e T R S N
i 00 S e vy 7 o B R ey % |0 nn P T A e e B T R
“ol: }, Rowt & Level: L Fide: mODIFY. Madify Chart [} col: i, Bou: & Level: O Tile: RODIFY.DFD  Tutorial Modify Chart
Enter eliild chart filenane. ... Zhact file DINTUINECPLUS3INSANPLESNCustops.erd does not exist. create it 7
Figure 6.12 Text Entry Box for ERD Chart Fitenama Entry Figure 6.13 Prompt to Confirm Creation of New Chart
14,  Click on'Yes.' * 16.  Click on 'Yes.
15.  You arc prompted to verify thal you want to create the new ERD chart, as 17.  The new CUSTOPS.ERD chart is then created, and a blank chart is
shown in Figure 6.13. displayed in the chart window, ready lor you to work on, as shown in
Figure 6.14. .
. ] .
: s
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~| Fila Edit Objecte View O'Pllum D(‘plodu fnalyre Schema Utllity lwlp
B:" huuwbt»mu-smhm. T Piooon : ‘
T

A inn ]

P At T
“"'d'uiz

Figure 6,14 New ERD Chart

18.  Sclect the 'Up a Level” option from'the Explode menu, or press CTRL+ U,
or click on the cxplode vp iconsto move back to the pareat charl
{TUTOR1.DFD).

19.  You ar¢ asked to confirm if you want to save the new chant. Click on the
‘No' oplion or press the ESC key,

You have just established a link between the Customer exiernal cnmy on the
original diagram 10 an ERD,
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Establishing a Link to a Text File

A text file can also be specificd as a child object. This allows you to explode 2
chart object to a note file, primitive process specification, or control specification
in textual form, A text file is an ASCIL Ble with extension TXT, .DOC, .PPS, or
.CTS. When you explade feom o chart object 1o a text [ile, 2 text editor is also
loaded.

This approach will also enable you 10 access an external documentation too!
rather than a text cditor, such as a Now charter, and pass the namec of a file to it.
This is described in more detail in Chapter 9 of the Chart Edilor User's Guide.

Before you can explode down to a text file you must first select the default text
editor as follows:

I Choose the 'Set Defuult Editor' aption from the Options meou.

2. If 4 text editor has already been chosen, its name wilt be displaycd on the
prompt Line at the botlom of the sereen, in the form of a full pathoame
and filename.

A lext eatry box will appear on sereen, as shown in Figure 621, and
contains the specification (drive, pathname and filename) of the currently
chosen text editor, if any. Initially it will be blank.

3. Assuming that you intend, for this cxample, 16 use the default text editor
EDLINEXE, supplied with your version of MS-DOS, enter the text: ‘

’ C:\DOS\EDUN.EXE

into the text entry box and then ¢lick oo the "Yes' option button.

Now, whenever you explode down to a text file, this (primitive) text editor
will be uscd.
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i -
To link a chart object 1o a text file, use the Explodes To attribute fields in the
data dictionary cotry screen of the abject just as you set up a link 1o a chart file

previcusly.

-_-]_fllo [dit ObJects Ulew (}ptlom [xp!ndn fina lyre Sc)m Utllllq lluly
u‘wwuuma——"— A A S A I

........ Load the TUTORI chary, if it is not already loaded,

To sct up a link to 2 tex file:

Tewt Ldltior:

1 Select the external ety aymihal lubeled "hMunngement®,-
[ Yen ] [ Ho ] . {Cancall

2 Choase the "‘Wentify Object’ option from the Edit menu. You will be
prompted for an 1D for the object, which will be ‘Management’ by default.
Click on the "OK option Lo use that identifier, as shown in Figure 6,17,

] Select External Entity Hame j——of

B B LA (E RIS IPRIAS LA R R S ID: |Managenent§
..... Brake -
. . Clutch
: l TOBL.DED tutort
Eoter mm File Sm:iriuuou a:\Patinrile.Ext)..,. 4. Credit Card Conpang
. Customer o
. . ) ) * Drive-Shaft |
Figure 6,15 Enter Path to Text File Editor Dialog Box - Driver
. . . ) o "Engine
Alternatively, you can specifly your own particular favorite text editor such "Fuel Tank
as Briel, the DOS 5.0 editor, cte., or even the name of your word Cearbox
processor. For further details on how 10 do this, refer 1o C!uptcr 9 of the " Irivent Han d
Chart Editor's User's Guide. . P:y?g l(]JI":I on . ' ..
SSwpplier .0 b
Text Editor: (C:rdosvedlin.exef
[ 0K 1 [Cancell
[ Yes ) [ Ho 1 [Cancel]

Figure 6.17 Entered Chan Object Name in the Text Entry Box
Figure £.15 Enter the Path to the* Text Editor Executable File
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The DDE screen will appear. The Object Explodes To (Type, Name)
ficids will be blank.

Seleat the ObJCC! Explodes To - Type attribute field by cl:ckmg an the
up/down arrow icon, as shown in Figure 6.1R,

| Chart Objoct DDE Sereem |——~

DDE Hame: Hanagerent
DDE Tupoe: External Entity
Last Mod: John R. Hopkins Febh-20-1992
Creator: John R. Hopkins Feb-20-1992
Object Explodes To

Type: ‘ ) [filel

Allas: i
Hisc 81: .
Kisc #2: -
Kisc !3;;

LiatrL} [befin] ([Descr] [.Ok:'1 [Oirit]
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Figure 6.18 Cursor Polsed over the Explodes To - Type Field

A dialog box will appear containing the list of valid child types, as shown in

Figurc 6.3.

Choosc the 'ixt’ entry by clicking on it, then choose "OK. The text txt’ will

appear immediately to the right of the Explodes To - Type field name.

Select the Explodes To - Name attribute ficld by ¢licking on the up/down

arrow icon nexd to ths field.

A dialog box will appear containing a list of availsble text file eotries as

shown in Figure 6.19. Type in""Management” as the identifier (or the tex

(Je, then choose ‘OK!
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9.

10,

—————} Chari Object DDE Screen e

DDE Hame: Managenent
DDE Typa: Ixtornal Entity :
Last Mod: John R. llopkins Feb-20-1992

Craator: Johm R, Hopking Tol-20-1992
Object Luplodes To

Tupe :Bt;xt EYILEY

Hane :{Managenent ‘ Coe

Alias: .
MNisc #1: &
Misc 42:
Hisc #3: : . = ~ .-

[LaLell [Definl [Descrl L0k 1 [Quitl

Figure 6.19 Selected Child Object Type and Name in DDE Screen

)
The text file name will appear immediately 1o the right of the Explodes To z
- Name fickd. |

Select the [OK] button in the data dictionary screen Lo exit.

Press ENTER Lo place the fabel for the Management external entity.

You have just finished describing the link to the child chart object (a named text
file) in the data didionary nof the text file name icself,

To provide a filename for the text file to be entered in the data dictionary:

L

The chart object should still be selected. i1 it is not, re-select it by cl:ckmg
on it.

Scledt the 'Down a level command {rom the Explode menw. '
A dialog box will appear prompting you 1o save the chart. If 5o, choose the

“Yes' oplion.
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4. A dialog box will appear prompting you Lo coafirm creation of the data
diciionary entry for the tlext file as shown in Figure 6.20. Choose the "Yes'
option,

~————— Create neu chlld ohject DIE 7 —— .

Ohject Type: txt
ldont!fier : Nanagemoni

[ Yes ] R HER

Figure 6.20 Prompt to Create DDE for Text File

5. A dialog box will appear prompting you 1o confirm ercation of the new text
file, Choose the "Yes option.

6. A dialog box will appear prompling you for the name of the text file. Enter
“Mpmt.a” as shown in Figure 6.21, then choose the "Yes’ option.

Enter Chart Tilename: |Nont.tut{

[ Yes ] [ Mo 3 {Cancell

1

~

Figure 6.21 Enter Text Filename

7 The chosen editor will be run and you will be able 1o access the lext file
oamed MGMT.TXT.

B. To return 1o the cliait editor, exit or quit [rom your text editor.

EasyCASE Plus Version 3.1 Beginners Tutorial

Establishing a Link to a Record

When a chart oliject is to be assoctated with a data structure definition, you link it
to 2 Record definition that sllows you to define a data structure.

When you establish a-link to a record, you nced to establish a data dictionary
cutry for the Record, just as you did for chart objects and text files, The
components of » rrcord are the apecilic dutn liekds and are reprcaented by
clements,

In this section, you will load the TUTOR1.DFD chart and establish a link to a
record used for information about Payroll, The components of this record define

data such as the Employce Number, Name, Position, and so on,

To establish a link 10 2 Record:
1. Load the TUTOR1.DFD chart,

2 Select the external eatity symbol labeled "Payroll” by clicking on it.

3. Select the 'Down a Level option [rom the Explode menu, or press
CTRL+D, or click on the cxplode down icon,

4. A dialog box pops up listing available child abject types as shown in Figure
6.9

‘ 5. Select the 'Record’ uption by clicking on it.
6. Click on QK.

7 A dialog box is displayed listing the identifiers for Record object types in
the current project data dictionary,

8. Enter "Payroll’ as the Record identifier in the text entry box at the top of
the dialog box, as shown in Figure 6.22.
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Figure 6.22 Entered Linked Record Name

9. Click on "OK”

So lar you have established a tink from the chart abjeet t0 a named Record
data dictionary entry, Next youwill create the DDE and then access it

10. A dialog box pops up prompting for confirmation to create the Payroll
Record data dictionary entry, as shown in Figure 6.23.

————— | Create new child okject DDE 7 }—8

ODhjoct Type: Record
Identifler : Payroll N

[ Yes 1 (R L E R

Figure 6.23 Promp! to Create Record DDE
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11. Click on "Yes, ‘

12.  The Record definition dala entry scrcen is then dusplayed, as shown in
Figure 6.24.

| Record DDE Screon | |
ObjJect Hame: Payroll
Objoct Typo: Rocord

Last Hod: Jolm K. Hopkins Febh-20-1992
Crecator: John R. Haopkins Feb-20-1992
Defn: - Co R e
Tablo Mame: | - .
Index Hape: .- . - N . Tupe (REKF)

# BNF Conponent nanes : ‘ BHF

1

1
e
S
1

1

1

=1L LAY e
Tt e T e—

R
% Occsd
[List]l [Explodel {[Descrl €0k 1 [Quity

Y _¢:;]

Figure 6.24 New Record Definitlon Screan

You have just defincd a link between a chart object and 2 Record and have
crcated a new record definition which is ready to be worked on, Take a few
minutes 1o understand the ficlds associated with the Record definition data entry
screcn. The Object Name, Object Type, Last Mod, Creator, Deln, Table Name,
and Index Name fields showld be familiar to you from he chart object data
dictionary cotry screen.

The remaining hields are used 1o define the record components. A secord can

conlain up 10 128 such componeats, cach of which is defined in detail by linking it
in turn to an Element entry in the dala dictionary.
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Backus-Naur Operators

The Backus-Naur operator fiekds arc the fiest and third ficlds (an cither side of
the componeat ficld). You can wsc these operators to specify how the record
componcnls are related. Allowable entries are; + {*{] (feft sicde) and {1}*) +
{right side).

Component

This field defines a particular record component. The component name can be up
to 32 characters ia length, This is the name of an element defined in the data
dictionary.

#0ccs

The # Qccs (Number of Qceurrences) ficld determines how many times a
particular component is to occur in the record. The deflauit number of
occurtences for all componenis is one.

Type

The Type field sﬁcciﬁcs the ype of component. The available component types
are indicated by "(REKF}™. These letters identify the lollowing component types:

= Record

= A Element ) 1

= Key Field {an Element}

w Forcign Key Field (an Element)

The default type for all components is (E)lement.

The numbers down the left side of the Record Definition sereen show that you
can specify up to 128 componeats for a Record.

To ener the record components:

1. Click on the first position in the Component ficld, or press the ENTER key.

EasyCASE Plus Version 3.1 Beginners Tuiorial
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K

2. Type "Employce Number™. This number will univucly identily each Sales
Representative.

3, Click on the Type fcld, or press the ENTER key three times.

4, Type “K* to replace the default entry of "E.* The Employee Number
component will bic s key feld,

s. Press ENIER 1o move Lo the aext record componcat licld (row #2),

6. Use Figrure 6.25 1o specify the remaining Record componenl definitions,

| Pecord DDE Screem }
Object Hane: Payroll

Object Type: Record

Last ¥od: John R. Hopkins Feb-20-1992
Creator: Jolm R, Hopkins ) Feb-20-1992
Defn: - B
Table Nane:

Index Hame: Tupe (REKF)

] BNF Conponent nanes BNf:' ]
1{i=.. Esiployee’ Hunher‘ R U 4
2 . Enplouee Hane' : 1 E
3B+ Enplouee Posltlonﬂ 1E
48 - 1E
O + 1E
GH + 1E
g~ 1E
afl « 1 E

8 Occs!
[Listl CExplode) [Descrd COKT COuwit)

Figure 6.25 Completed Record Definltion

Al the bottom of the Record DDE screen are sclection boxes 1o save or cancel
the definition, as well as additional fuactions. The 'OK" and 'Ouit’ selections
should alrcady be familiar 1o you, The remaining functions are described below:
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List 3. Press the 173 key Lo cxil the description field,
The Lgl .bullnu Bccesses a list qfnrxy recond ccflls[)_oncnls.a[rcady dcﬁ:.u:dvm the | Record DDE Screen |
data dictionary. Click on the [List] button o display the list as shown in Figure i
626 Object Hame: Payroll
- Object Typo: Rucord '
_____l Solect Flement Hame [ - Last Hod: John R. Hopkins . Feb-20-1992 !
. Crueator: Jolm K, Hopking - Fob-20-1092 :
Obj| iID:}Enployee Position ‘ Dufn: . . R
0bJ ' - Table Hame: . © . .
- - : : In—————| SHORT DESCRIPTION —
Las 92
Cr g7 #4 |This record contains the enplugee nunher
- ) ’ e, and position. :
Def Ixtended Cost. 11z nene. and yositio 0 :
Tab ~Intended Price’ SR 3l E
Ind -First Hame P T e ) NE E
‘8 B ]'reight Char_;e o ¥ ] gi: gl
1 ‘Home:Phona -~ A K Gl E
2 : Last_ Hame: ' -.: . E 7 E
3 List Price. . E B« L XE
q " Location .- E ' : o ' ¥ Ocesd
5 Nodel -Humber E [List] -[Exploded TuESURI L 0k 1" [Quit] _
G . Het Arount . E - ;
T Phone Humber E ]
8 L Flgure 6.27 Text Entry Box for the Record Shont Doscrption
I - OK 1 ° CCancell ] Explode '
’ The Explode button enables you lo create a data dictionary entry for a record '
component, known as an Element, and aceess the data dictionary entry sercen for
Figure 6.26 Display Element DDEs Using the [LIzt] Option . that Element.
. To define the record components as Elements in the data dictionary:
Descr
. ) 1. Click an the 'Employee Number’ component.
The Descr button paps up a text entry box fer you i enter a short description (up
to 254 characters) of the purpose of the record. 2. Click on the [Explode] button.
1. Click on the {Deser] bution to displuy the text entry box. 3. You may be prompted to verify that you wint to crcate a data dictionary
’ try for the Element 1y ¢ named Employee Numl
2, Eater “This record contains the employee number, name, and position.” in epury for the Tleler }.pc component pamed Empioyee Timber, as

. e shown in Figure 6.2,
the record description field as shown in Figure 6.27.

t
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EasyCASE Plu:

——I Elenent DDE Screen |

———] Create Hew Elenont DDE 7 po—

Object Type: Elenent
Identifior : Employes Humber

£ 351 £ Ho 1

Figura 6.28 Promp! to Confirm DDE Creation for Chosen Element
1f so, click on 'Yes.'

The data dictionary entry screen for the Element named "Employce
Number® is displayed as shown in Figure 6.29.

DDE Hame: Employee Hunber
DDE Type: Elenent

Last Mod: John R. Hophkins
Creator: John R. Hopkins

Feb-2B-1952
Feb-20-1932

Length:
Type:
Constrnt :f§ ¢ o
Hane : EHPLUYEE NUHEERs.
Misc #1: :
Hisc #2:
Fornat:

[Definl  [Descrl [ 0k 1 [Quit]

Figure 6.29 Data Dictionary Entry Screen for an Element

Click on the "Length’ ficld and enter °4°.

This means that the Employee Number can be vp to 4 characters in
length,

)

on 3.1 Beglnners Tutorial

10.

11.

Click on the Type' ficld and type *Numeric®. P
This means that the data type for the Employee Number is 2 number in
the range of 0 1o 9999.

Click on the ‘Constraint' lield and type "NOT NULL"
Click on the ‘Format' ficld and 1ype "R,
Tsis is the format in which the data would be entered (digits ouly).

Click on the Definition field and type *A number uziguely identifying an
employce®. Then press the F3 key.

This defines the purpose of the Employee Number element,

Click on the ‘Name' ficld and type "EMP_NUN", This assigns a field name
for the Employce Number ficld.

— Record DDE Screen |- 1

¢flement DDE Screen |—

DDE Hame: Emplouyee Humber
DDE Type: Elenent

Last Mod: John R, flopkins
Creator: John R. Hopkins

Fub-28-1892
Feb-20-1992

Length: 47 ¢ 71
Type :fHumeric .
Constrnt :}310T HULL =

Hame: EMP_HUM. .-
Misc #1: | .-
Misc #2:

Fornat:

(Ppefinl  [Descrl ©C 0kl [Quitd

Figure 6.30 Complete Employee Number Element Definition
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11.  Click on 'OK."

The data dictionary entry lor the Employee Number element is saved, and
the Record delinition screen is redisplayed.

12, Click gn 'OK'to return to the chart editor.

When you have finiskied, you can thea explode dowa 1o the completed Payiolt
recerd [rom the Payroll symbol,

To explode down to the Payroll record from the Payroll object:

1. The Payroll symbaol should still be szlected. 1f not, scleet 1t by clicking on 1. *
Select the ‘Down a Level option from the Explode meow, or press
CTRL+ D, or click oo the explode down icon.

2 You are prompted 16 save the current chart (if it has changed since the last
save), If so, Click on 'Yes.!

3. The Payroll Record data entry screen is displayed. This will look the same

. © as it did when you entered it as shown io Fig. 6.25.

4, Click on "Quil’ or press ESC (o remaove the record definition screen and

return 1o the chant editor.
Alternatives
1
Explode menu .
Top Level

Select the Top Leve! command to explode up to the highest level ¢hart in a linked
set of charts (o7 o the chart assigned as the top leve! chart, using the Deline Top -
Leve! command).

For example, if you Iinked as object oo the MODIFY chart to the ECPCONTX

chart, you could sclect the Top Level command (o explode up to the TUTOR1
chart,

EasyCASE Plus Verslon 3.1 Beginners Tutorial
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Define Top Level

You can define any of the charts in a linked set of charts to be the top level chart,
This will then be Lhe chart you explode up to when you select the Top Levet .
conmand.

For examiple, you conbd deline the MODIFY chart to be the tap level chart,
rather than the PUTOI chart (the defaul, bighest fevel chort),

Show Exploslons
Seledt the Show Explosions command to indicate the object{s) on the TUTGR1

chart for which you have defined a link. This helps you to rcmcr{lbcr which
vbjects are linked. The objects that have a defined link will be highlighted.

Update Explosions )

The Update Explosions command updates the display of linked objects when you
have the Show Explosions option turaed on. This is uscful when you define new
linked objects and want to have them shown as such.

For More Information

See “Chart Linking and Decomposition® in (he EasyCASE Plus Chart Editor
User's Guide.
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EPILOG
Congratulations! You have just finished the EasyCASE Plus Beginner's Tutorial,
You have used the basic functions of the CasyCASE Plus chart cditor program 1o
crcate and modify charts, describe chart objects to the data dictionary, and link
chart objects to child chartg, records and text files. EasyCASE Plus has many
more functions than could be covered in this beginner's utorial. For more

information about the Chart Editor, please refer 1o the Chart Editor User's
Guide, .

If you want to use the product to assist you in the design of relationa! database
systems, using entity relationship diagrams (ERDs) and the data dictionary, it is
recommended that you use the optional Schema Generator produdt to produce
the resulting schemas. How to do this, in the lorm of a more advanced tetonal, is
provided in the Schema Generator User's Guide and Tutorial.

The data dictionary stores the descriptions you gave to the charts, chan objects,
records, ete. “You can manipulate this data outside of the chart editor by using
the supplicd Data Dictionary and Reports Manager (DDRM) utility program.
You can also gencrate specific chart and data dictionary reports using the
DDRM. The DDRM can be aceessed via the chart editor’s UlLility menu, or run
the as a stand-alone application. For more information about the Data
Dictionary and Reports Manager, please refer (o the Data Dictionary and
Reports Manager (DDRM) User's Guide.

You can use Lthe optional Analysis Manager program to check and verify your
charts and data dictionary. This utility program allows you 1o check your diagramis
against a set of methodology, usage, and fayout rules. It also allows for tevel
balancing linked diagrams, checking record and element definitions, and ¢ven”
provides a “wherc uscd” analysis capability. For more information, please reler to
the Analysis Manager User Refcrence.

To ellectively use EasyCASE Plus, you should first be familiar with the software
design methodologics supported by this CASE tool. EasyCASE Plus does not ry
to teach you about methodologies. However, it does supply the means whereby
you can implement the most common, widely documented, well established
methodologies. For more information about the methodologics, diagram types
and symbologies supported by EasyCASE Plus, please refer to the provided
Methodology Guide, which also conlains a bibliography of popular sofiware
design methodology books.
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LESSONG
LINKING CHART OBJECTS VIATHE DATA
DICTIONARY

Overview
This lesson covers:
s The Data Dictionary Entry (DDE) screen
« Establishing a link to anotlier chart
o Using the lix;plodc commands 1o access the linked chart

s Establishing a link to a text file

»  Using the Explode commands to edit the linked text file

i

|
- !
Before beginaing this lesson, you should be familiar with the material covered in ‘ -
Lesson 5, in which you simply identified several chart objects and bricfly accessed
the corresponding Data Dictionary Entries (DDEs). You did not actually add to, :
or modify, any of the DDE information. ’

You will nced to use the TUTOR 1L.DFD chart you created in Lesson 2 {and
updated in Lesson 5) to complete the excreises in this lesson. If this chart is not
currently loaded, you will need to foad it a3 described in Lesson 3.

This lesson should take you approximately ) hour o complete.

In previous lessons you assigned the fundamental sttributes for.your Dala
Dictionary Entries. The objects you identified can now be used 1o establish
rclationships: functional inks to other charts or text files to create a hierarchy for
your project Niles as described in1he [ullowing sections,
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4, Click on "OK’ (o retain that Wentifier.

* . ] ) ‘ .
5. The DDE sercen is displayed fur the sclected "Order Proccasing System
Data Process symbaol, as shown in Figure 6.2.

——] Charl Ohjecl DDE Sereen’ |——————T

Linking a Chart Object to Another Chart

In this scction, you will usc the Data Dictionary Entry for the "Ocder Processing
System® Data Frocess symbaol as an example and Link it to unother chart,

Access the DD far the "Oxder Proceasing System™ datin process symbal as

follows:
1, Seleet the "Order Processing System” data process symbaol. It will be DDE Mane: Order Processing Systen
highlighted. DDE Type: Data Process )
: : Last Mod: John R. Hopkins Feb-19-1992
2. Sclect the “1dentily Object’ aption from the Edit menu, or press ALT+1. . Creator: John R. Hopkins Feb-19-19592
L. . . Object Explodes To : o
3. The identifier list box is displayed with the identifier "Order Processing Type: . LFilel
System” in the text entry box, as shown in Figure 6.1 A highlight bar Hane :E . . o o
appears over that entry in the list indicating that the identilier is assigned 7
to the selected chart object. )
Nlias:
~——-] Salect Data Process Hame }——— Wisc #1: -
Misc #2: -
1D :{Order Processing Systen Misc #3: .
L {LaprL; befinl fDescr] - [ Ok.} COu it
~ Order Processing Susten ‘
S0P O L -
S0P 1-
. S0P 1.1 ! Y Figure 6.2 DDE Screen Displayed for Sefected Object
SOP 1.2 .
SOP 1.3 . e
SOP 1.4 Note that the Explodes To Type and Name attributes are Llank |r1ld|ca(1}1g that
sop 1.5 the selected chart object has not (yet) been linked to any othes child object.
SOP 1.6 : X .
soP 1.7 1n this section, you will ¢reate a link from the "Order Processing S_YS‘CN data
sopP 2 process symbol 1o the MODIFY.DFD chart (another DFD chast in the
sor 2.1 SAMPLES project directory).
The link associates a specific chart ohject with another chart. You then usc the
L 0K 1 [Cancel] “Explode Down' function to load the linked chart.

Ta specify the name and type of the chart to link ta:

N . . . - To - 1d.
Figure 6.1 Identifier List Box with Object identilier Hightighted 6. Click on the up/down arrow icon next Lo Object Explodes To - Type field

EasyCASE Plus Version 3.1 Beginner's Tutorial
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1. A dislog box, listing the availalile child chast types, data definition types,
and text Gle types is displayed, as shown in Figure 6.3.

————————1 Chert Object DDE Screen |}—————
’——-| Child Ubject Type |—
DDE Hanmo:
DDL Type:| ¢ dfd o Record
Last Mod:]| ¢ trg o Element b-19-1992
Creator:| ¢ erd ¢ Control Table L-19-1992
Object Ef ¢ stic
Type:] ¢ std o txt iileld .
Nane:| o dsd o doc
o dmd © pps . =
Alias:| ¢ elh o cts
Misc #1:| o 1ds o epd R
Misc H2:
Hisc H#3: L Gk 1 {Cancell
Lo - [Quit]

Figure 6.3 Dialog Box Listing Available Child Object Types

8. Click aa the 'dfd’ button to selecttit,

9. Click on the "OK’ option button.
The text "dld" appears immediately to the right of the Object Explodes To -
Type ficld indicating that a link is being established between the selected
data process symbol on the current DFD 10 anather data Aow diagram.

Next you will specify which particulsr DFD, by name, you want Lo link to.

10 Click an the up/down arrow icon next to the Olbject Explodes To - Name
field,

A dialog box appears listing the names of all existing, avadable data Now
disgrams so far deseribed in the Juta dictionary, as shown o Figure 6.4,
-
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—| Select dfd Name |

— lD:[Etoria] Hodify Chart ‘] ——‘

31 i
[130) DI'D Dbjucts (Cano & Sarson) I
La DI'D O Jocty (SSADK) G492
C DFD Objects (YourdonsDeMarco) 992 :
)} LasyCNSE Plus Coantext Diagram .
Sanple (FasyCNSE Plus) DID
Sanple DID

Sample Project Context Diagranm
Sample Project Level O DFD
Sample Project Process 1 DFD
Sanmple Project Process 2 DI'D

Jutorial Hodify Cha - !

fragmoent

Tz

BN S L0 0K [Cancell e

Figure 6.4 Dialog Box Listing Available DFD Chants

Scleat the Tutorizl Modify Chart’ eatry by clicking on it :
]

Click on 'OK.

The Dats Diclionary Entry sereen for the Order Pru'c::ssing Syslem is

redisplayed as shown in Figure 6.5 Notice the enltties i the Object

Explodes To - Type and Explodes To - Name fields sre those you just

chose from the lists. In this examyple, the DDE sereen shows that the data

process named "Order Vrocessing System” hus been linked 1o another data

flow diagram (ft) named “Tutonal Modify Chart.” T ihe next section you
will traveese the Tinkage and access the samed ‘child chart,
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~—————— Chart Object DDE Screen |——

DDE Hame: Order Processing Systenm
DDL Typc: Data Process

——] Chart Object DPE Screen |————

DDE Hane: Order Processing Sgsten
DDE Type: Data Process

Last Mod: John R. Hopklins Feb-20-1992 Last Mod:.-Jahn K. llopkins Feb-20-1992
Crecator: John R. Hopking Feh-19-14902 Croator: Joln K. Hoplking TFoh-19-19492
Object Explodes To : —————| SIORT DESCRIFTION |

TJpe.Blfd #IIN | _

Hane :}jTutorial Modify Chart : ) - .

filias: 2 .
Hisc H1: .
Misc #2:
Hisc #3:

[Labell [Deflinl tDescr][} [ Ok 1 COuit] [Labell ([Defiwnl [Jx;:{g,i.fi!jt [ Ok J I[Quit]

Figure 6.5 DDE Screen with Linked Chart Entry Figure 6.6 Short Description Field Text Entry Window

4. Now click on the [Deser] bution. 15.  Type the following short description for the Order Processing System
entry: “Process representing the entire Order Processing System®™.

A text cntry box pops up, overlaying the DDE screen, as shown in Figure

6.6. This text entry box allows you 10 add a short description about the

16.,  Press the F3 key to complete entry af the short deseription.
selected data process.

17.  Click on ‘OK' to return to Lhe chart,
The object labe! is highlighted along with the sclected symbol.

18.  Click the right mouse bulton, or press the ENTER key, to accept the
current position fur the symbol Lubel.

When you accessed the DXDE sereen in this example, you defined a link between
the selected chant olject and anvther chart via the data dictionary (chaet of type
DFD numed Tutorial Modify Chart’). You can now ‘explode’ down from the
selected data process 1o the destgnuted chary, as described in the next section.
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Exploding To and From a Linked Chart

-.1rus [dit Objects VUiew Options [xplode Nnalyze Schoss Utilty lelp

A TI‘JI}! l?‘gs‘i‘t_d:q;h . - L
. . .. R . . ot} at oo . . P
Once you bave estublished a hink 10 4 chart, 15 & simple matter to “explode e, ::1-.;:_'3’1. Mo D O

down to the Child chart, sutomatically loading it into the chart windaw ready to
be warked an. To do this, you select the object tinked to the chart, then use the
‘Duwn’ option from the Explode menu,

e f.o:;}m::
['11 ur;.!f.-:.'\,;-.\ﬂ‘:...

< 11K
T

To explode to the linked chart from the Order 'rocessing System data process:

1. Select the data process symbaol labeled *Order TProcessing System” by
clicking on it. The symbol is highlighted.

Sclect the "Down a Level option feom the Explode meny, or press
CTRL+ D, or click on the explode down icon located in the lower left corner
of the chart window.

fAnaluze Schema
Top level - - Ctriel - .

Up a level Cirls+y
Doun a level Ctrl+D

ta

Define top level...
Update explosions
Show explosions

Flgure 6.8 Child Chart Displayed in Charnt Window

k3

Figure 6.7 Explode Menu You can explode back to the pareat chart (TUTOR1.DFD) by using the ‘U !

. option fromn the Explode meny, as follows: . o
If the current chart has changed since it was last saved, you are prompied :
1o save the chart. To do so, ¢lick on the "Yes™ button, to

1. Select the *Up a Level option from ke Explodé menu, or press CTRIL+ U,
or click on the explode up icon located in the lower left corner of the chart

3. The linked (child) chart (MODIFY.DFD) is loaded and displayed in the window.
chart wind dy 10 be worked on, as shown in Figure 6.8, . . .
andow ready rked on n Py The parent chart (TUTOR1,DFDY is loaded and displayed in the chart

window,

e

T
. . .-
h Only one chart can be loaded at a Gme. However, explodiog from/fto a chartis a
. quick and easy way to move between linked charts.
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Linking to a New Chart

You have just defined a linkage fronm a existing chart object to another chart vis
the data dictionary. However, the chart that you wish 1o link to peed not already
exist, The new chart is created as you complete the link by attempting 1o access it

T do this, you will use the “Down u Level aptinn (ro (e Explinle menu,

1.

2

Sclect the *Customer® external entity symbol by clicking on if.

Select the ‘Down a Level option from the Explode menu, or press
CTRL+D, or click on the explode down icon located in the lower feft corner
of the ¢chant window.

You will be asked if you wish 1o save the chart if it has been modified since
it was last saved. -

Click on ‘Yes' 1o save the chart.

A dialog box is displayed and fists the available child object wypes (charts,
text files, data definitions}, as shown in Figure 6.9,
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Flgure 6.9 Avallable Child Objact Types

Click on the ‘erd’ entry 1o choose an Entity Relutionship Diagram as the

child chart type you want 10 link Lo,

Click on 'OK.

A dialog box is displayed containing the identifiers for ERD charl types in
the current project. The text entry box at the top of the Jiatog box is emply

and ready for text entry.

Type “Customer Operations™ in the Lext enlry box, as shown in Figure 6.10.
Tluis is the name of the ERD 1o link 1o
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Figure .10 Child ERD Identitier in Text Entry B0k |
3 B +

9, Ctick on ‘OK.' .
.10, A dialog box then pops up and you are prampied 1o venfy that you want 1o

create the specified child ehaet entry in the data dictionary, as shown in
Figure 6.11.
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Figure 6.11 Prompt 1o Create Child Chart Entry In the Data Dictlonary

11, Click on*Yes!

. -
12, You are prompted lo enter the lilename o use Tor the ERD chart file, as:
. - R .. R

sil.()\ﬂ'l in Figure 6.12. ‘

13, Typc "CUSTOIS. ERDT i the text entry bux, 10 e used us th filcname
“{or the child ERD chart.
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4, A dialog box will appear prompling you 1o conlinn creation of the data Establlshmg a Llnk toa HECOI‘d o : : i ;
dictionary entry for the text file as shown in Figure 6.20. Choose the “Yes' f
option, : When a chart object is to be .lssncmtcd with a data structure definition, you link it F

to a Record definition that allows you lu‘dlz,ﬁr_l_t, u data structure., |

— Cr'e.-_xtc new child object DOL 7 |———

ObJect Tuﬁa: tut-

When yau establish aJink 1o a'record, you neeil to establish a daty dictivaury
eatry for the Becord, just as you dld fm chit nlqul-. anad fext files. The

LYLIPRILI B I FRS Hapanogunt comepment el a deenGh e e e Wi bt a 0 B s epresentel ey
' cicient 'a
| [ Yes 1 . I HE
In this section, you will load the TUTORL.DYFD chart and cslabh.\h alinktoa
H record used for information about Payroll. The componcnls of this record define
s data such as g_hq Employee Number, Name, Position, and 30 on.

Figure 6.20 Prompt 1o Create DDE for Text File
To establish a ligk 1o a Record:

5. A dialog box will appear prompting you to confirm ¢reation of the new lext .
file. Chicose the "Yes' option. I Load the TUTORLDFD chart.
Ty - H ’ .
6. A dizlog box will appear prompiing you far'the name of the [cn fift_ Lnter 2. Sclcet the external entity symbol labeled "Payroll” by clicking an it
“Mgmi.txt” as shown in Figure 6.21, then choose the "Yes' oplion. : -
. 3. i"Select the'Down a Level option lrom the Explade menuw; or press
! CcTRL#+D, or click on the explode down icon.
. ° .ot .
Enter Chart Filenane: [Nont .txi] 4. A d:alog box pops up l:stmg avml.xblc child objcct types as shown in F'ngurc
t , ' 69, - . R
[ Yes ] Q ( Ho } [-Cu,“?gl] . RN 5. ¢ Select the 'Record’ option by clicking on it.
1 o . : -
S 6. | Cickon'OK ,
Figure 6.21 Enter Text Fitename 7. A dialog box is displayed listing the identifiers for Record object types in
. . o . . the current project data dictionary.
7. The chosen editor will be run dnd you will be able to aceess the text file freat project & awy ]
pamed MGMT.TXT. 8, ° Latcr ‘I'ayrull‘ us the Record identifier in the lext entry box at lhc lop of
. . . : . ' the dialoj bo shov 1in Figure 6.22. .
8 To return to the chart editor, exit or quit from your text cditor,  fhe Cualog 2o, s s 0w Bure o
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—— . - . ) : . f :

= File Pdit_ Objocts Ulew Llpl.lm;u IT,Tx.nu fins yZa  Lchama ULl fwlp 1. Clich on 'Yoes! . .
D'E_w b‘l“”‘w‘M_“ruT.& Rocard Hare |———‘ ‘ SEREEEEI ) ' R
S_)_‘ --U-J-;';- ?:’\‘e . 12 The Record definition data entry sereen is then displayed, as shown in o
el | st A i ”:Ih“"“l Figure 6.24. - '
Conponant f R -~ A PR 1 I
Companants ticod . PR [ Record DDU Seroum | }
fugtonor S I T ’ M ject Hane: Payroll i
[T TS fit b ?-n-n' "h(l! il ‘
Salno kepremantstfve Lo, ' Vi 0 “-"']'-I’
:::“‘“::E::‘;: Betall Creator: Juhn K. Huplc b 4l 2ue B
: . Defn: | . .
Table Hame: . S
. _ - Index Hame: |, ‘ Type (REKF} )
' 1 LHr Conpanent nanes : DHF ] \
1jj- - 1E
28 « “1E
ag - 1E
48 + 1L
-SH + 1E N
Gl « . . 1Z )
. 7 + 1+ . ' T .1 E
\ i R .1k
Figure 6.22 Entered Linked Record Name LT # Ocesd |
- [Ligt]l '[Fxplode) [Descrl { Ok 1 [Quitd
9. Click on 'OK . -
So far you have established a link from the chart uhjécl to a numed Record a e e ! r R ."F.lgure 6.2 New Record Dﬂel’mm‘on Screen .

data dictionary entry. Next youswill create the DDE and then secess it

You have just defined a fink bétween a chant object and a Record and have
created a new record definition which is ready te be worked on. Tuke a few
minutes to understand the ficlds asmc.utcd with the Recurd definition duta cntry
screen, The Object Name, Objea Type, List Mod, Creator, Deln, Table Name,

10, A dialog box pops up prompting for confirmation to ¢reate the Pa)ru!l
Record duta dictionary entry, us shown in Fipure 6.23,

———————| Cruate nouw child object DL 7- J———

.- and Index Name fields should be Gamiliar to you {roms the chart ofject data
Objoct Type: Record ) . du.umury colry sereen., | - C
1dontifier : Payroll . . et
L, ) o The remaining (elds are usw.d to dehine the rtcmd cumpom.nls A record can
C'vas 1 ° Powi ’ contain up lo [28:such components, cach of which is défined in derail by linking it
in turn to an Element catry in thc data dictionary. '

Figure 6.23 Prompt 1o Create Record DDE
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. . - . - i
/-s-Naur Operators 2, Type 'I'mployt_c Numhu This pumber will uniquely :dcum[’y each Sales,
’ : R fat

- Backus-MNaur operator lields are the first and third ficlds {on cither side of Ll)l’LhCn ative.

/- componcent ficld). You can use these operutors ta specily how the record 3. Click on the Type fichl, or press the ENTER key three 1imcs.
.7 -omponents are related, Allowable entries are; + (" {] (lcft side) and J1} ")+ R
(right sidc). 4.- Ty]u: K o rcpl.ncc the defaylt cmry 1] I B '! he Fmpluycc Mumber
Component ) ) '7 ('nmpnncnl will be s key I'.le :
) .. . . | —5 ':lll... 1o the’ ‘d icul ficld ll‘ .
This field defines a particular record component, The compunent name can be up 3 Prcs.s ENTTE 0 move Lo the next record comporicat field (sow #2)
. _ :]Gczloﬁh:;:\cwrs in length. This is 1hc name of an element defined in the data 6. Use Figure 625 1o specify the remaining Record component delinitions.
i a ..
,#occs T e L : ] Record DDE ¢ Screeu %
: : . . N i Object Nane Pauroll N C
.Thc # Occs (Number of Occurrcnccs) field determines how many timesa . i-| Ohject, Tupe: Record . :
particular component is 1o occur in the record. The default number of o : Last Mod: John' R. Hopkins Feb~20-1992
occuriences for ali components is one, i 0 ‘ . Creator: Joln R. Hopkins FED—ZB-"IQQZ.
. . ’ . Defn: ’ T s
Type ’ : <\ Table Hanme: .o T :
. : . “f Index Hame: e Typo (REKF)
The Type field specifies the type of component. The available component types : : | # DNF Conponent nanes : . BHF. ]
‘are mdw:ucd by_ (REKI)". Thcsc letters identifly the {ollowing component types: ] 101 Enployee Hunber © | ) o 1T K
- o - . ‘1. 2§ + Enployce Hane o © 1E N
" Récord ' * 3f.+ Employee: Positionf ‘1E
1 : - ‘ l-ag + o C TE
» Element - L . : ' ) 1 SB o+ 1k
_ ) ‘ “GR + ‘1E
» Key Ficld (an Element} 7B « -1 E
) ; . el sy : . : -~ 1E
» Foreign Key Field (an Element) I T ‘ 4 Occsl
. [Listl C(Explodel [Descrl L 0k 3 rQuit]
The delault type lor all components is (E)lement, - .
. The numbers down the lefi side of the Record Definition sereen show that you Figure 6.25 Completed Record Definition
* can specify up to 128 components fur o Record, '
To cnter the record components: : - At the bottom of the Record DDE screen are selection boxes to save or cancel ;

the definition, as wel as additional functions. The 'OK’ and 'Quit’ selections

1. Click on the first position in the Component field, or press the ENTER key. should already be familiar 1o you. The remaining functions are described below:
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Loy
List

The List button accesses a list of any record camponents alresdy defined in the
data dictionary. Click on the [List] button 1o display the st as shown in Figure |
6.26,

~. —————] Select Elenent NHana |——

ID:{Enployee Tositian

Ri=Rie
NN

Enployee Pasition -
- Extended Cost-- | - .
~Extended Price , oot
_TFirst Hana . :
Frelght. Charge

Homne Phone

Last Hame -

List Price-

Location. ° : SR
Model Humber
Net Amcunt
Phone Humber

Nt

MR b Re—T -

&1 L ok 1, [Cancel] T

Figure 6.26 Dispf;a'if Efement DDEs Using the [List] Option .

Descr ‘ : - . T

The Descr bution pops up a 1ext entry box for you to enter a short description {up

1o 254 characters) of the purpose of the record.

1. Click an the {Descr] button 1o display the text entry box.

2 Fnter "This record contains the employee number, name, and position.” in
the record description field as shown in Figure 6.27, :

EasyCASE Plus Version 3.1 Beginner's Tutorial

i - vy
3 Press the F3 hey to exit the t[v..u:riptinn Neld.

cot
H

L }I.ﬁecnrd DOE Screen- |

Object Hand: Patgroll
Obloct Typo: Kecord !
Last Mad: Jahn K. Hopkins fob-20-1902 | |
Creator s Joln R, Hopltlog Ieb-20-19492 |
Dafn: o B I
Table Hame: . .
h:—————————J HURT DE‘CRIPTIUH J————— 3 ¢
# |This record contains. the enpluueu nunber ] {
1., nane,,and pos|t1on B. E 1
2 _ . e E

3 al EY . E

q| i . E

9] V!Cf. “ J: E

6| i - .E

7 — -~ - E

BI + tioie, co - 1E
Sornin e ae o # Occsd

w|  CLEst) [Explodel) | fyistiy ™ [ 0k 3 [Quitd .
T v =

Flgure 6.27 Text Ehrry.Box for the Recard Short Description ..

RN R S = .
Explode ‘ e
The Exp!od: hulmn cn.nblu. you T cie! ll: a data dictionary eotry for a record
component, known as an E lcmcm and access the dula dictionary entry sereen lor
that Element. .

e,

To dcﬁnc Ahe recurd cmnlmnculs as rll.uu:nl; in the dats dictionary:

1. Click on lhr: [ mpln)u. Numhu compnncnl
2 Click on the [IEX|)|m|c] Dutton.
3 You may be prompred to veeily that you want 1 ereate adata dietionary

A

entey for the Element type compuonent n.nm.d Llnplu)u_ Number, as
shown in Figure 6.28, a
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Create Mew lf'lcnent DDE 7 .

) Object Type: Elenent
. Identifier : Employce Runber

Lo [ Ho 3 ;
Figure 6.28 Prompt to Confirm DDE Creaion for Chosen Element

4, 1f so, click on 'Yes!'

5 Thc data dlcuonary entry screen for the Element named 'Emp]oycc
Number is displayed as shown in Figure 6.29...

_———————————4 Elenent DDE Screen |

DDE Hame: Employee Nunber

DDE Type: Elenent |

Last Mod: John R. Hopkins Feh-20-1992
Creator: John R. llopkins Febh-20-1992
-~ Length: B~ . . L nE . :

Type:J . ° . . I
_Constrnt: E o ' B ,
Hame : EMPLOVEE HUHBER ‘ oo

Hisc #1:

Misc #2:
Format :

[Definl

[Desecr] [ 0Ok J fQuit]

Figure 6.29 Data Dicticnary Enry Screen for an Element

6. Click on the "Length' field and enter “4°

* This means-that the Employee Number cin be up to 4 characters in
length,

1

EasyCASE Plus an 3.1-Beginner's Tutorial

S

7.

H-‘

10;
i

i

. Click on the Type' field and type *N umeric”. ] f"rzj

. This mecans that the data type for the Employee Number is a number in
the range of 0 1o ')‘)')‘J ] - T

i
RN

(‘ﬂrk an the Const ging” ield and sype "NOT UL

This is the format in which the data would be entered (digits only).

Cixck on the Definition ficld and typc A numbcr umqucly ld:ntlfymg an’
cmp!oyec Then pr:ss the F3 key,

L i -
Thxs d:.['mcs thc'purposc of the Employcc Number clcmcnl

“'Click on the Namc field and 1ype "EMP_NUM®. This assigns a ﬁcld name
for lhc Employce Number field. . .

Record DDL Screen ) — .

Element DDE Screen |—

.r P [ ] h

! DDE. Hame.: ‘Enployee Hupnber .. e r

-DDE. Type : Elenent . :
Last.Hod : John R. Hopkins
Creator: John K. lopkins

" Fab-20-1992
Felb~-20-1992

Length: 4
. Type :[Hurmeric
Constrnt :BIDT HULL

Name : EMP_HUM : .

Misc #1: B ‘

Misc H2:

Yornat.:
[ Dk I [Quitl

(befinl [Descrl

Figure 6.30 Complete Employee Number Element Definition
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11, C!lck on OK.‘ - S ]
e f " A A I
~r

Thc data d:cnunary enlry for the Employce Number c!cmcn! is saved, and
“the Record definition screen is redispluyed. 7 o

12: . l C“Ck o.n 'O[‘g' ug’n;lurn l:J the chart cdimr_

\ ot S Sh B e e e
ot T L L S # LR e ot
When you have ﬁnL\th 'you ¢an lllcn explode down to the: Lump!n._u.d Payrall
record from the l’ayroll symbol. i R T

st . - - o, . : - 1 1 '

To cxplode down to the Payroll record from the Payroll object:

.l."‘ _The Payroll symbol should snll be selected. If not, select it by clicking on it.
T v Select the '‘Down a Level'' npllon from lhc l_..xplodc mcnu ur prcss‘ H
' CTRL +D, or click on the :xplodc duwu I.COI! ) ;

x You are promplcd lo save lhc currt:nl ch.n[ (xf !t h 15 ch.m[btd since the Lust
‘ save). If so, Click on. Yr.s g SRt

(LA S et _r.I-'.-i‘L:'uz' va .t
3. The Payroll Record data Eatry screen is displayed. This will ook the same

_as it did when yuu entered 1t s slmwn iu Fig. 0_25,
T

4. Cln:L on 'Quit’ or press BSC Lo n:mm'c the rccord dLﬁmhon scrc.cn and e
feturn (0 the chart :duor Lo " R
. o . Rl .
:~ . ”-:'! . . PRI . ' R P T
Alternatives " °
' N b
Explode menu -~ " -t et van g
. ' N . o !-"‘.1 SRR IR L TR -
Top Level - o . C

Sclccl the Top Level command 1o explode up to the highestlevel chart in a lmkcd
sct of charts {ar 10 the chart assigned as the tap level chart, using the Definc Top
Level cumm.md) NN 3

" For cu:nplc if you linked an object on the MODIFY chart tu the £ (_!'CONT)\
chart, you could scleet the Top Level command 1o explode up to Lthe TU" TOR1
chan, . -
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Define Top Level . ‘
" You can define any of the charts in a linked set of charts Lo be the top letel chari.
This will then be the chart you explode up to when you sclcet the Top Levet

command.

Trar c!(jlll'l[l'lc,;‘g'i;ll.('lilllll:ttl‘lhlllil—(l!.'(_‘, MODIEY chart to be the top level ehant,
rathice than the TUTORE chiut (the defautt, higheat Jevel chat).

Scltd the Show Explusiony command to indicate the object{s} on lhc TUTOR1
chagt for whichyou have: defined a link, This helps you to remember whick .

b t
Show Explosions i ‘
ObJCClS are hnLcd '] he UJJLCLS Uiat have a defined link will be highlighted; +7 .

- !

Iy

Updhle Exploslons

‘ o
T b; Updatc I-xpiosmns command updatcs the display of linked objects when § you
have.lhe Show Explasions option turncd on. This is uselful when you define new
lml.cd—objccts and want to huve them shown as such. -

i

For More Informat:on

Sce; ’Chan Lmkmb and Duomposmuu in the L.:s;(_ASL Plus Chart Editur
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EPILOG. | Cor

Congratulations! You have jusi-finished the EasyCASE I'tus Beginner's Tutorial,
You have uscd the hasic functions of the EasyCASE Plus chart editor program 1o
create and modify charts, describe charl objects to the data dictionary, and Link
chart objects to child charts, records and text files. EasyCASE Plus has many
more functions than could be covered in thiy beginner's tiionial, For more
information about the Charl Editor, pleasc refcr to thic Chart Editor User's
Gauide, :

If you want (o usc the product to assist you in the design of relational database
systems, using entity refationship disgrams (ERDs) and the data dictionary, it is
recommended that you use the optional Schema Generator product to produce
the resulting schemas, How to do this, in the form of a more advance d tuterial, is
provided in the Schema Generator Uses's Guide and Tutorial.

Thc data diétionary itores the' descriptions you gave (o the charts, chart abjedts,
rccords, ete. You can maniputate this data outside of the'chart editor by using
the supplied Data Dictionary and Reparts Manager (DDRM} ul:ll[y program.
You can also generate specific chart and deta dictionary reports using the 7 &
DDRM. The DDRM can be accessed via the chart editor's Utility menu, or fun
the 25 a stand-alonc application. For more, information about the Data
Dictionary and Reports Manager, please’ refer lo the Dala D:cuonary and
Reports Manager (DDRM) User's Guide. " -

t

You can use the upuonal Analysis Managcr program lo chcck and verify ynur
charts and dala dictionary. This utility program allows you to check your diagrams
against 2 s¢1 of methodology, usage, and layout rules, H also allows for level . ..
balancing linked diagrams, checking record and clement definitions, and even
provides a “wherc used” analysis capabality. For more information, please rclsr lo
the Analysis Manager User Reference,

To clfectively use E:asyE‘ASE Plus, you shoutd first be famritiar with the software
design methodolopies supporied by this CASE tool: EusyCASE Plus does not try
to teach you about methodologies. However, it docs supply the means whereby
you ean implement the most common, widely Jocumented, well established
methodologics. For more inlormation about the methodologies, diagram types
and symbolagics supported by EasyCASE Plus, please refer 1o'the provided
Methadology Guide, which also contains a bibliography of popular software
design methodalogy books.,
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